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About This Guide
This guide will see you through your initial contact with SUSE Linux. Whether you
are a first time user or an experienced administrator, check out the various parts of this
manual to learn how to use and enjoy your SUSE Linux system.

Setup
Learn how to install and maintain your SUSE Linux system.

Basics
Get an introduction to the Linux desktop and to the most important software options
for SUSE Linux. In addition to that, learn how to find help or additional documen-
tation in case you need more in-depth information on your system.

Desktop
Learn more about the desktop of your choice, either GNOME or KDE.

Troubleshooting
Check out a compilation of the most frequent problems and annoyances and learn
how to solve these problems on your own.

1 Feedback
We want to hear your comments and suggestions about this manual and the other doc-
umentation included with this product. Please use the User Comments feature at the
bottom of each page of the online documentation, or go to http://www.novell
.com/documentation/feedback.html and enter your comments there.

2 Additional Documentation
There are other manuals available on this SUSE Linux product, either online at
http://www.novell.com/documentation/ or in your installed system under
/usr/share/doc/manual/:

http://www.novell.com/documentation/feedback.html
http://www.novell.com/documentation/feedback.html
http://www.novell.com/documentation/


SUSE Linux Reference
This guide covers advanced system administration tasks with SUSE Linux. An online
version of this document can be found at http://www.novell.com/
documentation/suse10/.

Novell AppArmor Powered by Immunix 1.2 Installation and QuickStart Guide
This guide outlines the initial installation procedure for the AppArmor product. An
online version of this document can be found at http://www.novell.com/
documentation/apparmor/.

Novell AppArmor Powered by Immunix 1.2 Administration Guide
This guide contains in-depth information on the use of AppArmor in your environ-
ment. An online version of this document can be found at http://www.novell
.com/documentation/apparmor/.

3 Documentation Conventions
The following typographical conventions are used in this manual:

• /etc/passwd: filenames and directory names

• placeholder: replace placeholder with the actual value

• PATH: the environment variable PATH

• ls, --help: commands, options, and parameters

• user: users or groups

• Alt , Alt + F1 : a key to press or a key combination

• File, File → Save As: menu items, buttons

• Dancing Penguins (Chapter Penguins, ↑Reference): This is a reference to a chapter
in another book.

viii
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1Installation with YaST
This chapter systematically guides you through the installation of the SUSE Linux
system with the system assistant YaST. The description of the preparation of the instal-
lation process is accompanied by background information to assist you in making the
right decisions in the individual configuration stages.

1.1 System Start-Up for Installation
Insert the first SUSE Linux CD or the DVD into the drive. Then reboot the computer
to start the installation program from the medium in the drive.

1.2 The Boot Screen
The boot screen displays a number of options for the installation procedure. Boot from
Hard Disk boots the installed system. This item is selected by default, because the CD
is often left in the drive. To install the system, select one of the installation options with
the arrow keys. The relevant options are:

Installation
The normal installation mode. All modern hardware functions are enabled.
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Installation—ACPI Disabled

If the normal installation fails, this might be due to the system hardware not support-
ing ACPI (advanced configuration and power interface). If this seems to be the case,
use this option to install without ACPI support.

Installation—Safe Settings

Boots the system with the DMA mode (for CD-ROM drives) and power management
functions disabled. Experts can also use the command line to enter or change kernel
parameters.

Use the function keys indicated in the bar at the bottom of the screen to change a
number of installation settings.

F1
Context-sensitive help for the active element of the boot screen.

F2
Select the display language for the installation.

F3
See other options that can be set for installation.

After pressing F3 some other options can be set:

F3
Selection of various graphical display modes for the installation. The text mode can
be selected if the graphical installation causes problems.

F4
Normally, the installation is performed from the inserted installation medium. Other
sources, like FTP or NFS servers, can be selected here. If the installation is carried
out in a network with an SLP server, one of the installation sources available on the
server can be selected with this option. Information about SLP is available in
Chapter SLP Services in the Network (↑Reference).

F5
Use this to tell the system that you have an optional disk with a driver update for
SUSE Linux. You will be asked to insert the update disk at the appropriate point in
the installation process.
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A few seconds after starting the installation, SUSE Linux loads a minimal Linux system
to run the installation procedure. If you want to know what is going on during the boot
process, press ESC to see messages and copyright notices scroll by. At the end of the
loading process, the YaST installation program starts. After a few more seconds, the
screen should display the graphical installer.

The actual installation of SUSE Linux begins at this point. All YaST screens have a
common layout. All buttons, entry fields, and lists can be accessed with the mouse or
the keyboard. If your mouse pointer does not move, the mouse has not been autodetected.
In this case, use the keyboard for the time being. The navigation with the keyboard is
similar to the description in Section 3.9.1, “Navigation in Modules” (page 96).

1.3 Language Selection
YaST and SUSE Linux in general can be configured to use different languages according
to your needs. The language selected here is also used for the keyboard layout. In addi-
tion, YaST uses the language setting to guess a time zone for the system clock. These
settings can be modified later along with the selection of secondary languages to install
on your system. If your mouse does not work, select the language with the arrow keys
and press Tab until Next is highlighted. Then press Enter to confirm your language se-
lection.

1.4 License Agreement
Read thoroughly the license agreement that is displayed on screen. If you agree to the
terms, choose Yes, I agree to the License Agreement and click Next to confirm your
selection. If you do not agree to the license agreement, you are not allowed to install
SUSE Linux and the installation terminates.

1.5 Installation Mode
Select New installation or Update an existing system. Updating is only possible if a
SUSE Linux system is already installed. When a SUSE Linux system is already installed,
useOther to access two advanced options: boot the installed system with Boot installed
system or, if the installed system fails to boot, you can try to fix the problem with Repair
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installed system. If no SUSE Linux system is installed, you can only perform the new
installation.

The following sections describe the procedure of installing a new system. Find detailed
instructions for a system update in Section 3.2.5, “Updating the System” (page 62).
Find a description of the system repair options in Section “Using YaST System Repair”
(page 247).

1.6 Time Zone
In this dialog, shown in Figure 1.1, “Selecting the Time Zone” (page 6), select your
region and time zone from the lists. During installation both are preset according to the
selected installation language. Choose between Local Time and UTC (GMT) under
Hardware Clock Set To. The selection depends on how the BIOS hardware clock is set
on your machine. If it is set to GMT, which corresponds to UTC, your system can rely
on SUSE Linux to switch from standard time to daylight saving time and back automat-
ically. Click Change to set the current date and time. When you are satisfied with the
settings, click Next to proceed.

Figure 1.1 Selecting the Time Zone
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1.7 Desktop Selection
In SUSE Linux, you can choose from various desktops.KDE andGNOME are powerful
graphical desktop environments similar to Windows©. Find information about these
in Chapter 7, The KDE Desktop (page 173) and Chapter 8, The GNOME Desktop
(page 201). If you do not want either, choose Other and click Select for more options.
With Minimal Graphical System, install a graphical window manager that allows for
running stand-alone X applications and console windows but does not provide the
usual integrated desktop functionality. In Text Mode, only console terminals are avail-
able.

1.8 Installation Settings
After a thorough system analysis, YaST presents reasonable suggestions for all instal-
lation settings. The options that sometimes need manual intervention in most common
installation situations are presented under the Overview tab. Find more special options
in the Expert tab. After configuring any of the items presented in these dialogs, you are
always returned to the settings window, which is updated accordingly. The individual
settings are discussed in the following sections.
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Figure 1.2 Installation Settings

1.8.1 Partitioning
In most cases, YaST proposes a reasonable partitioning scheme that can be accepted
without change. YaST can also be used to customize the partitioning. This section de-
scribes the necessary steps.

Partition Types
Every hard disk has a partition table with space for four entries. An entry in the partition
table can correspond to a primary partition or an extended partition. Only one extended
partition entry is allowed, however.

A primary partition simply consists of a continuous range of cylinders (physical disk
areas) assigned to a particular operating system. With primary partitions only, you
would be limited to four partitions per hard disk, because more do not fit in the partition
table. This is why extended partitions are used. Extended partitions are also continuous
ranges of disk cylinders, but an extended partition may itself be subdivided into logical
partitions. Logical partitions do not require entries in the partition table. In other words,
an extended partition is a container for logical partitions.
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If you need more than four partitions, create an extended partition as the fourth partition
or earlier. This extended partition should span the entire remaining free cylinder range.
Then create multiple logical partitions within the extended partition. The maximum
number of logical partitions is 15 on SCSI, SATA, and Firewire disks and 63 on (E)IDE
disks. It does not matter which types of partitions are used for Linux. Primary and log-
ical partitions both work fine.

TIP: Hard Disks with a GPT Disk Label

For architectures using the GPT disk label, the number of primary partitions is
not restricted. Consequently, there are no logical partitions in this case.

Required Disk Space
YaST normally proposes a reasonable partitioning scheme with sufficient disk space.
If you want to implement your own partitioning scheme, consider the following recom-
mendations concerning the requirements for different system types.

Minimal System: 500 MB
No graphical interface (X Window System) is installed, which means that only
console applications can be used. Also, only a very basic selection of software is
installed.

Minimal System with Graphical Interface: 700 MB
This includes the X Window System and some applications.

Default System: 2.5 GB
This includes a modern desktop environment, like KDE or GNOME, and also pro-
vides enough space for large application suites, such as OpenOffice.org and Netscape
or Mozilla.

The partitions to create depend on the available space. The following are some basic
partitioning guidelines:

Up to 4 GB:
One partition for the swap space and one root partition (/). In this case, the root
partition must allow for those directories that often reside on their own partitions if
more space is available.
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4 GB or More:
A swap partition, a root partition (1 GB), and one partition each for the following
directories as needed: /usr (4 GB or more), /opt (4 GB or more), and /var
(1 GB). If you do not want to have separate partitions for these directories, add the
suggested disk space to the root partition. The rest of the available space can be
used for /home.

Depending on the hardware, it might also be useful to create a boot partition (/boot)
to hold the boot mechanism and the Linux kernel. This partition should be located at
the start of the disk and should be at least 8 MB or one cylinder. As a rule of thumb,
always create such a partition if it was included in YaST's original proposal. If you are
unsure about this, create a boot partition to be on the safe side.

You should also be aware that some (mostly commercial) programs install their data
in /opt. Therefore, either create a separate partition for /opt or make the root partition
large enough. KDE and GNOME are also installed in /opt.

Partitioning with YaST
When you select the partitioning item in the suggestion window for the first time, the
YaST partitioning dialog displays the partition settings as currently proposed. Accept
these current settings as they are or change them before continuing. Alternatively, discard
all the settings and start over from scratch.
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Figure 1.3 Editing the Partitioning Setup

Nothing in the partitioning setup is changed if you select Accept Proposal. If you select
Base Partition Setup on This Proposal, the Expert Partitioner opens. It allows tweaking
the partition setup in every detail. This dialog is explained in Section 3.7.5, “Partitioner”
(page 86). The original setup as proposed by YaST is offered there as a starting point.

Selecting Create Custom Partition Setup opens the dialog as shown in Figure 1.4,
“Selecting the Hard Disk” (page 12). Use the list to choose among the existing hard
disks on your system. SUSE Linux will be installed on the disk selected in this dialog.
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Figure 1.4 Selecting the Hard Disk

The next step is to determine whether the entire disk should be used (Use Entire Hard
Disk) or whether to use any existing partitions (if available) for the installation. If a
Windows operating system was found on the disk, you are asked whether to delete or
resize the partition. Before doing so, read Section “Resizing a Windows Partition”
(page 13). If desired, go to the Expert Partitioner dialog to create a custom partition
setup as described in Section 3.7.5, “Partitioner” (page 86).

WARNING: Using the Entire Hard Disk for Installation

If you choose Use Entire Hard Disk, all existing data on that disk is completely
erased later in the installation process and is then lost.

YaST checks during the installation whether the disk space is sufficient for the software
selection made. If not, YaST automatically changes the software selection. The proposal
dialog displays a notice to inform you about this. As long as there is sufficient disk
space available, YaST simply accepts your settings and partitions the hard disk accord-
ingly.
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Resizing a Windows Partition
If a hard disk containing a Windows FAT or NTFS partition was selected as the instal-
lation target, YaST offers to delete or shrink this partition. In this way, you can install
SUSE Linux even if there is currently not enough space on the hard disk. This function-
ality is especially useful if the selected hard disk contains only one Windows partition
that covers the entire hard disk. This is sometimes the case on computers where Windows
comes preinstalled. If YaST sees that there is not enough space on the selected hard
disk, but that space could be made available by deleting or shrinking a Windows parti-
tion, it presents a dialog in which to choose one of these two options.

Figure 1.5 Possible Options for Windows Partitions

If you selectDelete Windows Completely, the Windows partition is marked for deletion
and the space is used for the installation of SUSE Linux.

WARNING: Deleting Windows

If you delete Windows, all data will be lost beyond recovery as soon as the
formatting starts.
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To shrink the Windows partition, interrupt the installation and boot Windows to prepare
the partition from there. Although this step is not strictly required for FAT partitions,
it speeds up the resizing process and also makes it safer. These steps are vital for NTFS
partitions.

FAT File System

In Windows, first run scandisk to make sure that the FAT partition is free of lost
file fragments and crosslinks. After that, run defrag to move files to the beginning
of the partition. This accelerates the resizing procedure in Linux.

If you have optimized virtual memory settings for Windows so a contiguous swap
file is used with the same initial (minimum) and maximum size limit, consider an-
other step. With these Windows settings, the resizing might split the swap file into
many small parts scattered all over the FAT partition. Also, the entire swap file
would need to be moved during the resizing, which makes the process rather slow.
It is therefore useful to disable these Windows optimizations for the time being and
reenable them after the resizing has been completed.

NTFS File System

In Windows, run scandisk and defrag to move the files to the beginning of the hard
disk. In contrast to the FAT file system, you must perform these steps. Otherwise
the NTFS partition cannot be resized.

IMPORTANT: Disabling the Windows Swap File

If you operate your system with a permanent swap file on an NTFS file system,
this file may be located at the end of the hard disk and remain there despite
defrag. Therefore, it may be impossible to shrink the partition sufficiently. In
this case, temporarily deactivate the swap file (the virtual memory in Windows).
After the partition has been resized, reconfigure the virtual memory.

After these preparations, return to the Linux partitioning setup and select ShrinkWindows
Partition. After a quick check of the partition, YaST opens a dialog with a suggestion
for resizing the Windows partition.

14



Figure 1.6 Resizing the Windows Partition

The first bar graph shows how much disk space is currently occupied by Windows and
how much space is still available. The second bar graph shows how the space would
be distributed after the resizing, according to YaST's current proposal. See Figure 1.6,
“Resizing the Windows Partition” (page 15). Accept the proposed settings or use the
slider to change the partition sizing (within certain limits).

If you leave this dialog by selecting Next, the settings are stored and you are returned
to the previous dialog. The actual resizing takes place later, before the hard disk is for-
matted.

IMPORTANT: Windows Systems Installed on NTFS Partitions

By default, the Windows versions NT, 2000, and XP use the NTFS file system.
Unlike FAT file systems, NTFS file systems can only be read from Linux. This
means you can read your Windows files from Linux, but you cannot edit them.
If you want write access to your Windows data and do not need the NTFS file
system, reinstall Windows on a FAT32 file system. In this case, you will have
full access to your Windows data from SUSE Linux.

Installation with YaST 15



1.8.2 Software
SUSE Linux contains a number of software packages for various application purposes.
Click Software in the suggestion window to start the software installation module
(package manager) and modify the installation scope according to your needs. See
Figure 1.7, “Installing and Removing Software with the YaST Package Manager”
(page 16).

Figure 1.7 Installing and Removing Software with the YaST Package Manager

Changing the Installation Scope
If you install one of the default systems, there is usually no need to add or remove indi-
vidual packages. It consists of a software selection that meets most requirements without
any changes. If you have specific needs, modify this selection with the package manager,
which greatly eases this task. The package manager offers various filter criteria to
simplify selection from the numerous packages in SUSE Linux.

The filter selection box is located at the top left under the menu bar. After starting, the
active filter is Selections. This filter sorts program packages by application purpose,
such as multimedia or office applications. These groups are listed under the filter selec-
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tion box. The packages included in the current system type are preselected. Click the
check boxes to select or deselect entire selections or groups for installation.

The right part of the window displays a table listing the individual packages included
in the current selection. The table column furthest to the left shows the current status
of each package. Two status flags are especially relevant for the installation: Install
(the box in front of the package name is checked) andDo Not Install (the box is empty).
To select or deselect individual software packages, click the status box until the desired
status is displayed. Alternatively, right-click the package line to access a pop-up menu
listing all the possible status settings. To learn more about them, read the detailed de-
scription of this module in Section 3.2.1, “Installing and Removing Software” (page 51).

Other Filters
Click the filter selection box to view the other possible filters. The selection according
to Package Groups can also be used for the installation. This filter sorts the program
packages by subjects in a tree structure to the left. The more you expand the branches,
the more specific the selection of packages is and the fewer packages are displayed in
the list of associated packages to the right.

Use Search to search for a specific package. This is explained in detail in Section 3.2.1,
“Installing and Removing Software” (page 51).

Package Dependencies and Conflicts
You cannot simply install any combination of software packages. The different software
packages must be compatible. Otherwise they might interfere with each other and cause
conflicts that affect the system as a whole. Therefore, you may see alerts about unre-
solved package dependencies or conflicts after selecting or deselecting software packages
in this dialog. If you install SUSE Linux for the first time or if you do not understand
the alerts, read Section 3.2.1, “Installing and Removing Software” (page 51), which
provides detailed information about the operation of the package manager and a brief
summary of the software organization in Linux.

WARNING

The software preselected for installation is based on long-standing experience
and is usually suitable for the needs of most newcomers and advanced home
users. In general, there is no need to change anything here. However, if you
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decide to select or deselect any packages, you should be aware of the conse-
quences. In particular, observe any warnings and avoid deselecting any packages
of the base system.

Exiting the Software Selection
When satisfied with your software selection and all package dependencies or conflicts
are resolved, click Accept to apply your changes and exit the module. During the instal-
lation, the changes are recorded internally and applied later when the actual installation
starts.

1.8.3 Language
The language was selected at the beginning of the installation as described in Section 1.3,
“Language Selection” (page 5). However, you can change this setting here and also
select any additional languages to install on your system. In the upper part of this dialog,
select the primary language. This is the language that will be activated after installation.
Adapt your keyboard and time zone settings to the selected primary language by selecting
those options, if desired. Optionally, use Details to set the language for the user root.
There are three options:

ctype only
The value of the variable LC_CTYPE in the file /etc/sysconfig/language
is adopted for the user root. This sets the localization for language-specific function
calls.

yes
The user root has the same language settings as the local user.

no
The language settings for the user root are not affected by the language selection.
All locale variables will be unset.

Additionally the setting for the Locale can be set explicitly with Detailed Locale
Setting.

The list in the lower part of the language dialog allows for selecting additional languages
to install. For all the languages selected in this list, YaST checks if there are any lan-
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guage-specific packages for any packages in your current software selection. If so, these
packages are installed.

Click Accept to complete the configuration.

1.8.4 System
This dialog presents all the hardware information YaST could obtain about your com-
puter. Select any item in the list and click Details to see detailed information about the
selected item. You may also add PCI IDs to device drivers with this dialog.

1.8.5 Keyboard Layout
Select the keyboard layout from the list. By default, the layout corresponds to the se-
lected language. After changing the layout, test the characters that are special to the
selected language layout to make sure that the selection is correct. If you want to set
special options regarding keyboard behavior, click Expert Settings. Find more informa-
tion about that in Section 3.3.10, “Keyboard Layout” (page 69). When finished, click
Accept to return to the installation settings dialog.

1.8.6 Booting
During the installation, YaST proposes a boot configuration for your system. Normally,
you can leave these settings unchanged. However, if you need a custom setup, modify
the proposal for your system.

One possibility is to configure the boot mechanism to rely on a special boot floppy.
Although this has the disadvantage that it requires the floppy to be in the drive when
booting, it leaves an existing boot mechanism untouched. Normally this should not be
necessary, however, because YaST can configure the boot loader to boot other existing
operating systems as well. Another possibility with the configuration is to change the
location of the boot mechanism on the hard disk.

To change the boot configuration proposed by YaST, select Booting to open a dialog
in which to change many details of the boot mechanism. For information, read Sec-
tion “Configuring the Boot Loader with YaST” (Chapter 29, The Boot Loader, ↑Refer-
ence). The boot method should only be changed by experienced computer users.
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1.8.7 Default Runlevel
SUSE Linux can boot to different runlevels. Normally there should be no need to change
anything here, but if necessary set the default runlevel with this dialog. Refer to Sec-
tion 3.7.8, “System Services (Runlevel)” (page 91) for more information about runlevel
configuration.

1.8.8 Starting the Installation
After making all installation settings, click Accept in the suggestion window to begin
the installation. Confirm with Install in the dialog that opens. The installation usually
takes between 15 and 30 minutes, depending on the system performance and the software
selected. As soon as all packages are installed, YaST boots into the new Linux system,
after which you can configure the hardware and set up system services.

1.9 Finishing the Installation
After completing the basic system setup and the installation of all selected software
packages, provide a password for the account of the system administrator (the root
user). You can then configure your Internet access and network connection. With a
working Internet connection, you can perform an update of the system as part of the
installation. You can also configure an authentication server for centralized user admin-
istration in a local network. Finally, configure the hardware devices connected to the
machine.

1.9.1 root Password
root is the name of the superuser, the administrator of the system. Unlike regular users,
which may or may not have permission to do certain things on the system, root has
unlimited power to do anything: change the system configuration, install programs, and
set up new hardware. If users forget their passwords or have other problems with the
system, root can help. The root account should only be used for system administra-
tion, maintenance, and repair. Logging in as root for daily work is rather risky: a
single mistake could lead to irretrievable loss of many system files.
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For verification purposes, the password for root must be entered twice, as shown in
Figure 1.8, “Setting the root Password” (page 21). Do not forget the root password.
Once entered, this password cannot be retrieved.

WARNING: The root User

The user root has all the permissions needed to make changes to the system.
To carry out such tasks, the root password is required. You cannot carry out
any administrative tasks without this password.

Figure 1.8 Setting the root Password

1.9.2 Network Configuration
You can now configure any network devices for a connection to the outside world, such
as network cards, modems, and ISDN or DSL hardware. If you have such devices, it
is a good idea to configure them now, because an Internet connection allows YaST to
retrieve any available SUSE Linux updates and include them in the installation.
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Figure 1.9 Configuring the Network Devices

To configure your network hardware at this stage, refer to Section “Configuring a
Network Connection with YaST” (Chapter 38, Basic Networking, ↑Reference). Other-
wise, select Skip Configuration and click Next. The network hardware can also be
configured after the system installation has been completed.

1.9.3 Firewall Configuration
When you connect to a network, a firewall is started automatically on the configured
interface. The firewall settings are displayed in the network configuration dialog. The
configuration proposal for the firewall is updated automatically every time the configu-
ration of the interfaces or services is modified. To adapt the automatic settings to your
own preferences, click Change → Firewall. In the new dialog, determine whether the
firewall should be started. If you do not want the firewall to be started, select the appro-
priate option and exit the dialog. To start and configure the firewall, click Next for a
series of dialogs similar to those described in Section “Configuring with YaST”
(Chapter 23, Security in Linux, ↑Reference).
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1.9.4 Testing the Internet Connection
If you have configured an Internet connection, you can test it now. For this purpose,
YaST establishes a connection to the SUSE server and checks if any product updates
are available for your version of SUSE Linux. If there are such updates, they can be
included in the installation. Also, the latest release notes are downloaded. You can read
them at the end of the installation.

If you do not want to test the connection at this point, select Skip Test then Next. This
also skips downloading product updates and release notes.

1.9.5 Loading Software Updates
If YaST was able to connect to the SUSE servers, select whether to perform a YaST
online update. If there are any patched packages available on the servers, download
and install them now to fix known bugs or security issues.

IMPORTANT: Downloading Software Updates

The download of updates might take quite some time, depending on the
bandwidth of the Internet connection and the size of the update files.

To perform a software update immediately, select Perform Update Now and click OK.
This opens YaST's online update dialog with a list of the available patches (if any),
which can be selected and loaded. To learn about the process, read Section 3.2.3, “Up-
dating Software Online” (page 61). This kind of update can be performed at any time
after the installation. If you prefer not to update now, select Skip Update then clickOK.

1.9.6 User Authentication
If the network access was configured successfully during the previous steps of the in-
stallation, you now have four possibilities for managing user accounts on your system.

Local User Administration
Users are administered locally on the installed host. This is a suitable option for
stand-alone workstations. The user data is managed by the local file/etc/passwd.
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LDAP
Users are administered centrally on an LDAP server for all systems in the network.

NIS
Users are administered centrally on a NIS server for all systems in the network.

Samba
SMB authentication is often used in mixed Linux and Windows networks.

If all requirements are met, YaST opens a dialog in which to select the user administra-
tion method. If you do not have the necessary network connection, create local user
accounts.

1.9.7 Configuring the Host as a NIS Client
To implement the user administration via NIS, configure a NIS client in the next step.
This section only describes the configuration of the client side. Configuration of a NIS
server with YaST is described in Chapter Using NIS (↑Reference).

Figure 1.10 NIS Client Configuration
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In the dialog shown in Figure 1.10, “NIS Client Configuration” (page 24), first select
whether the host has a static IP address or gets one via DHCP. If you select DHCP, you
cannot specify a NIS domain or NIS server address, because these are provided by the
DHCP server. Information about DHCP is available in Chapter DHCP (↑Reference).
If a static IP address is used, specify the NIS domain and the NIS server manually.

To search for NIS servers broadcasting in the network, check the relevant option. You
can also specify several NIS domains and set a default domain. For each domain, select
Edit to specify several server addresses or enable the broadcast function on a per-domain
basis.

In the expert settings, use Answer Remote Hosts to allow other network hosts to query
which server your client is using. If you activate Broken Server, responses from servers
on unprivileged ports are also accepted. For more information, refer to the man page
of ypbind.

1.9.8 Creating Local User Accounts
If you decide against using an authentication server for user authentication, create local
users. Any data related to user accounts (name, login, password, etc.) is stored and
managed on the installed system.

Linux is an operating system that allows several users to work on the same system at
the same time. Each user needs a user account to log in to the system. By having user
accounts, the system gains a lot in terms of security. For instance, regular users cannot
change or delete files needed for the system to work properly. At the same time, the
personal data of a given user cannot be modified, viewed, or tampered with by other
users. Users can set up their own working environments and always find them unchanged
when logging back in.
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Figure 1.11 Entering the Username and Password

A user account can be created using the dialog shown in Figure 1.11, “Entering the
Username and Password” (page 26). After entering the first name and last name,
specify a username (login). Click Suggestion for the system to generate a username
automatically.

Finally, enter a password for the user. Reenter it for confirmation (to ensure that you
did not type something else by mistake). The username tells the system who a user is
and the password is used to verify this identity.

WARNING: Username and Password

Remember both your username and the password because they are needed
each time you log in to the system.

To provide effective security, a password should be between five and eight characters
long. The maximum length for a password is 128 characters. However, if no special
security modules are loaded, only the first eight characters are used to discern the
password. Passwords are case-sensitive. Special characters like umlauts are not allowed.
Other special characters (7-bit ASCII) and the digits 0 to 9 are allowed.
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Two additional options are available for local users:

Receive System Messages via E-Mail
Checking this box sends the user messages created by the system services. These
are usually only sent to root, the system administrator. This option is useful for
the most frequently used account, because it is highly recommended to log in as
root only in special cases.

Automatic Login
This option is only available if KDE is used as the default desktop. It automatically
logs the current user into the system when it starts. This is mainly useful if the
computer is operated by only one user.

WARNING: Automatic Login

With the automatic login enabled, the system boots straight into your desktop
with no authentication at all. If you store sensitive data on your system, you
should not enable this option if the computer can also be accessed by others.

Click User Management to create more than one user. Refer to Section 3.6.1, “User
Management” (page 79) for more information about user management.

1.9.9 Release Notes
After completing the user authentication setup, YaST displays the release notes. Reading
them is advised because they contain important up-to-date information that was not
available when the manuals were printed. If you have installed update packages, read
the most recent version of the release notes, as fetched from SUSE's servers.

1.10 Hardware Configuration
At the end of the installation, YaST opens a dialog for the configuration of the graphics
card and other hardware components connected to the system, such as printers or sound
cards. Click the individual components to start the hardware configuration. For the most
part, YaST detects and configures the devices automatically.
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You can skip any peripheral devices and configure them later. However, you should
configure the graphics card right away. Although the display settings as autoconfigured
by YaST should be generally acceptable, most users have very strong preferences as
far as resolution, color depth, and other graphics features are concerned. To change
these settings, select the respective item and set the values as desired. The configuration
is further explained in Section 3.11.1, “Card and Monitor Properties” (page 101). Finish
the installation of SUSE Linux with Finish in the final dialog.

1.11 Graphical Login
SUSE Linux is now installed. Start without logging in if you enabled the automatic login
in the local user administration module. If not, you should see the graphical login on
your screen, as shown in Figure 1.12, “The Login Screen of KDM” (page 28). Enter
your login and password to log in to the system.

Figure 1.12 The Login Screen of KDM
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2Updating the System and Package
Management
SUSE Linux provides the option of updating an existing system without completely
reinstalling it. There are two types of updates: updating individual software packages
and updating the entire system. Packages can also be installed by hand using the package
manager RPM.

2.1 Updating SUSE Linux
Software tends to “grow” from version to version. Therefore, take a look at the available
partition space with df before updating. If you suspect you are running short of disk
space, secure your data before updating and repartition your system. There is no general
rule of thumb regarding how much space each partition should have. Space requirements
depend on your particular partitioning profile, the software selected, and the version
numbers of SUSE Linux.

2.1.1 Preparations
Before updating, copy the old configuration files to a separate medium, such as
streamer, removable hard disk, USB stick, or ZIP drive, to secure the data. This primar-
ily applies to files stored in /etc as well as some of the directories and files in /var
and /opt. You may also want to write the user data in /home (the HOME directories)
to a backup medium. Back up this data as root. Only root has read permission for
all local files.
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Before starting your update, make note of the root partition. The command df / lists
the device name of the root partition. In Example 2.1, “List with df -h” (page 30),
the root partition to write down is /dev/hda3 (mounted as /).

Example 2.1 List with df -h
Filesystem     Size  Used Avail Use% Mounted on
/dev/hda3       74G   22G   53G  29% /
tmpfs          506M     0  506M   0% /dev/shm
/dev/hda5      116G  5.8G  111G   5% /home
/dev/hda1       39G  1.6G   37G   4% /windows/C
/dev/hda2      4.6G  2.6G  2.1G  57% /windows/D

2.1.2 Possible Problems
If you update a default system from the previous version to this version, YaST works
out necessary changes and performs them. Depending on your customizations, some
steps or the entire update procedure may fail and you must resort to copying back your
backup data. Here, we point out more issues to check before starting the system update.

Checking passwd and group in /etc
Before updating the system, make sure that /etc/passwd and /etc/group do not
contain any syntax errors. For this purpose, start the verification utilities pwck and
grpck as root and eliminate any reported errors.

PostgreSQL
Before updating PostgreSQL (postgres), dump the databases. See the manual page
of pg_dump. This is only necessary if you actually used PostgreSQL prior to your
update.

2.1.3 Updating with YaST
Following the preparation procedure outlined in Section 2.1.1, “Preparations” (page 29),
you can now update your system:
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1 Boot the system as for the installation, described in Section 1.1, “System Start-
Up for Installation” (page 3). In YaST, choose a language and select Update
in the Installation Mode dialog. Do not select New Installation.

2 YaST determines whether there are multiple root partitions. If there is only one,
continue with the next step. If there are several, select the right partition and
confirm with Next (/dev/hda3 was selected in the example in Section 2.1.1,
“Preparations” (page 29)). YaST reads the old fstab on this partition to analyze
and mount the file systems listed there.

3 In the Installation Settings dialog, adjust the settings according to your require-
ments. Normally, you can leave the default settings untouched, but if you intend
to enhance your system, check the packages offered in the Software Selection
submenus or add support for additional languages.

You also have the possibility to make backups of various system components.
Selecting backups slows down the update process. Use this option if you do not
have a recent system backup.

4 In the following dialog, choose to update only the software that is already installed
or to add new software components to the system (upgrade mode). It is advisable
to accept the suggested composition, for example, Update Based on Selection
"Standard System with KDE" or "Standard System with GNOME". Adjustments
can be made later with YaST.

2.1.4 Updating Individual Packages
Regardless of your overall updated environment, you can always update individual
packages. From this point on, however, it is your responsibility to ensure that your
system remains consistent. Update advice can be found at http://www.novell
.com/linux/download/updates/.

Select components from the YaST package selection list according to your needs. If
you select a package essential for the overall operation of the system, YaST issues a
warning. Such packages should be updated only in the update mode. For example, many
packages contain shared libraries. If you update these programs and applications in
the running system, things might malfunction.
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2.2 Software Changes from Version
to Version

The individual aspects changed from version to version are outlined in the following
in detail. This summary indicates, for example, whether basic settings have been com-
pletely reconfigured, whether configuration files have been moved to other places, or
whether common applications have been significantly changed. Significant modifications
that affect the daily use of the system at either the user level or the administrator level
are mentioned here.

Problems and special issues of the respective versions are published online as they are
identified. See the links listed below. Important updates of individual packages can be
accessed at http://www.novell.com/products/linuxprofessional/
downloads/ using the YaST Online Update (YOU)—see Section 3.2.3, “Updating
Software Online” (page 61).

2.2.1 From 9.0 to 9.1
Refer to the article “Known Problems and Special Features in SUSE Linux 9.1” in the
SUSE Support Database at http://portal.suse.com under the keyword special
features. These articles are published for every SUSE Linux version.

Upgrading to Kernel 2.6
SUSE Linux is now based entirely on kernel 2.6. The predecessor version 2.4 cannot
be used any longer, because the enclosed applications do not work with kernel 2.4.
Note the following details:

• The loading of modules is configured by means of the file /etc/modprobe
.conf. The file /etc/modules.conf is obsolete. YaST tries to convert the
file (also see script /sbin/generate-modprobe.conf).

• Modules have the suffix .ko.

• The module ide-scsi is no longer needed for burning CDs.

• The prefix snd_ has been removed from the ALSA sound module options.
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• sysfs now complements the /proc file system.

• Power management (especially ACPI) has been improved and can be configured
by means of a YaST module.

Mounting VFAT Partitions
When mounting VFAT partitions, the parametercodemust be changed tocodepage.
If you have difficulties mounting a VFAT partition, check if the file /etc/fstab
contains the old parameter name.

Standby and Suspend with ACPI
The kernel 2.6 supports standby and suspend with ACPI. This function is still in an
experimental stage and may not be supported by some hardware components. To use
this function, you need the powersave package. Information about this package is
available in /usr/share/doc/packages/powersave. A graphical front-end
is available in the kpowersave package.

Input Devices
Regarding the changes in connection with the input devices, refer to the already-men-
tioned portal article “Known Problems and Special Features in SUSE LINUX 9.1” in
the Support Database at http://portal.suse.com under the keyword special
features.

Native POSIX Thread Library and glibc 2.3.x
Applications linked against NGPT (Next Generation POSIX Threading) do not work
with glibc 2.3.x. All affected applications that are not shipped with SUSE Linux must
be compiled with linuxthreads or with NPTL (Native POSIX Thread Library). NPTL
is preferred, because this is the standard for the future.

If NPTL causes difficulties, the older linuxthreads implementation can be used by setting
the following environment variable (replace kernel-version with the version
number of the respective kernel):
LD_ASSUME_KERNEL=kernel-version
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The following version numbers are possible:

2.2.5 (i386, i586):
linuxthreads without floating stacks

2.4.1 (AMD64, i586, i686):
linuxthread with floating stacks

Notes regarding the kernel and linuxthreads with floating stacks: Applications using
errno, h_errno, and _res must include the header files (errno.h, netdb.h,
and resolv.h) with #include. For C++ programs with multithread support that
use thread cancellation, the environment variable LD_ASSUME_KERNEL=2.4.1
must be used to prompt the use of the linuxthreads library.

Adaptations for Native POSIX Thread Library
NPTL is included in SUSE Linux 9.1 as the thread package. NPTL is binary-compatible
with the older linuxthreads library. However, areas in which linuxthreads violates the
POSIX standard require NPTL adaptions. This includes the following: signal handling,
getpid returning the same value in all threads, and thread handlers registered with
pthread_atfork not working if vfork is used.

Network Interface Configuration
The configuration of the network interface has changed. Formerly, the hardware was
initialized following the configuration of a nonexistent interface. Now, the system
searches for new hardware and initializes it immediately, enabling the configuration of
the new network interface.

New names have been introduced for the configuration files. Because the name of a
network interface is generated dynamically and the use of hotplug devices is increasing
steadily, a name like eth0 or eth1 is no longer suitable for configuration purposes.
For this reason, unique designations, like the MAC address or the PCI slot, are used
for naming interface configurations. You can use interface names as soon as they appear.
Commands like ifup eth0 or ifdown eth0 are still possible.

The device configurations are located in /etc/sysconfig/hardware. The inter-
faces provided by these devices are usually located in /etc/sysconfig/network
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(with different names). See the detailed description in /usr/share/doc/
packages/sysconfig/README.

Sound Configuration
Following an update, the sound cards must be reconfigured. This can be done with the
YaST sound module. As root, enter /sbin/yast2 sound.

Top-Level Domain .local as “link-local” Domain
The resolver library treats the top-level domain .local as “link-local” domain and
sends multicast DNS queries to the multicast address 224.0.0.251, port 5353, in-
stead of normal DNS queries. This is an incompatible change. If the domain .local
is already used in the name server configuration, use a different domain name. For more
information about multicast DNS, see http://www.multicastdns.org.

Systemwide UTF-8 Encoding
The default encoding for the system is UTF-8. Thus, when performing a standard in-
stallation, a locale is set with UTF-8 encoding, such as en_US.UTF-8. For more in-
formation, seehttp://www.suse.de/~mfabian/suse-cjk/locales.html.

Converting Filenames to UTF-8
Files in previously created file systems do not use UTF-8 encoding for the filenames
(unless specified otherwise). If these filenames contain non-ASCII characters, they will
be garbled. To correct this, use the convmv script, which converts the encoding of
filenames to UTF-8.

Shell Tools Compatible with POSIX Standard of 2001
In the default setting, shell tools from the coreutils package (tail, chown, head,
sort, etc.) no longer comply with the POSIX standard of 1992 but with the POSIX
standard of 2001 (Single UNIX Specification, version 3 == IEEE Std 1003.1-2001 ==
ISO/IEC 9945:2002). The old behavior can be forced with an environment variable:
_POSIX2_VERSION=199209
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The new value is 200112 and is used as the default for _POSIX2_VERSION. The SUS
standard can be reviewed (free of charge, but registration is required) at http://www
.unix.org.

TIP

Third-party software may not yet comply with the new standard. In this case,
set the environment variable as described above.

/etc/gshadow Obsolete
/etc/gshadow has been abandoned and removed, because this file is superfluous
for the following reasons:

• It is not supported by glibc.

• There is no official interface for this file. Even the shadow suite does not contain
such an interface.

• Most tools that check the group password do not support the file and ignore it for
the said reasons.

OpenLDAP
Because the database format has changed, the databases must be regenerated. During
the update, the system attempts to perform this conversion automatically. However,
there will certainly be cases in which the conversion fails.

The schema check has undergone substantial improvement. Therefore, a number of
standard-noncompliant operations that were possible with the former LDAP server are
no longer possible.

The syntax of the configuration file has partly changed with a view to ACLs. Following
the installation, information regarding the update is available in the file /usr/share/
doc/packages/openldap2/README.update.
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Apache 1.3 Replaced with Apache 2
The Apache Web server (version 1.3) has been replaced with Apache 2. Detailed doc-
umentation for version 2.0 is available at the Web page http://httpd.apache
.org/docs-2.0/en/. On a system with an HTTP server installation, an update
removes the Apache package and installs Apache 2. Subsequently, the system must be
adapted with YaST or manually. The configuration files in /etc/httpd are now lo-
cated in /etc/apache2.

Either threads or processes can be selected for handling multiple concurrent queries.
The process management has been moved to an independent module, the multiprocessing
module (MPM). Accordingly, Apache 2 needs the apache2-prefork package
(recommended for stability) or the apache2-worker package. Depending on the
MPM, Apache 2 reacts differently to queries. This affects the performance as well as
the use of modules. These characteristics are discussed in detail in Section “Multipro-
cessing Modules” (Chapter 46, The Apache Web Server, ↑Reference).

Apache 2 now supports the next-generation Internet protocol IPv6.

A mechanism has been implemented that enables module programmers to specify the
desired loading sequence of the modules, relieving users of this task. The sequence in
which modules are executed is often important. In earlier versions, it was determined
by means of the loading sequence. For instance, a module that only gives authenticated
users access to certain resources must be loaded first to prevent users without access
permissions from seeing the pages.

Queries to and responses from Apache can be processed with filters.

From Samba 2.x to Samba 3.x
Following the update from Samba 2.x to Samba 3.x, winbind authentication is no
longer available. The other authentication methods can still be used. For this reason,
the following programs have been removed:
/usr/sbin/wb_auth
/usr/sbin/wb_ntlmauth
/usr/sbin/wb_info_group.pl

See also http://www.squid-cache.org/Doc/FAQ/FAQ-23.html#ss23
.5.
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OpenSSH Update (Version 3.8p1)
gssapi support has been replaced with gssapi-with-mic to prevent potential
MITM attacks. These two versions are not compatible. This means that you cannot
authenticate with Kerberos tickets from older distributions, because other authentication
methods are used.

SSH and Terminal Applications
When establishing a connection from a remote host (especially via SSH, telnet, and
RSH) between version 9 (standard configuration with activated UTF-8) and older systems
(SUSE Linux 9.0 and earlier versions in which UTF-8 is not activated by default or not
supported), terminal applications may display faulty characters.

This is because OpenSSH does not forward local settings. Therefore, the default system
settings that may not match the remote terminal settings are used. This affects YaST
in text mode and applications executed from a remote host as a normal user (not root).
The applications started by root are only affected if the user changes the standard lo-
cales for root (only LC_CTYPE is set by default).

libiodbc Discarded
Users of FreeRADIUS must now link against unixODBC, because libiodbc has been
discarded.

XML Resources in /usr/share/xml

XML resources (DTDs, stylesheets, etc.) are installed in/usr/share/xml. Therefore,
some directories are no longer available in /usr/share/sgml. If you encounter
problems, modify your scripts and makefiles or use the official catalogs (especially
/etc/xml/catalog or /etc/sgml/catalog).

Removable Media with subfs
Removable media are now integrated with subfs. Media no longer need to be mounted
manually with mount. To mount the medium, simply change to the respective device
directory in/media. Media cannot be ejected as long as they are accessed by a program.
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2.2.2 From 9.1 to 9.2
Refer to the article “Known Problems and Special Features in SUSE LINUX 9.2” in
the SUSE Support Database at http://portal.suse.com under the keyword
special features.

Activation of the Firewall in the Proposal Dialog
During the Installation
To increase the security, the enclosed firewall solution SuSEFirewall2 is activated at
the end of the installation in the proposal dialog. This means that all ports are closed
initially and can be opened in the proposal dialog if necessary. By default, you cannot
log in from remote systems. It also interferes with network browsing and multicast ap-
plications, such as SLP, Samba ("Network Neighborhood"), and some games. You can
fine-tune the firewall settings using YaST.

If network access is required during the installation or configuration of a service, the
respective YaST module opens the needed TCP and UDP ports of all internal and ex-
ternal interfaces. If this is not desired, the user can close the ports in the YaST module
or specify other detailed firewall settings.

KDE and IPv6 Support
By default, IPv6 support is not enabled for KDE. You can enable it using the /etc/
sysconfig editor of YaST. The reason for disabling this feature is that IPv6 addresses
are not properly supported by all Internet service providers and, as a consequence, this
would lead to error messages while browsing the Web and delays while displaying Web
pages.

YaST Online Update and Delta Packages
The YaST Online Update now supports a special kind of RPM package that only stores
the binary difference from a given base package. This technique significantly reduces
the package size and download time at the expense of higher CPU load for reassembling
the final package. In/etc/sysconfig/onlineupdate, configure whether YOU
should use these delta packages. See /usr/share/doc/packages/deltarpm/
README for technical details.
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Print System Configuration
At the end of the installation (proposal dialog), the ports needed for the print system
must be open in the firewall configuration. Port 631/TCP and port 631/UDP are needed
for CUPS and should not be closed for normal operation. Port 515/TCP (for the old
LPD protocol) and the ports used by Samba must also be open for printing via LPD or
SMB.

Change to X.Org
The change from XFree86 to X.Org is facilitated by compatibility links that enable access
to important files and commands with the old names.

Table 2.1 Commands

X.OrgXFree86

XorgXFree86

xorgconfigxf86config

xorgcfgxf86cfg

Table 2.2 Log Files in /var/log

X.OrgXFree86

Xorg.0.logXFree86.0.log

Xorg.0.log.oldXFree86.0.log.old

In the course of the change to X.Org, the packages were renamed from XFree86* to
xorg-x11*.

Terminal Emulators for X11
We have removed a number of terminal emulators because they are either no longer
maintained or do not work in the default environment, especially by not supporting
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UTF-8. SUSE Linux offers standard terminals, such as xterm, the KDE and GNOME
terminals, and mlterm (Multilingual Terminal Emulator for X), which might be a re-
placement for aterm and eterm.

Changes in the powersave Package
The configuration files in /etc/sysconfig/powersave have changed:

Table 2.3 Split Configuration Files in /etc/sysconfig/powersave

Now split intoOld

common/etc/sysconfig/powersave/
common

cpufreq

events

battery

sleep

thermal

/etc/powersave.conf has become obsolete. Existing variables have been moved
to the files listed in Table 2.3, “Split Configuration Files in /etc/sysconfig/powersave”
(page 41). If you changed the “event” variables in /etc/powersave.conf, these
must now be adapted in /etc/sysconfig/powersave/events.

The names of sleep states have changed from:

• suspend (ACPI S4, APM suspend)

• standby (ACPI S3, APM standby)

To:

• suspend to disk (ACPI S4, APM suspend)
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• suspend to ram (ACPI S3, APM suspend)

• standby (ACPI S1, APM standby)

OpenOffice.org (OOo)
Directories:

OOo is now installed in /usr/lib/ooo-1.1 instead of /opt/OpenOffice
.org. The default directory for user settings is now ~/.ooo-1.1 instead of ~/
OpenOffice.org1.1.

Wrapper:
There are some new wrappers for starting the OOo components. The new names
are shown Table 2.4, “Wrapper” (page 42).

Table 2.4 Wrapper

NewOld

/usr/bin/oocalc/usr/X11R6/bin/OOo-calc

/usr/bin/oodraw/usr/X11R6/bin/OOo-draw

/usr/bin/ooimpress/usr/X11R6/bin/OOo-impress

/usr/bin/oomath/usr/X11R6/bin/OOo-math

/usr/sbin/oopadmin/usr/X11R6/bin/OOo-padmin

–/usr/X11R6/bin/OOo-setup

/usr/bin/oofromtemplate/usr/X11R6/bin/OOo-template

/usr/bin/ooweb/usr/X11R6/bin/OOo-web

/usr/bin/oowriter/usr/X11R6/bin/OOo-writer

/usr/bin/ooffice/usr/X11R6/bin/OOo
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NewOld

/usr/bin/ooo-wrapper/usr/X11R6/bin/OOo-wrapper

The wrapper now supports the option --icons-set for switching between KDE
and GNOME icons. The following options are no longer supported:
--default-configuration, --gui, --java-path, --skip-check,
--lang (the language is now determined by means of locales),
--messages-in-window, and --quiet.

KDE and GNOME Support:
KDE and GNOME extensions are available in the OpenOffice_org-kde and
OpenOffice_org-gnome packages.

Sound Mixer kmix
The sound mixer kmix is preset as the default. For high-end hardware, there are other
mixers, like QAMix. KAMix, envy24control (only ICE1712), or hdspmixer (only RME
Hammerfall).

DVD Burning
In the past, a patch was applied to the cdrecord binary from the cdrecord package
to support burning DVDs. Instead, a new binary cdrecord-dvd is installed that has
this patch.

The growisofs program from the dvd+rw-tools package can now burn all DVD
media (DVD+R, DVD-R, DVD+RW, DVD-RW, DVD+RL). Try using that one instead
of the patched cdrecord-dvd.

Multiple Kernels
It is possible to install multiple kernels side by side. This feature is meant to allow ad-
ministrators to upgrade from one kernel to another by installing the new kernel, verifying
that the new kernel works as expected, then uninstalling the old kernel. While YaST
does not yet support this feature, kernels can easily be installed and uninstalled from
the shell using rpm -i package.rpm.
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The default boot loader menus contain one kernel entry. Before installing multiple
kernels, it is useful to add an entry for the extra kernels, so that they can easily be se-
lected. The kernel that was active before installing a new kernel can be accessed as
vmlinuz.previous and initrd.previous. By creating a boot loader entry
similar to the default entry and having this entry refer to vmlinuz.previous and
initrd.previous instead of vmlinuz and initrd, the previously active kernel
can be accessed. Alternatively, GRUB and LILO support wild card boot loader entries.
Refer to the GRUB info pages (info grub) and to the lilo.conf (5) manual page
for details.

2.2.3 From 9.2 to 9.3
Refer to the article “Known Problems and Special Features in SUSE Linux 9.3” in the
SUSE Support Database at http://portal.suse.com under the keyword special
features.

Starting Manual Installation at the Kernel Prompt
The Manual Installation mode is gone from the boot loader screen. You can still get
linuxrc into manual mode using manual=1 at the boot prompt. Normally this is not
necessary because you can set installation options at the kernel prompt directly, such
as textmode=1 or a URL as the installation source.

Kerberos for Network Authentication
Kerberos is the default for network authentication instead of heimdal. Converting
an existing heimdal configuration automatically is not possible. During a system update,
backup copies of configuration files are created as shown in Table 2.5, “Backup Files”
(page 44).

Table 2.5 Backup Files

Backup FileOld File

/etc/krb5.conf.heimdal/etc/krb5.conf

/etc/krb5.keytab.heimdal/etc/krb5.keytab
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The client configuration (/etc/krb5.conf) is very similar to the one of heimdal.
If nothing special was configured, it is enough to replace the parameter
kpasswd_server with admin_server.

It is not possible to copy the server-related (kdc and kadmind) data. After the system
update, the old heimdal database is still available under /var/heimdal. MIT kerberos
maintains the database under /var/lib/kerberos/krb5kdc.

JFS: Not Supported Anymore
Due to technical problems with JFS, it is no longer supported. The kernel file system
driver is still there, but YaST does not offer partitioning with JFS.

AIDE as a Tripwire Replacement
As an intrusion detection system, use AIDE (package name aide), which is released
under the GPL. Tripwire is no longer available on SUSE Linux.

X.Org Configuration File
The configuration tool SaX2 writes the X.Org configuration settings into /etc/X11/
xorg.conf. During an installation from scratch, no compatibility link from
XF86Config to xorg.conf is created.

XView and OpenLook Support Dropped
The packages xview, xview-devel, xview-devel-examples, olvwm, and
xtoolpl were dropped. In the past, we just provided the XView (OpenLook) base
system. The XView libraries are no longer provided after the system update. Even more
important, OLVWM (OpenLook Virtual Window Manager) is no longer available.

PAM Configuration
New Configuration Files (containing comments for more information)

common-auth
Default PAM configuration for auth section
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common-account
Default PAM configuration for account section

common-password
Default PAM configuration for password changing

common-session
Default PAM configuration for session management

You should include these default configuration files from within your application-spe-
cific configuration file, because it is easier to modify and maintain one file instead of
the approximately forty files that used to exist on the system. If you install an application
later, it inherits the already applied changes and the administrator is not required to re-
member to adjust the configuration.

The changes are simple. If you have the following configuration file (which should be
the default for most applications):
#%PAM-1.0
auth     required       pam_unix2.so
account  required       pam_unix2.so
password required       pam_pwcheck.so
password required       pam_unix2.so    use_first_pass use_authtok
#password required      pam_make.so     /var/yp
session required        pam_unix2.so

you can change it to:
#%PAM-1.0
auth     include        common-auth
account  include        common-account
password include        common-password
session  include        common-session

Stricter tar Syntax
The tar usage syntax is stricter now. The tar options must come before the file or
directory specifications. Appending options, like --atime-preserve or
--numeric-owner, after the file or directory specification makes tar fail. Check
your backup scripts. Commands such as the following no longer work:
tar czf etc.tar.gz /etc --atime-preserve

See the tar info pages for more information.
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2.2.4 From 9.3 to 10.0
Refer to the article “Known Problems and Special Features in SUSE Linux 10” in the
SUSE Support Database at http://portal.suse.com under the keyword special
features.

Becoming the Superuser Using su
By default, calling su to become root does not set the PATH for root. Either call
su - to start a login shell with the complete environment for root or set
ALWAYS_SET_PATH toyes in/etc/default/su if you want to change the default
behavior of su.

Powersave Configuration Variables
Names of the powersave configuration variables are changed for consistency, but the
sysconfig files are still the same. Find more information in Section “Configuring the
powersave Package” (Chapter 21, Power Management, ↑Reference).

PCMCIA
cardmgr no longer manages PC cards. Instead, as with Cardbus cards and other sub-
systems, a kernel module manages them. All necessary actions are executed by
hotplug. The pcmcia start script has been removed and cardctl is replaced by
pccardctl. For more information, see /usr/share/doc/packages/
pcmciautils/README.SUSE.

TEI XSL Stylesheets
Find the TEI XSL stylesheets (tei-xsl-stylesheets) with a new directory layout
at /usr/share/xml/tei/stylesheet/rahtz/current. From there, for
example, use base/p4/html/tei.xsl to produce HTML output. For more infor-
mation, see http://www.tei-c.org/Stylesheets/teic/
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3System Configuration with YaST
YaST, the setup tool used for installation, is also the configuration tool for SUSE Linux.
This chapter covers the configuration of your system with YaST. This includes most
of the hardware, the graphical user interface, Internet access, security settings, user
administration, installation of software, system updates, and system information. Both
graphical and text modes of YaST are available and provide the same functionality.

Configure the system with YaST using various YaST modules. Depending on the
hardware platform and the installed software, there are different ways to access YaST
in the installed system.

In KDE or GNOME, start the YaST Control Center from the SUSE menu (System →
YaST). The individual YaST configuration modules are also integrated in the KDE
Control Center. Before YaST starts, you are prompted to enter the root password, because
YaST needs system administrator permissions to change the system files.

To start YaST from the command line, enter the commands su (for changing to the
user root) and yast2. To start the text version, enter yast instead of yast2. Also
use the command yast to start the program from one of the virtual consoles.

TIP

To change the language of YaST, select System → Language Selection in the
YaST Control Center. Choose a language, exit the YaST Control Center, log out
of the system, then log in again. The next time you start YaST, the new language
setting is used.
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For hardware platforms that do not support a display device of their own and for remote
administration on other hosts, run YaST remotely. First, open a console on the host on
which to display YaST and enter the command
ssh -X root@<system-to-configure> to log in to the system to configure
root and redirect the X server output to your terminal. Following the successful SSH
login, enter yast2 to start YaST in graphical mode.

To start YaST in text mode on another system, use
ssh root@<system-to-configure> to open the connection. Then start YaST
with yast.

3.1 The YaST Control Center
When you start YaST in the graphical mode, the YaST Control Center, as shown in
Figure 3.1, “The YaST Control Center” (page 51), opens. The left frame contains the
available categories. When you click a category, its contents are listed in the right frame.
Then select the desired module. For example, if you select Hardware and click Sound
in the right frame, a configuration dialog opens for the sound card. The configuration
of the individual items usually consists of several steps. Press Next to proceed to the
following step.

The left frame of most modules displays the help text, which offers suggestions for
configuration and explains the required entries. To get help in modules without a help
frame, press F1 or choose Help. After selecting the desired settings, complete the pro-
cedure by pressing Accept on the last page of the configuration dialog. The configuration
is then saved.
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Figure 3.1 The YaST Control Center

3.2 Software

3.2.1 Installing and Removing Software
To install, uninstall, and update software on your machine, use Software Management.
In Linux, software is available in the form of packages. Normally, a package contains
everything needed for a program: the program itself, the configuration files, and all
documentation. A package containing the source files for the program is also normally
available. The sources are not needed for running the program, but you may want to
install the sources to compile a custom version of the program.

Some packages depend on other packages. This means that the software of the package
only works properly if another package is also installed. The installation of some
packages is only possible if certain other packages are installed, perhaps because the
installation routine requires specific tools. Such packages must be installed in the correct
sequence. There are some packages with identical or similar functionalities. If these
packages use the same system resource, they should not be installed at the same time
(package conflict). Dependencies and conflicts can occur between two or more packages
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and are sometimes very complex. The fact that a specific package version may be re-
quired for smooth interaction can make things even more complicated.

All these factors must be taken into consideration when installing, uninstalling, and
updating software. YaST provides an extremely efficient tool for this purpose: the
software installation module, usually referred to as the package manager. When the
package manager starts, it examines the system and displays installed packages. If you
select additional packages for installation, the package manager automatically checks
the dependencies and selects any other required packages (resolution of dependencies).
If you select conflicting packages, the package manager indicates this and submits
suggestions for solving the problem (resolution of conflicts). If a package required by
other installed packages is marked for deletion, the package manager issues an alert
with detailed information and alternative solutions.

Also use the package manager for the well-structured overview of the range of packages
in SUSE Linux that it provides. The packages are arranged by subject and you can restrict
display of these groups with filters.

To start the package manager, select Software Manager. This opens a dialog as shown
in Figure 3.2, “YaST Package Manager” (page 53). Modify the frame sizes by clicking
and moving the borders separating the areas. The contents of the frames and their uses
are described in the following sections.
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Figure 3.2 YaST Package Manager

The Filter Window
Arrange the packages in categories and limit the number of packages displayed with
the filters. View the filters in the left frame. The frame displays the settings for the
current filter method. Choose the desired filter from the list in Filter.

Selections
Initially, the Selections filter is active. It groups the program packages according to
their application purpose, such as multimedia or office applications. The various
groups of the Selections filter are listed with the installed packages preselected.
Click the status box at the beginning of a line to change the status flags of a selection.
Select a status directly by right-clicking the selection and using the context menu.
From the individual package overview to the right, which displays the packages
included in the current selection, select and deselect individual packages.

Package Groups
Package Groups provides a more technical overview of the range of packages and
is suitable if you are familiar with the package structure of SUSE Linux. This filter
sorts the program packages by subjects, such as applications, development, and
hardware, in a tree structure to the left. The more you expand the branches, the more
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specific the selection is. This means fewer packages are displayed in the individual
package window.

Additionally, this filter lets you display all packages in alphabetic order without
any categorization. To do this, select zzz All at the bottom of the tree. SUSE Linux
contains a number of packages and it might take some time to display this long list.

Search
Find a specific package with Search. By specifying various search criteria, restrict
the search to display a few or even only one package. Enter a search string and use
the check boxes to determine where to search for this string (in the name, in the
description, or in the package dependencies). You can define special search patterns
using wild cards and regular expressions and search the package dependencies in
the Provides and Requires fields.

TIP: Quick Search

In addition to the Search filter, all lists of the package manager feature a
quick search. Simply enter a letter to move the cursor to the first package
in the list whose name begins with this letter. The cursor must be in the list
(by clicking the list).

Languages
To find language-specific packages, such as translated texts for the user interface
of programs, documentation, and fonts, use Language. This filter shows a list of all
languages supported by SUSE Linux. If you select one of these, the right frame
shows all packages available for this language. Among these, all packages applying
to your current software selection are automatically tagged for installation.

NOTE

Because language-specific packages may depend on other packages, the
package manager may select additional packages for installation.

Installation Summary
After selecting the packages for installation, update, or deletion, view the installation
summary with Installation Summary. It shows how packages will be affected when
you click Accept. Use the check boxes to the left to filter the packages to view in
the individual package window. For example, to check which packages are already
installed, start the package manager and deactivate all check boxes except Keep.
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The package status in the individual package window can be changed as usual.
However, the respective package may no longer meet the search criteria. To remove
such packages from the list, update the list with Update List.

The Individual Package Window
As already mentioned, a list of individual packages is displayed to the right in the indi-
vidual package window. The content of this list is determined by the currently selected
filter. If, for example, the Selection filter is selected, the individual package window
displays all packages of the current selection.

In the package manager, each package has a status that determines what to do with the
package, such as “Install” or “Delete.” This status is shown by a symbol in a status box
at the beginning of the line. Toggle the status by clicking or selecting the desired status
from the menu that opens when the item is right-clicked. Depending on the current sit-
uation, some of the possible status flags may not be available for selection. For example,
a package that has not yet been installed cannot be set to “Delete.” View the available
status flags with Help → Symbols.

The package manager offers the following package status flags:

Do Not Install
This package is not installed and will not be installed.

Install
This package is not yet installed but will be installed.

Keep
This package is already installed and will not be changed.

Update
This package is already installed and will be replaced by the version on the installa-
tion medium.

Delete
This package is already installed and will be deleted.
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Taboo—Never Install
This package is not installed and will never be installed. It is treated as if it does
not exist on any of the installation media. If a package would automatically be se-
lected to resolve dependencies, the “Taboo” setting prevents this. However, this
may result in inconsistencies that must be resolved manually (dependency check).
“Taboo” is mainly intended for expert users.

Protected
This package is installed and should not be modified. Third-party packages (packages
without a SUSE signature) are automatically assigned this status to prevent them
from being overwritten by later versions existing on the installation media. This
may cause package conflicts that must be resolved manually.

Automatic Installation
This package has been automatically selected for installation because it is required
by another package (resolution of package dependencies). To deselect such a
package, the status “Taboo” may be necessary.

Automatic Update
This package is already installed. However, because another package requires a
newer version of this package, the installed version will automatically be updated.

Delete Automatically
This package is already installed, but existing package conflicts require that this
package be deleted. For example, this may be the case if the current package has
been replaced by a different package.

Automatic Installation (after selection)
This package has been automatically selected for installation because it is part of a
predefined selection, such as “Multimedia” or “Development.”

Automatic Update (after selection)
This package is already installed, but a newer version exists on the installation media.
This package is part of a predefined selection, such as “Multimedia” or “Develop-
ment,” selected for update and will automatically be updated.
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Delete Automatically (after selection)
This package is already installed, but a predefined selection (such as “Multimedia”
or “Development”) requires that this package be deleted. This does not happen very
often.

Additionally, you can decide whether to install the sources for a package. This informa-
tion complements the current package status and cannot be toggled with the mouse or
selected directly from the context menu. Instead, mark a check box at the end of the
package line. This option can also be accessed under Package.

Install Source
Also install the source code.

Do Not Install Source
The sources will not be installed.

The font color used for various packages in the individual package window provides
additional information. Installed packages for which a newer version is available on
the installation media are displayed in blue. Installed packages whose version numbers
are higher than those on the installation media are displayed in red. However, because
the version numbering of packages is not always linear, the information may not be
perfect, but should be sufficient to indicate problematic packages. If necessary, check
the version numbers in the information window.

The Information Window
Get information about the selected package in the tabs in the bottom right frame. The
description of the selected package is automatically active. Click the other tabs to view
technical data (package size, group, etc.), the list of other packages on which it depends,
or the version information.

The Resource Window
During the selection of the software, the resource window at the bottom left of the
module displays the prospective usage of all mounted file systems. The colored bar
graph grows with every selection. As long as it remains green, there is sufficient space.
The bar color slowly changes to red as you approach the limit of disk space. If you select
too many packages for installation, an alert is displayed.
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The Menu Bar
You can also use the menu bar at the top left of the window to access most of the
functions already described. Find important functions in the following four menus:

File
Select File → Export to save a list of all installed packages in a text file. This is
recommended if you want to replicate a specific installation scope at a later date or
on another system. Import a file generated in this way with Import to have the same
package selection as was saved. In both cases, define the location of the file or accept
the suggestion.

To exit the package manager without saving changes to the package selection, click
Exit—Discard Changes. To save your changes, select Quit—Save Changes. In this
case, all changes are applied and the program is terminated.

Package
The items in the Package menu always refer to the package currently selected in
the individual package window. Although all status flags are displayed, you can
only select those possible for the current package. Use the check boxes to specify
whether to install the sources of the package. All in This List opens a submenu listing
all package status flags that then affect all packages in this list.

Extras
The Extras menu offers options for handling package dependencies and conflicts.
If you have manually selected packages for installation, click Show Automatic
Package Changes to view the list of packages that the package manager has auto-
matically selected to resolve dependencies. If there are still unresolved package
conflicts, an alert is displayed and solutions suggested.

If you set package conflicts to Ignore, this information is saved permanently in the
system. To unignore dependencies, click Reset Ignored Dependency Conflicts.

Help
Help→ Overview provides a brief explanation of the package manager functional-
ity. A detailed description of the various package flags is available under Symbols.
If you prefer to operate programs without using the mouse, click Keys to view a list
of keyboard shortcuts.
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Dependency Check
Check Dependencies and Autocheck are located under the information window. If you
clickCheck Dependencies, the package manager checks if the current package selection
results in any unresolved package dependencies or conflicts. In the event of unresolved
dependencies, the required additional packages are selected automatically. For package
conflicts, the package manager opens a dialog that shows the conflict and offers various
options for solving the problem.

If you activate Autocheck, any change of a package status triggers an automatic check.
This is a useful feature, because the consistency of the package selection is monitored
permanently. However, this process consumes resources and can slow down the package
manager. For this reason, the autocheck is not activated by default. In either case, a
consistency check is performed when you confirm your selection with Accept.

For example, sendmail and postfixmay not be installed concurrently. Figure 3.3,
“Conflict Management of the Package Manager” (page 60) shows the conflict message
prompting you to make a decision. postfix is already installed. Accordingly, you
can refrain from installing sendmail, remove postfix, or take the risk and ignore
the conflict.

WARNING: Handling Package Conflicts

Unless you are very experienced, follow the suggestions of YaST when handling
package conflicts, because otherwise the stability and functionality of your
system could be endangered by the existing conflict.
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Figure 3.3 Conflict Management of the Package Manager

3.2.2 Selecting the Installation Source
You can use multiple installation sources of several types. Select them and enable their
use for installation or update using Installation Source. When started, it displays a list
of all previously registered sources. Following a normal installation from CD, only the
installation CD is listed. Click Add to include additional sources in this list. Sources
can be CDs, DVDs, or network sources, such as NFS and FTP servers. Even directories
on the local hard disk can be selected as the installation medium. See the detailed YaST
help text for more details.

All registered sources have an activation status in the first column of the list. Enable
or disable individual installation sources by clicking Activate or Deactivate. During
the installation of software packages or updates, YaST selects a suitable entry from the
list of activated installation sources. When you exit the module with Close, the current
settings are saved and applied to the configuration modules Software Management and
System Update.
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3.2.3 Updating Software Online
Install important updates and improvements with the YaST Online Update (YOU).
These patches are available for download on the SUSE FTP server and various mirror
servers.

Under Installation Source, select one of the various servers. When you select a server,
its URL is copied to the input field, where it can be edited. You can also specify local
URLs in the format file:/my/path or /my/path. Expand the existing list with
additional servers using New Server. Click Edit Server to modify the settings of the
currently selected server.

When the module starts, Manual Selection of Patches is active, enabling selection of
the patches to fetch. To apply all available recommended and security patches, deactivate
this option. However, depending on the bandwidth of the connection and the amount
of data to transmit, this can result in long download times.

If you activateDownload All Patches Again, all available patches, installable packages,
and descriptions are downloaded from the server. If this is not activated (default), only
patches not yet installed on your system are retrieved.

To configure a process that automatically looks for updates and applies them on a reg-
ular basis, clickConfigure Fully Automatic Update . This procedure is fully automated.
The system must be able to connect to the update server at the scheduled time.

To perform the update, click Next. For a manual update, this loads a list of all available
patches and starts the package manager, described in Section 3.2.1, “Installing and
Removing Software” (page 51). In the package manager, the filter for YOU patches
is activated, enabling selection of updates to install. At start-up, the available security
patches and recommended patches are preselected, if the applicable software is installed
on the system. This proposal should be accepted.

After making your selection, click Accept in the package manager. All selected updates
are then downloaded from the server and installed on your machine. Depending on the
connection speed and hardware performance, this may take some time. Any errors are
displayed in a window. If necessary, skip a problematic package. Prior to the installation,
some patches open a window displaying details.

While the updates are downloaded and installed, you can track all actions in the log
window. Following the successful installation of all patches, exit YOU with Close. If
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you do not need the update files after the installation, select Remove Source Packages
after Update for them to be deleted after the update. Finally, SuSEconfig is executed
to adjust the system configuration as needed.

3.2.4 Updating from a Patch CD
Patch CD Update installs patches from CD, not from an FTP server. The advantage
lies in a much faster update with CD. After the patch CD is inserted, all patches on the
CD are displayed in the dialog. Select the desired packages for installation from the list
of patches. The module issues an error message if no patch CD is present. Insert the
patch CD then restart the module.

3.2.5 Updating the System
Update the version of SUSE Linux installed on your system with SystemUpdate. During
operation, you can only update application software, not the base system. To update
the base system, boot the computer from an installation medium, such as CD. When
selecting the installation mode in YaST, select Update an Existing System.

The procedure for updating the system is similar to a new installation. Initially, YaST
examines the system, determines a suitable update strategy, and presents the results in
a suggestion dialog. Click Change or the individual items to change any details.

Update Options
Set the update method for your system. Two options are available.

Update with Installation of New Software
To update the entire system to the latest versions of software, select one of the pre-
defined selections. These selections are the same as those offered during the instal-
lation. They ensure that packages that did not exist previously are also installed.

Only Update Installed Packages
This option merely updates packages that already exist on the system. No new fea-
tures are installed.
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Additionally, you can use Delete Outdated Packages to remove packages that do not
exist in the new version. By default, this option is preselected to prevent outdated
packages from unnecessarily occupying hard disk space.

Packages
Click Packages to start the package manager and select or deselect individual packages
for update. Any package conflicts should be resolved with the consistency check. The
use of the package manager is covered in detail in Section 3.2.1, “Installing and Remov-
ing Software” (page 51).

Backup
During the update, the configuration files of some packages may be replaced by those
of the new version. Because you may have modified some of the files in your current
system, the package manager normally makes backup copies of the replaced files. With
this dialog, determine the scope of these backups.

IMPORTANT: Scope of the Backup

This backup does not include the software. It only contains configuration files.

Language
Primary and other languages currently installed on the system are listed here. Change
them by clicking Language in the displayed configuration or withChange→ Language.
You can choose to adapt the keyboard layout and time zone to the region where the
primary language is spoken. More about language selection can be found in Sec-
tion 3.7.11, “Language” (page 92).

Important Information about Updates
The system update is a very complex procedure. For each program package, YaST must
first check which version is installed on the computer then determine what needs to be
done to replace the old version with the new version correctly. YaST also tries to adopt
any personal settings of the installed packages. Some configurations may cause problems
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because the old configuration cannot handle the new program version as expected or
because unexpected inconsistencies arise between various configurations.

The older the existing version is and the more the configuration of the packages to update
differs from the standard, the more problematic an update is. Sometimes, the old confi-
guration cannot be adopted correctly. In this case, reconfigure. Before starting the update,
save the existing configuration.

3.2.6 Installing into a Directory for Xen
Install packages into a directory for Xen with Installation into a Directory for Xen. Xen
is a virtual machine monitor (VMM) for x86-compatible computers that enables you
to run more than one virtual machine, each with its own OS, on a single physical system
and with excellent performance. After selecting this module, YaST determines the
system settings and lists the default directory, installation instructions, and software to
install. Edit the defaults by clicking Change. Confirm all changes by clicking Accept.
After all changes have been made, clickNext until you are informed that the installation
is complete. Click Finish to exit the dialog. Find detailed information about Xen in
Chapter Virtualization with Xen (↑Reference).

3.2.7 Checking Media
If you encounter any problems using the SUSE Linux installation media, you can check
the CDs or DVDs with Media Check. Media problems are more likely to occur with
media you burn yourself. To check that a SUSE Linux CD or DVD is error-free, insert
the medium into the drive and run this module. Click Start for YaST to check the MD5
checksum of the medium. This may take several minutes. If any errors are detected,
you should not use this medium for installation.
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Figure 3.4 Checking Media

3.3 Hardware
New hardware must first be installed or connected as directed by the vendor. Turn on
external devices, such as the printer or the modem, and start the appropriate YaST
module. Most devices are automatically detected by YaST and the technical data is
displayed. If the automatic detection fails, YaST offers a list of devices (model, vendor,
etc.) from which to select the suitable device. Consult the documentation enclosed with
your hardware for more information.

IMPORTANT: Model Designations

If your model is not included in the device list, try a model with a similar des-
ignation. However, in some cases the model must match exactly, because sim-
ilar designations do not always indicate compatibility.
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3.3.1 Bluetooth
Configure Bluetooth devices with Bluetooth. Click Enable Bluetooth Services to begin
configuration. Bluetooth configuration is covered in detail in Section “Configuring
Bluetooth with YaST” (Chapter 22, Wireless Communication, ↑Reference).

3.3.2 Infrared Device
Configure an infrared device with Infrared Device. Click Start IrDa to begin configu-
ration. Find information about infrared devices in Section “Infrared Data Transmission”
(Chapter 22, Wireless Communication, ↑Reference).

3.3.3 CD-ROM and DVD Drives
During installation, all detected CD-ROM drives are integrated in the installed system
with entries in /etc/fstab. Subdirectories for each device are created in /media.
Use CD-ROM Drives to integrate additional drives in the system.

When the module is started, a list of all detected drives is displayed. Select the device
to integrate then click Add. Delete a device with Remove.

3.3.4 Graphics Card and Monitor
Configure graphics cards and monitors with Graphics Card and Monitor. It uses the
the SaX2 interface, described in Section 3.11, “SaX2” (page 101).

3.3.5 Printer
Configure a printer with Printer. If a printer is properly connected to the system, it
should be detected automatically. Find detailed instructions for configuring printers
with YaST in Section “Configuring the Printer” (Chapter 31, Printer Operation, ↑Ref-
erence).
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3.3.6 Hard Disk Controller
Normally, the hard disk controller of your system is configured during the installation.
If you add controllers, integrate these into the system with Disk Controller. You can
also modify the existing configuration, but this is generally not necessary.

The dialog presents a list of detected hard disk controllers and enables assignment of
the suitable kernel module with specific parameters. Use Test Loading of Module to
check if the current settings work before they are saved permanently in the system.

WARNING: Configuration of the Hard Disk Controller

This is an expert tool. Your system may no longer boot if you make incorrect
settings. If you make changes, use the test option.

3.3.7 Hardware Information
Display detected hardware and technical data using Hardware Information. Click any
node of the tree for more information about a device. This module is especially useful,
for example, when submitting a support request for which you need information about
your hardware.

Save the hardware information displayed to file by clicking Save to File. Select the
desired directory and filename then click Save to create the file.
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Figure 3.5 Displaying Hardware Information

3.3.8 IDE DMA Mode
Activate and deactivate the DMA mode for your IDE hard disks and your IDE CD and
DVD drives in the installed system with IDE DMA Mode. This module does not have
any effect on SCSI devices. DMA modes can substantially increase the performance
and data transfer speed in your system.

During installation, the current SUSE Linux kernel automatically activates DMA for
hard disks but not for CD drives, because default DMA activation for all drives often
causes problems with CD drives. Use the DMA module to activate DMA for your
drives. If the drive supports the DMA mode without any problems, the data transfer
rate of your drive can be increased by activating DMA.

NOTE

DMA (direct memory access) means that your data can be transferred directly
to the RAM, bypassing the processor control.
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3.3.9 Joystick
Configure a joystick connected to the sound card with Joystick. Select your joystick
type in the list provided. If your joystick is not listed, select Generic Analog Joystick.
After selecting your joystick, make sure that it is connected then click Test to test the
functionality. Click Continue and YaST installs the required files. After the Joystick
Test window appears, test the joystick by moving it in all directions and pressing all
buttons. Each movement should be displayed in the window. If you are satisfied with
the settings, click OK to return to the module and Finish to complete configuration.

If you have a USB device, this configuration is not necessary. Plug in the joystick and
start using it.

3.3.10 Keyboard Layout
To configure the keyboard for the console, run YaST in text mode then use Keyboard
Layout. After clicking the module, the current layout is displayed. To choose another
keyboard layout, select the desired layout from the list provided. Test the layout in Test
by pressing keys on the keyboard.

You can fine-tune the settings by clickingExpert Settings. You can adjust the key repeat
rate and delay and configure the start-up state by choosing the desired settings in Start-
Up States. ForDevices to Lock, enter a space-separated list of devices to which to apply
the Scroll Lock , Num Lock , and Caps Lock settings. Click OK to complete the fine-tuning.
Finally, after all selections have been made, click Accept for your changes to take effect.

To set up the keyboard for the graphical environment, run the graphical YaST then select
Keyboard Layout. Find information about the graphical configuration in Section 3.11.3,
“Keyboard Properties” (page 106).

3.3.11 Mouse Model
When configuring the mouse in the graphical environment, clickMouseModel to access
the SaX2 mouse configuration. Refer to Section 3.11.2, “Mouse Properties” (page 105)
for details.

To configure your mouse for the text environment, use YaST in text mode. After entering
text mode and selecting Hardware → Mouse Model, use the keyboard arrow keys to
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choose your mouse from the provided list. Then click Accept to save the settings and
exit the module.

3.3.12 Scanner
Connect and turn on your scanner then select Scanner to configure it. Most supported
scanners are detected automatically. Select the scanner to configure and click Edit. If
your scanner is not listed, click Add to open the manual configuration dialog. Select
the appropriate vendor and model from the list and clickNext to proceed with the instal-
lation. To modify a configured scanner, select it then click Edit.

After the scanner has been determined by either automatic detection or user selection,
installation is carried out. Click Finish to complete the installation. If the installation
is successful, a corresponding message appears. To test your scanner after installation,
insert a document into your scanner and click Other → Test.

Scanner Not Detected
Only supported scanners can be automatically detected. Scanners connected to another
network host cannot be detected. The manual configuration distinguishes three types
of scanners: USB scanners, SCSI scanners, and network scanners.

USB Scanner
After the scanner is selected, YaST attempts to load the USB modules. If your
scanner is very new, the modules may not be loaded automatically. In this case,
continue automatically to a dialog in which to load the USB module manually. Refer
to the YaST help text for more information.

SCSI Scanner
SCSI devices are normally detected. Specify the device, such as /dev/sg0. If
problems arise, refer to the YaST help text. Remember always to shut down the
system before connecting or disconnecting a SCSI scanner.

Network Scanner
Enter the IP address or the hostname. To configure a network scanner, refer to the
Support Database article Scanning in Linux (http://portal.suse.com/
sdb/en/index.html, keyword scanner).
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If your scanner is not detected, the device is probably not supported. However, some-
times even supported scanners are not detected. If this is the case, proceed with the
manual scanner selection. If you can identify your scanner in the list of vendors and
models, select it. If not, selectCancel. Information about scanners that work with Linux
is provided at http://cdb.suse.de/ and http://www.sane-project
.org/.

WARNING: Assigning a Scanner Manually

Assign the scanner manually only if you are absolutely sure. An incorrect selec-
tion could damage your hardware.

Troubleshooting
Your scanner may not have been detected for one of the following reasons:

• The scanner is not supported. Checkhttp://cdb.suse.de/ for a list of Linux-
compatible devices.

• The SCSI controller was not installed correctly.

• There were termination problems with your SCSI port.

• The SCSI cable is too long.

• The scanner has a SCSI light controller that is not supported by Linux.

• The scanner is defective.

WARNING

SCSI scanners should not be connected or disconnected while the system is
running. Shut the system down first.

For more information about scanning, see Chapter Kooka—A Scanning Application
(↑Reference).
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3.3.13 Sound
Use Sound to configure a sound card. Most sound cards are detected automatically and
listed. Select the one to configure or modify then click Edit.

If YaST is unable to detect your sound card automatically, click Add to open a dialog
in which to select a sound card vendor and model. Refer to your sound card documen-
tation for the information required. Find a reference list of sound cards supported by
ALSA with their corresponding sound modules in /usr/share/doc/packages/
alsa/cards.txt and at http://www.alsa-project.org/~goemon/.
After making your selection, click Next.

Setup Dialog
Choose the configuration level in the first setup screen. With Quick Automatic Setup,
you are not required to go through any of the further configuration steps and no sound
test is performed. The sound card is configured automatically. With Normal Setup, you
can adjust the output volume and play a test sound. Advanced setup with possibility to
change options allows you to customize the sound card options manually.

In this dialog, there is also a shortcut to joystick configuration. Click the respective box
and select the joystick type in the following dialog. Click Next to continue.

Sound Card Volume
Here, test your sound configuration and make adjustments to the volume. You should
start at about ten percent to avoid damage to your speakers or hearing. A test sound
should be audible when you click Test. If you cannot hear anything, increase the volume.
Press Continue to complete the sound configuration. The volume setting is then saved.

Sound Configuration
Use Delete to remove a sound card. This deactivates existing entries of configured
sound cards in /etc/modprobe.d/sound. Click Other to open a dialog in which
to customize the sound module options manually. Under Add, configure additional
sound cards. If YaST detects another sound card, select it then use Edit. If YaST does
not detect a sound card, you are automatically directed toManual Sound Card Selection.
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If you use aCreative Soundblaster Live orAWE sound card, copy SF2 sound
fonts to your hard disk from the original Soundblaster driver CD-ROM with Install
Sound Fonts. The sound fonts are saved in the directory /usr/share/sfbank/
creative/.

For playback of MIDI files, check Start Sequencer. This way, the modules for sequencer
support are loaded along with the sound modules.

The volume and configuration of all sound cards installed are saved when you click
Finish. The mixer settings are saved to the file /etc/asound.conf and the ALSA
configuration data is appended at the end of the files /etc/modprobe.d/sound
and /etc/sysconfig/hardware.

3.3.14 TV and Radio Cards
Configure TV and radio cards with TV Card. If your card was automatically detected,
it is displayed in the list. In this case, select the card and click Edit. If your card was
not detected, click Add. If you have already configured TV or radio cards, select a card
to modify then click Edit.

During the automatic hardware detection, YaST attempts to assign the correct tuner to
your card. If you are not sure, simply keep the setting Default (recognized) and check
whether it works. If you cannot set all channels, click Select Tuner and select the correct
tuner type from the list.

If you are familiar with the technical details, you can use the expert dialog to make
settings for a TV or radio card. Select a kernel module and its parameters in this dialog.
Also check all parameters of your TV card driver. To do this, select the respective pa-
rameters and enter the new value in the parameter line. Confirm the new values with
Apply or restore the default values with Reset.

Configure audio settings if your TV or radio card is connected to the installed sound
card. Make the connection with a cable from output of the TV or radio card to the ex-
ternal audio input of the sound card. If you have not yet configured your sound card,
select Configure Sound Card to configure it as described in Section 3.3.13, “Sound”
(page 72).
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If your TV or radio card has speaker jacks, you can also connect the speakers directly
without using the sound card. There are also TV cards without any sound function,
which do not require an audio configuration, such as those for CCD cameras.

When editing a configuration, you can also configure the TV stations by clicking TV
Channel. Set the proper TV Standard and Frequency Table for you area and click Scan
the Channels. A list of stations appears. After scanning has been completed, click OK
to return to the configuration dialog.

3.4 Network Devices
All network devices connected to the system must be initialized before they can be used
by a service. The detection and configuration of these devices is done in the module
group Network Devices.

3.4.1 DSL, ISDN, Modem, or Network Card
To configure a DSL, ISDN, or network interface or a modem, select the appropriate
module. For a device that is detected automatically, select it from the list then click
Edit. If your device has not been detected, click Add and select it manually. To edit an
existing device, select it then clickEdit. For more detailed information, see Section “Con-
figuring a Network Connection with YaST” (Chapter 38,Basic Networking, ↑Reference).
For wireless network interfaces, see Chapter Wireless Communication (↑Reference).

3.4.2 Fax
Configure a fax system with Fax. Set up the fax system for one or more users, but each
user must have a unique fax number. When adding or editing users, configure the
username, fax numbers, outgoing MSN, station ID, headline, and desired action.

3.4.3 Phone Answering Machine
Configure your SUSE Linux system to function as a telephone answering machine with
Phone Answering Machine. You can configure it for one or more users, but each user
must have a unique telephone number. When adding or editing users, configure the
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username, telephone numbers, delay, duration, and desired action. Assign a PIN (per-
sonal identification number) to provide the user with remote access to the machine.

3.5 Network Services
This group contains tools to configure all kinds of services in the network. These include
name resolution, user authentication, and file services.

3.5.1 Mail Transfer Agent
You can configure your mail settings in Mail Transfer Agent if you send your e-mail
with sendmail, postfix, or the SMTP server of your provider. You can fetch mail via
the fetchmail program, for which you can also enter the details of the POP3 or IMAP
server of your provider. Alternatively, use a mail program of your choice, such as KMail
or Evolution, to set your access data. In this case, you do not need this module.

To configure your mail with YaST, specify the type of your connection to the Internet
in the first dialog. Choose one of the following options:

Permanent
Select this option if you have a dedicated line to the Internet. Your machine is online
permanently, so no dial-up is required. If your system is part of a local network with
a central e-mail server, select this option to ensure permanent access to your e-mail
messages.

Dial-Up
This item is relevant for users who have a computer at home, are not located in a
network, and occasionally connect to the Internet.

No Connection
If you do not have access to the Internet and are not located in a network, you cannot
send or receive e-mail.

Activate virus scanning for your incoming and outgoing e-mail with AMaViS by select-
ing that option. The package is installed automatically as soon as you activate the mail
filtering feature. In the following dialogs, specify the outgoing mail server (usually the
SMTP server of your provider) and the parameters for incoming mail. Set the diverse
POP or IMAP servers for mail reception by various users. Using this dialog, you can

System Configuration with YaST 75



also assign aliases, use masquerading, or set up virtual domains. Click Finish to exit
the mail configuration.

3.5.2 Other Available Services
Many other network modules are available in YaST.

DHCP Server

Use this to set up a custom DHCP server in only a few steps. Chapter DHCP
(↑Reference) provides basic knowledge about the subject and a step-by-step descrip-
tion of the configuration process.

DNS Server

Configuring a DNS server that is responsible for name resolution is recommended
for larger networks. You can use DNS Server for this as described in Section “Con-
figuration with YaST” (Chapter 40, The Domain Name System, ↑Reference).
Chapter The Domain Name System (↑Reference) provides background information
about DNS.

DNS and Hostname

Use this module to configure the hostname and DNS, if these settings were not al-
ready made while configuring the network devices. Also use it to change the host-
name and domain name. If the provider has been configured correctly for DSL,
modem, or ISDN access, the list of name servers contains the entries that were ex-
tracted automatically from the provider data. If you are located in a local network,
you might receive your hostname via DHCP, in which case you should not modify
the name.

HTTP Server

To run your own Web server, configure Apache in HTTP Server. Find more infor-
mation in Chapter The Apache Web Server (↑Reference).

Hostnames

When booting and in small networks, you can useHostnames for hostname resolution
instead of DNS. The entries in this module reflect the data of the file /etc/hosts.
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For more information, read Section “ /etc/hosts ” (Chapter 38, Basic Network-
ing, ↑Reference).

LDAP Client

If using LDAP for user authentication in the network, configure the client in LDAP
Client. Information about LDAP and a detailed description of the client configuration
with YaST are available in Chapter LDAP—A Directory Service (↑Reference).

NFS Client and NFS Server

With NFS, run a file server that all members of your network can access. This file
server can be used to make certain applications, files, and storage space available
to users. InNFS Server, you can configure your host as an NFS server and determine
the directories to export for general use by the network users. All users with the
appropriate permissions can mount these directories in their own file trees. UseNFS
Client to configure your system to access an NFS server in the network. A description
of the YaST modules and background information about NFS are provided in
Chapter Sharing File Systems with NFS (↑Reference).

NIS Client and NIS Server

If you run more than one system, local user administration (using the files /etc/
passwd and /etc/shadow) is impractical and requires a lot of maintenance. In
this case, administer user data on a central server and distribute it to the clients from
there. NIS is one option for this. Detailed information about NIS and the configura-
tion with YaST is available in Chapter Using NIS (↑Reference).

NTP Client

NTP (network time protocol) is a protocol for synchronizing hardware clocks over
a network. Information about NTP and instructions for configuring it with YaST
are available in Chapter Time Synchronization with xntp (↑Reference).

Network Services (xinetd)

Configure the network services (such as finger, talk, and ftp) to start when SUSE
Linux boots usingNetwork Services. These services enable external hosts to connect
to your computer. Various parameters can be configured for every service. By default,
the master service that manages the individual services (inetd or xinetd) is not
started.
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When this module starts, choose whether to start inetd or xinetd. The selected daemon
can be started with a standard selection of services. Alternatively, compose your
own selection of services with Add, Delete, and Edit.

WARNING: Configuring Network Services (xinetd)

The composition and adjustment of network services on a system is a
complex procedure that requires a comprehensive understanding of the
concept of Linux services. The default settings are usually sufficient.

Proxy

Configure Internet proxy client settings in Proxy. Click Enable Proxy then enter
the desired proxy settings. You can test these settings by clicking Test Proxy Settings.
A small window informs you whether your proxy settings work correctly. After
your settings have been entered and tested, save them by clicking Accept.

Remote Administration

To administer your machine remotely from another machine, use Remote Adminis-
tration. To maintain your system remotely, use a VNC client, such as krdc, or a
Java-enabled browser. Although remote administration using VNC is simple and
fast, it is less secure than using SSH, so you should always keep this in mind when
using a VNC server. Find detailed information about installing with a VNC client
in Section “Simple Remote Installation via VNC—Static Network Configuration”
(Chapter 1, Remote Installation, ↑Reference).

Allow remote administration by selecting Allow Remote Administration in Remote
Administration Settings. Selecting Do Not Allow Remote Administration disables
this function. Click Open Port in Firewall to allow access to your computer.
ClickingFirewall Details displays network interfaces with open ports in the firewall.
Select the desired interface and click OK to return to the main dialog. Click Accept
to complete the configuration.

The YaST Remote Administration module is highly recommended for configuring
VNC on your machine. Although the SaX2 interface also allows you to set remote
access properties, it is not a substitute for YaST. It only enables you to configure
your X server as a host for VNC sessions. For more information, refer to Sec-
tion 3.11.6, “Remote Access Properties” (page 107).
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Routing

Use Routing to configure the paths data takes over the network. In most cases, only
enter the IP address of the system through which to send all data inDefault Gateway.
To create more complicated configurations, use Expert Configuration.

Samba Server and Client

In a heterogeneous network consisting of Linux and Windows hosts, Samba controls
the communication between the two worlds. Information about Samba and the
configuration of clients and servers is provided in Chapter Samba (↑Reference).

TFTP Server

TFTP (Trivial File Transfer Protocol) is a simple form of the file transfer protocol
(FTP). It is often used by servers to boot diskless workstations, X terminals, and
routers. Set up a TFTP server with TFTP Server. Click Enable to start the process.
Open a port in the firewall to allow remote access to the server then specify the di-
rectory where served files are located. Click Accept to complete setup. You are then
asked if the directory specified should be created.

3.6 Security and Users
A basic aspect of Linux is its multiuser capability. Consequently, several users can
work independently on the same Linux system. Each user has a user account identified
by a login name and a personal password for logging in to the system. All users have
their own home directories where personal files and configurations are stored.

3.6.1 User Management
Create and edit users with User Management. It provides an overview of users in the
system, including NIS and LDAP users if requested. If you are part of an extensive
network, click Set Filter to list all users categorically (for example, root or NIS users).
You can also customize filter settings by clicking Customize Filter.

To add new users, click Add and enter the appropriate data. Complete the addition by
clicking Accept. The new user can immediately log in using the newly created login
name and password.
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Disable user login with the corresponding option. Fine-tune user profiles in Details.
Here, manually set the user ID, home directory, default login shell, and assign the new
user to specific groups. Configure the validity of the password in Password Settings.
Click Accept to save all changes.

To delete a user, select the user from the list and click Delete. Then mark whether to
delete the home directory and click Yes to confirm.

For advanced user administration, use Expert Options to define the default settings for
the creation of new users. Select the user authentication method (such as NIS, LDAP,
Kerberos, or Samba), login settings (only with KDM or GDM), and the algorithm for
password encryption. Default for New Users and Password Encryption apply only to
local users. Authentication and User Sources provides a configuration overview and
the option to configure the client. Advanced client configuration is also possible using
this module. After accepting the configuration, return to the initial configuration
overview. Click Write Changes Now if you want to save all changes without exiting
the configuration module.

Figure 3.6 User Management
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3.6.2 Group Management
To create and edit groups, selectGroupManagement or clickGroups in the user admin-
istration module. Both dialogs have the same functionality, allowing you to create, edit,
or delete groups.

The module gives an overview of all groups. As in the user management dialog, change
filter settings by clicking Set Filter.

To add a group, click Add and fill in the appropriate data. Select group members from
the list by checking the corresponding box. Clicking Accept to create the group. To
edit a group, select the group to edit from the list and click Edit. Make all necessary
changes then save them with Accept. To delete a group, simply select it from the list
and click Delete.

Click Expert Options for advanced group management. Find more about these options
in Section 3.6.1, “User Management” (page 79).

3.6.3 Local Security
To apply a set of security settings to your entire system, use Local Security. These set-
tings include security for booting, login, passwords, user creating, and file permissions.
SUSE Linux offers three preconfigured security sets: Home Workstation, Networked
Workstation, and Networked Server. Modify the defaults with Details. To create your
own scheme, use Custom Settings.

The detailed or custom settings include:

Password Settings
To have new passwords checked by the system for security before they are accepted,
clickCheck New Passwords and Test for Complicated Passwords. Set the minimum
password length for newly created users. Define the period for which the password
should be valid and how many days in advance an expiration alert should be issued
when the user logs in to the text console.

Boot Settings
Set how the key combination Ctrl + Alt + Del should be interpreted by selecting
the desired action. Normally, this combination, when entered in the text console,
causes the system to reboot. Do not modify this setting unless your machine or
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server is publicly accessible and you are afraid someone could carry out this action
without authorization. If you select Stop, this key combination causes the system
to shut down. With Ignore, this key combination is ignored.

If you use the KDE login manager (KDM), set permissions for shutting down the
system in Shutdown Behavior of KDM. Give permission to Only root (the system
administrator),All Users,Nobody, or Local Users. IfNobody is selected, the system
can only be shut down from the text console.

Login Settings
Typically, following a failed login attempt, there is a waiting period lasting a few
seconds before another login is possible. This makes it more difficult for password
sniffers to log in. Optionally activate Record Successful Login Attempts and Allow
Remote Graphical Login. If you suspect someone is trying to discover your password,
check the entries in the system log files in /var/log. To grant other users access
to your graphical login screen over the network, enable Allow Remote Graphical
Login. Because this access possibility represents a potential security risk, it is inactive
by default.

User Addition
Every user has a numerical and an alphabetical user ID. The correlation between
these is established using the file /etc/passwd and should be as unique as pos-
sible. Using the data in this screen, define the range of numbers assigned to the nu-
merical part of the user ID when a new user is added. A minimum of 500 is suitable
for users. Automatically generated system users start with 1000. Proceed in the
same way with the group ID settings.

Miscellaneous Settings
To use predefined file permission settings, select Easy, Secure, or Paranoid. Easy
should be sufficient for most users. The setting Paranoid is extremely restrictive
and can serve as the basic level of operation for custom settings. If you select
Paranoid, remember that some programs might not work correctly or even at all,
because users no longer have permission to access certain files.

Also set which user should launch the updatedb program, if installed. This pro-
gram, which automatically runs on a daily basis or after booting, generates a database
(locatedb) in which the location of each file on your computer is stored. If you select
Nobody, any user can find only the paths in the database that can be seen by any
other (unprivileged) user. If root is selected, all local files are indexed, because
the user root, as superuser, may access all directories. Make sure that the options
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Current Directory in root's Path and Current Directory in Path of Regular Users
are deactivated. Only advanced users should consider using these options because
these settings may pose a significant security risk if used incorrectly. To have some
control over the system even if it crashes, click Enable Magic SysRq Keys.

Click Finish to complete your security configuration.

3.6.4 Firewall
SuSEfirewall2 can protect your machine against attacks from the Internet. Configure
it with Firewall. Find detailed information about SuSEfirewall2 in Section “Masquerad-
ing and Firewalls” (Chapter 23, Security in Linux, ↑Reference).

TIP: Automatic Activation of the Firewall

YaST automatically starts a firewall with suitable settings on every configured
network interface. Start this module only if you want to reconfigure the firewall
with custom settings or deactivate it.

3.7 System
This group of modules is designed to help you manage your system. All modules in
this group are system-related and serve as valuable tools for ensuring that your system
runs properly and your data is managed efficiently.

3.7.1 Backup
Create a backup of both your system and data using System Backup. However, the
backup created by the module does not include the entire system. The system is backed
up by saving important storage areas on your hard disk that may be crucial when trying
to restore a system, such as the partition table or master boot record (MBR). It can also
include the XML configuration acquired from the installation of the system, which is
used for AutoYaST. Data is backed up by saving changed files of packages accessible
on installation media, entire packages that are unaccessible (such as online updates),
and files not belonging to packages, such as many of the configuration files in /etc
or the directories under /home.
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3.7.2 Restoration
With System Restoration, shown in Figure 3.7, “Start Window of the Restore Module”
(page 84), restore your system from a backup archive created with System Backup.
First, specify where the archives are located (removable media, local hard disks, or
network file systems). Click Next to view the description and contents of the individual
archives and select what to restore from the archives.

You can also uninstall packages that were added since the last backup and reinstall
packages that were deleted since the last backup. These two steps enable you to restore
the exact system state at the time of the last backup.

WARNING: System Restoration

Because this module normally installs, replaces, or uninstalls many packages
and files, use it only if you have experience with backups. Otherwise you may
lose data.

Figure 3.7 Start Window of the Restore Module
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3.7.3 Boot and Rescue Disks
Create boot and rescue disks with Boot or Rescue Floppy. These floppy disks are
helpful if the boot configuration of your system is damaged. The rescue disk is especially
necessary if the file system of the root partition is damaged.

The following options are available:

Standard Boot Floppy
Use this option to create the standard boot floppies with which to boot an installed
system. Depending on the architecture, the actual number of boot disks may vary,
but you should create all the boot disks presented in the dialog because all these
disks are necessary for booting. They are also needed for starting the rescue system.

Rescue Floppy
This disk contains a special environment that allows you to perform maintenance
tasks in your installed system, such as checking and repairing the file system and
updating the boot loader. To start the rescue system, boot with the standard boot
disks then select Manual Installation → Start Installation or System → Rescue
System. Insert the rescue disk when prompted.

Custom Floppy
Use this to write any existing floppy disk image from the hard disk to a floppy disk.

Download Floppy Image
With this, enter a URL and authentication data to download a floppy disk image
from the Internet.

To create one of these floppy disks, select the corresponding option and click Next.
Insert a floppy disk when prompted. Click Next again to create the floppy disk.

3.7.4 LVM
The logical volume manager (LVM) is a tool for custom partitioning of hard disks with
logical drives. Find information about LVM in Section “LVM Configuration” (Chapter 2,
Advanced Disk Setup, ↑Reference).
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3.7.5 Partitioner
With the expert dialog, shown in Figure 3.8, “The YaST Partitioner” (page 86), manu-
ally modify the partitioning of one or several hard disks. Partitions can be added,
deleted, resized, and edited. Also access the soft RAID and LVM configuration from
this YaST module.

WARNING

Although it is possible to modify the partitions in the installed system, this
should be handled only by experts. Otherwise the risk of making a mistake that
causes data loss is very high. If you repartition a hard disk in use, reboot the
system right afterwards. It is safer to use the rescue system than repartition
the system while running.

Figure 3.8 The YaST Partitioner

All existing or suggested partitions on all connected hard disks are displayed in the list
of the YaST Expert Partitioner dialog. Entire hard disks are listed as devices without
numbers, such as /dev/hda or /dev/sda. Partitions are listed as parts of these de-
vices, such as /dev/hda1 or /dev/sda1. The size, type, file system, and mount
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point of the hard disks and their partitions are also displayed. The mount point describes
where the partition appears in the Linux file system tree.

If you run the expert dialog during installation, any free hard disk space is also listed
and automatically selected. To provide more disk space to SUSE Linux, free the needed
space starting from the bottom toward the top of the list (starting from the last partition
of a hard disk toward the first). For example, if you have three partitions, you cannot
use the second exclusively for SUSE Linux and retain the third and first for other oper-
ating systems.

Creating a Partition
Select Create. If several hard disks are connected, a selection dialog appears in which
to select a hard disk for the new partition. Then, specify the partition type (primary or
extended). Create up to four primary partitions or up to three primary partitions and
one extended partition. Within the extended partition, create several logical partitions
(see Section “Partition Types” (page 8)).

Select the file system to use and a mount point, if necessary. YaST suggests a mount
point for each partition created. Details of the parameters are provided in the next section.
Select OK to apply your changes. The new partition is then listed in the partition table.
If you clickNext, the current values are adopted. During installation you are then returned
to the suggestion screen.

Partitioning Parameters
When you create a new partition or modify an existing partition, set various parameters.
For new partitions, suitable parameters are set by YaST and usually do not require any
modification. To perform manual settings, proceed as follows:

1. Select the partition.

2. Click Edit to edit the partition and set the parameters:

File System ID
Even if you do not want to format the partition at this stage, assign it a file
system ID to ensure that the partition is registered correctly. Possible values
include Linux, Linux swap, Linux LVM, and Linux RAID. For LVM and RAID
details, refer to Section “LVM Configuration” (Chapter 2, Advanced Disk
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Setup, ↑Reference) and Section “Soft RAID Configuration” (Chapter 2, Ad-
vanced Disk Setup, ↑Reference).

File System
To format the partition immediately within the scope of the installation,
specify one of the following file systems for the partition: Swap, Ext2, Ext3,
ReiserFS, or JFS. Refer to Chapter File Systems in Linux (↑Reference) for
details on the various file systems.

Swap is a special format that allows the partition to be used as virtual mem-
ory. ReiserFS is the default file system for the Linux partitions. ReiserFS,
JFS, and Ext3 are journaling file systems. These file systems are able to re-
store the system very quickly after a system crash, because write processes
are logged during the operation. Furthermore, ReiserFS is very fast in handling
lots of small files. Ext2 is not a journaling file system. However, it is rock
solid and good for smaller partitions, because it does not require much disk
space for management.

File System Options
Set various parameters for the selected file system here. Depending on the
file system used, various options are offered for experts.

Encrypt File System
If you activate the encryption, all data is written to the hard disk in encrypted
form. This increases the security of sensitive data, but slightly reduces the
system speed, because the encryption takes some time. More information
about the encryption of file systems is provided in Section “Encrypting Par-
titions and Files” (Chapter 23, Security in Linux, ↑Reference).

Fstab Options
Here, specify various parameters for the administration file of the file systems
(/etc/fstab).

Mount Point
Specifies the directory at which the partition should be mounted in the file
system tree. Select from various YaST proposals or enter any other name.

3. Select Next to activate the partition.
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If you partition manually, create a swap partition of at least 256 MB. The swap partition
is used to free the main memory of data that is not used at the present moment. This
keeps the main memory free for the most frequently-used important data.

Expert Options
Expert opens a menu containing the following commands:

Reread Partition Table
Rereads the partitioning from disk. For example, you need this after manual parti-
tioning in the text console.

Delete Partition Table and Disk Label
This completely overwrites the old partition table. For example, this can be helpful
if you have problems with unconventional disk labels. Using this method, all data
on the hard disk is lost.

More Partitioning Tips
If the partitioning is performed by YaST and other partitions are detected in the system,
these partitions are also entered in the file /etc/fstab to enable easy access to this
data. This file contains all partitions in the system with their properties, such as the file
system, mount point, and user permissions.

Example 3.1 /etc/fstab: Partition Data
/dev/sda1    /data1    auto      noauto,user 0 0
/dev/sda5    /data2    auto      noauto,user 0 0 
/dev/sda6    /data3    auto      noauto,user 0 0

The partitions, regardless of whether they are Linux or FAT partitions, are specified
with the options noauto and user. This allows any user to mount or unmount these
partitions as needed. For security reasons, YaST does not automatically enter the exec
option here, which is needed for executing programs from the location. However, to
run programs from there, you can enter this option manually. This measure is necessary
if you encounter system messages such as bad interpreter or Permission denied.
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Partitioning and LVM
From the expert partitioner, access the LVM configuration with LVM (see Section “LVM
Configuration” (Chapter 2, Advanced Disk Setup, ↑Reference)). However, if a working
LVM configuration already exists on your system, it is automatically activated as soon
as you enter the LVM configuration for the first time in a session. In this case, any disks
containing a partition belonging to an activated volume group cannot be repartitioned
because the Linux kernel cannot reread the modified partition table of a hard disk when
any partition on this disk is in use. However, if you already have a functioning LVM
configuration on your system, physical repartitioning should not be necessary. Instead,
change the configuration of the logical volumes.

At the beginning of the physical volumes (PVs), information about the volume is written
to the partition. To reuse such a partition for other non-LVM purposes, it is advisable
to delete the beginning of this volume. For example, in the VG system and PV /dev/
sda2, do this with the command dd if=/dev/zero of=/dev/sda2 bs=512
count=1.

WARNING: File System for Booting

The file system used for booting (the root file system or /boot) must not be
stored on an LVM logical volume. Instead, store it on a normal physical partition.

3.7.6 Powertweak Configuration
Powertweak is a SUSE Linux utility for tweaking your system to peak performance by
tuning some kernel and hardware configurations. It should be used only by advanced
users. After starting it with Powertweak, it detects your system settings and lists them
in tree form in the left frame of the module. You can also use Search to find a configu-
ration variable. Select the option to tweak to display it on the screen along with its di-
rectory and settings. To save the settings, click Finish then confirm it by clicking OK.

3.7.7 Profile Manager
Create, manage, and switch among system configurations with Profile Management,
the YaST system configuration profile management (SCPM) module. This is especially
useful for mobile computers that are used in different locations (in different networks)
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and by different users. Nevertheless, this feature is useful even for stationary machines,
because it enables the use of various hardware components or test configurations. For
more information about SCPM basics and handling, refer to Chapter System Configu-
ration Profile Management (↑Reference).

3.7.8 System Services (Runlevel)
SUSE Linux can be operated in several runlevels. By default, the system boots to run-
level 5, which offers multiuser mode, network access, and the graphical user interface
(X Window System). The other runlevels offer multiuser mode with network but
without X (runlevel 3), multiuser mode without network (runlevel 2), single-user mode
(runlevel 1 and S), system halt (runlevel 0), and system reboot (runlevel 6).

The various runlevels are useful if problems are encountered in connection with a par-
ticular service (X or network) in a higher runlevel. In this case, the system can be
booted to a lower runlevel to repair the service. Many servers operate without a graph-
ical user interface and must be booted in a runlevel without X, such as runlevel 3.

Usually you only need the standard runlevel (5). However, if the graphical user interface
freezes at any time, you can restart the X Window system by switching to a text console
with Ctrl + Alt + F1 , logging in as root, and switching to runlevel 3 with the command
init 3. This shuts down your X Window System, leaving you with a text console.
To restart the graphical system, enter init 5.

Configure runlevels and the services that start in them with System Services. For more
information about the runlevels in SUSE Linux and a description of the YaST runlevel
editor, refer to Section “Configuring System Services (Runlevel) with YaST” (Chap-
ter 28, Booting and Configuring a Linux System, ↑Reference).

3.7.9 /etc/sysconfig Editor
The directory /etc/sysconfig contains the files with the most important settings
for SUSE Linux. Use /etc/sysconfig Editor to modify the values and save them to the
individual configuration files. Generally, manual editing is not necessary, because the
files are automatically adapted when a package is installed or a service is configured.
More information about /etc/sysconfig and the YaST sysconfig editor is available
in Section “Changing the System Configuration Using the YaST sysconfig Editor”
(Chapter 28, Booting and Configuring a Linux System, ↑Reference).
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3.7.10 Time Zone Selection
The time zone is initially set during installation, but you can change it with Date and
Time. Also use this to change the current system date and time.

To change the time zone, select the region in the left column and the location or time
zone in the right column. With Hardware Clock Set To, set whether the system clock
should use Local Time or UTC (Coordinated Universal Time). UTC is often used in
Linux systems, whereas machines with additional operating systems, such as Microsoft
Windows, mostly use local time.

Set the current system time and date with Change. In the dialog that opens, modify the
time and date by entering new values or adjusting them with the arrow buttons. Press
Apply to save the changes.

3.7.11 Language
The primary and secondary languages for your Linux system are set during installation.
However, they can be changed at any time using Language. The primary language set
in YaST applies to the entire system, including YaST and the desktop environment.
This is the language you expect to use most of the time. Secondary languages are lan-
guages that are sometimes needed by users for a variety of purposes, such as desktop
language or word processing.
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Figure 3.9 Setting the Language

Select the main language to use for your system in Primary Language. To adjust key-
board or time zone to this setting, enable Adapt Keyboard Layout or Adapt Time Zone.

Set how locale variables are set for the root user with Details. Also use Details to set
the primary language to a dialect not available in the main list. These settings are written
into the file /etc/sysconfig/language.

3.8 Miscellaneous
The YaST Control Center has several modules that cannot easily be classified into the
first six module groups. They can be used for things like viewing log files and installing
drivers from a vendor CD.

3.8.1 Start-Up Log and System Log
View information concerning the start-up of the computer in Start-Up Log. See messages
for the entire system in System Log. This is one of the first places you might want to
look when encountering problems with the system or when troubleshooting.
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Boot Log
View the boot log /var/log/boot.msg that contains the screen messages displayed
when the computer starts with Start-Up Log. It can help determine if the computer
started properly, and if all services and functions were started correctly.

System Log
Use System Log to view the system log that keeps track of the operations of your com-
puter in var/log/messages. Kernel messages, sorted according to date and time,
are also recorded here. View the status of certain system components using the box at
the top. The following options are possible from the system log and boot log modules:

/var/log/messages
This is the general system log file. Here, view kernel messages, users logging in as
root, and other useful information.

/proc/cpuinfo
This displays processor information, including its type, make, model, and perfor-
mance.

/proc/dma
This shows which DMA channels are currently being used.

/proc/interrupts
This shows which interrupts are in use and how many of each have been in use.

/proc/iomem
This displays the status of input/output memory.

/proc/ioports
This shows which I/O ports are in use at the moment.

/proc/meminfo
This displays memory status.

/proc/modules
This displays the individual modules.
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/proc/mounts
This displays devices currently mounted.

/proc/partitions
This shows the partitioning of all hard disks.

/proc/version
This displays the current version of Linux.

/var/log/YaST2/y2log
This displays all YaST log messages.

/var/log/boot.msg
This displays information concerning the start-up of the system.

/var/log/faillog
This displays login failures.

/var/log/warn
This displays all system warnings.

3.8.2 Vendor Driver CD
Install device drivers from a Linux driver CD that contains drivers for SUSE Linux
with Vendor Driver CD. When installing SUSE Linux from scratch, use this YaST
module to load the required drivers from the vendor CD after the installation.

3.9 YaST in Text Mode
This section is mainly intended for system administrators and experts who do not run
an X server on their systems and depend on the text-based installation tool. It provides
basic information about starting and operating YaST in text mode.

When YaST is started in text mode, the YaST Control Center appears first. See Fig-
ure 3.10, “Main Window of YaST in Text Mode” (page 96). The main window consists
of three areas. The left frame, which is surrounded by a thick white border, features the
categories to which the various modules belong. The active category is indicated by a
colored background. The right frame, which is surrounded by a thin white border, pro-
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vides an overview of the modules available in the active category. The bottom frame
contains the buttons for Help and Exit.

Figure 3.10 Main Window of YaST in Text Mode

When the YaST Control Center is started, the category Software is selected automati-
cally. Use ↓ and ↑ to change the category. To start a module from the selected category,
press → . The module selection now appears with a thick border. Use ↓ and ↑ to select
the desired module. Keep the arrow keys pressed to scroll through the list of available
modules. When a module is selected, the module title appears with a colored background
and a brief description is displayed in the bottom frame.

Press Enter to start the desired module. Various buttons or selection fields in the module
contain a letter with a different color (yellow by default). Use Alt + yellow_letter to select
a button directly instead of navigating there with Tab . Exit the YaST Control Center
by pressing the Exit button or by selecting Exit in the category overview and pressing
Enter .

3.9.1 Navigation in Modules
The following description of the control elements in the YaST modules assumes that
all function keys and Alt key combinations work and are not assigned different global
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functions. Read Section 3.9.2, “Restriction of Key Combinations” (page 98) for infor-
mation about possible exceptions.

Navigation among Buttons and Selection Lists
Use Tab and Alt + Tab or Shift + Tab to navigate among the buttons and the frames
containing selection lists.

Navigation in Selection Lists
Use the arrow keys ( ↑ and ↓ ) to navigate among the individual elements in an active
frame containing a selection list. If individual entries within a frame exceed its
width, use Shift + → or Shift + ← to scroll horizontally to the right and left. Alter-
natively, use Ctrl + E or Ctrl + A . This combination can also be used if using →
or ← would result in changing the active frame or the current selection list, as in
the Control Center.

Buttons, Radio Buttons, and Check Boxes
To select buttons with empty square brackets (check boxes) or empty parentheses
(radio buttons), press Space or Enter . Alternatively, radio buttons and check boxes
can be selected directly with Alt + yellow_letter . In this case, you do not need to
confirm with Enter . If you navigate to an item with Tab , press Enter to execute the
selected action or activate the respective menu item.

Function Keys
The F keys ( F1 to F12 ) enable quick access to the various buttons. Which function
keys are actually mapped to which buttons depends on the active YaST module,
because the different modules offer different buttons (Details, Info, Add, Delete,
etc.). Use F10 for OK, Next, and Finish. Press F1 to access the YaST help, which
shows the functions mapped to the individual F keys.
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Figure 3.11 The Software Installation Module

3.9.2 Restriction of Key Combinations
If your window manager uses global Alt combinations, the Alt combinations in YaST
might not work. Keys like Alt or Shift can also be occupied by the settings of the termi-
nal.

Replacing Alt with Esc
Alt shortcuts can be executed with Esc instead of Alt . For example, Esc + H replaces
Alt + H .

Backward and Forward Navigation with Ctrl + F and Ctrl + B
If the Alt and Shift combinations are occupied by the window manager or the termi-
nal, use the combinations Ctrl + F (forward) and Ctrl + B (backward) instead.

Restriction of Function Keys
The F keys are also used for functions. Certain function keys might be occupied by
the terminal and may not be available for YaST. However, the Alt key combinations
and function keys should always be fully available on a pure text console.
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3.9.3 Starting the Individual Modules
To save time, the individual YaST modules can be started directly. To start a module,
enter:
yast <module_name>

View a list of all module names available on your system with yast -l or yast
--list. Start the network module, for example, with yast lan.

3.10 Online Update from the
Command Line

The behavior of the YaST Online Update can be controlled with command-line param-
eters. The syntax is online_update  [command-line parameter]. The
possible parameters and their functions are as follows:

-u URL
Base URL of the directory tree from which the patches should be downloaded.

-g
Only download patches. Do not install.

-i
Install downloaded patches. Do not download.

-k
Check if new patches are available.

-c
Show the current configuration. Do not perform any action.

-p product
Product for which patches should be downloaded.

-v version
Product version for which patches should be downloaded.
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-a architecture
Base architecture of the product for which patches should be downloaded.

-d
Dry run. Download patches and simulate installation (system remains unchanged;
for test purposes only).

-n
No signature check of the downloaded files.

-s
Display a list of available patches.

-V
Verbose mode.

-D
Debug mode for experts and for troubleshooting.

-h
Displays the help file.

Using the command-line tool online_update, the system can be updated automat-
ically, for example, with scripts. For instance, you may want your system to search a
specific server for updates and download the patches and patch information at a specified
time in regular intervals. However, you may not want the patches to be installed auto-
matically. Instead, you may want to review the patches and select the patches for instal-
lation at a later time.

To use the tool, first configure a cron job that executes the following command:
online_update -u <URL> -g <type_specification>

-u introduces the base URL of the directory tree from which the patches should be
downloaded. The supported protocols are http, ftp, smb, nfs, cd, dvd, and dir.
-g downloads the patches to a local directory without installing them. Optionally, filter
the patches by specifying the type: security, recommended, or optional. If
no filter is specified, online_update downloads all newsecurity andrecommended
patches.
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The downloaded packages can be installed immediately without reviewing the individ-
ual patches. online_update saves the patches in the directory /var/lib/YaST2/
you/mnt. To install the patches, execute the following command:
online_update -u /var/lib/YaST2/you/mnt/ -i

The parameter -u specifies the local URL of the patches to install. -i starts the instal-
lation procedure.

To review the downloaded patches prior to the installation, start the YOU dialog:
yast online_update .url /var/lib/YaST2/you/mnt/

YOU starts and uses the local directory containing the downloaded patches instead of
a remote directory on the Internet. Select the patches to install in the same way as
packages for installation in the package manager.

For more information about online_update, enter online_update -h.

3.11 SaX2
Configure the graphical environment of your system withHardware→Graphics Card
and Monitor. This opens the SUSE Advanced X11 Configuration interface (SaX2),
where you can configure devices such as your mouse, keyboard, or display devices.
This interface can also accessed from the main menu by clicking System→ Configura-
tion → SaX2.

3.11.1 Card and Monitor Properties
Adjust the settings for your graphics card and display device in Card and Monitor
Properties. If you have more than one graphics card installed, each device is shown in
a separate dialog reachable by a tab. At the top of the dialog, see the current settings
for the selected graphics card and the monitor that is attached to it. If more than one
screen can be connected to the card (dual head), the monitor on the primary output is
shown. Normally, the card and display device are detected automatically by the system.
However, you can tune many parameters manually or even change the display device
completely.
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Figure 3.12 Card and Monitor Properties

Graphics Card
It is not possible to change the graphics card because only known models are supported
and these are detected automatically. However, you can change many options that affect
the behavior of the card. Normally, this should not be necessary because the system
already has set them up appropriately during installation. If you are an expert and want
to tweak some of the options, click Options next to the graphics card and select the
option you want to change. To assign a value needed to a certain option, enter this
value in the dialog that appears after selecting that option. ClickOK to close the options
dialog.

Monitor
To change the current settings for the monitor, click Change next to the monitor. A
new dialog opens in which to adjust various monitor-specific settings. This dialog has
several tabs for various aspects of monitor operation. Select the first tab to manually
select the vendor and model of the display device in two lists. If your monitor is not
listed, you can choose one of the VESA or LCD modes that suit your needs or, if you
have a vendor driver disk or CD, click Utility Disk and follow the instructions on the
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screen to use it. Check Activate DPMS to use display power management signaling.
Display Size, with the geometrical properties of the monitor, and Sync Frequencies,
with the ranges for the horizontal and vertical sync frequencies of your monitor, are
normally set up correctly by the system, but you can modify these values manually.
After making all adjustments, click OK to close this dialog.

WARNING: Changing Monitor Frequencies

Although there are safety mechanisms, you should still be very careful when
changing the allowed monitor frequencies manually. Incorrect values might
destroy your monitor. You should always refer to the monitor's manual before
changing frequencies.

Resolution and Color Depth
The resolution and color depth can be chosen directly from two lists in the middle of
the dialog. The resolution you select here marks the highest resolution to use. All
common resolutions down to 640x480 are also added to the configuration automatically.
Depending on the graphical desktop used, you can switch to any of these later without
the need for reconfiguration.

Dual Head
If you have a graphics card with two outputs installed in your computer, you can connect
two screens to your system. Two screens that are attached to the same graphics card
are referred to as dual head. SaX2 automatically detects multiple display devices in the
system and prepares the configuration accordingly. To use the dual head mode of a
graphics card, check Activate Dual Head Mode at the bottom of the dialog and click
Configure to set the dual head options and the arrangement of the screens in the dual
head dialog.

The tabs in the row at the top of the dialog each correspond to a graphics card in your
system. Select the card to configure and set its multihead options in the dialog below.
In the upper part of the multihead dialog, click Change to configure the additional
screen. The possible options are the same as for the first screen. Choose the resolution
to use for this screen from the list. Select one of three possible multihead modes.
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Traditional Multihead
Each monitor represents an individual unit. The mouse pointer can switch between
the screens.

Cloned Multihead
In this mode, all monitors display the same contents. The mouse is only visible on
the main screen.

Xinerama Multihead
All screens combine to form a single large screen. Program windows can be posi-
tioned freely on all screens or scaled to a size that fills more than one monitor.

NOTE

Linux currently does not offer 3D support for Xinerama multihead environ-
ments. In this case, SaX2 deactivates the 3D support.

The arrangement of the dual head environment describes the sequence of the individual
screens. By default, SaX2 configures a standard layout that follows the sequence of the
detected screens, arranging all screens in a row from left to right. In the Arrangement
part of the dialog, determine the way the monitors are arranged by selecting one of the
sequence buttons. Click OK to close the dialog.

Multihead
If you have more than one graphics card installed in your computer, you can connect
more than one screen to your system. Two or more screens that are attached to different
graphics cards are referred to as multihead. SaX2 automatically detects multiple
graphics cards in the system and prepares the configuration accordingly. By default,
SaX2 configures a standard layout that follows the sequence of the detected graphics
cards, arranging all screens in a row from left to right. The additional Arrangement tab
allows for changing this layout manually. Drag the icons representing the individual
screens in the grid and click OK to close the dialog.

3D Acceleration
If your graphics card supports 3D acceleration, you can switch it on and off with Activate
3D Acceleration.
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Testing the Configuration
Click OK in the main window after completing the configuration of your monitor and
your graphics card, then test your settings. This ensures that your configuration is suitable
for your devices. If the image is not steady, terminate the test immediately by pressing
Ctrl + Alt + Backspace and reduce the refresh rate or the resolution and color depth.

NOTE

Regardless of whether you run a test, all modifications are only activated when
you restart the X server.

3.11.2 Mouse Properties
Adjust the settings for your mouse in Mouse Properties. If you have more than one
mouse with different drivers installed, each driver is shown in a separate tab. Multiple
devices operated by the same driver are shown as one mouse. Activate or deactivate
the currently selected mouse with the check box at the top of the dialog. Below the
check box, see the current settings for that mouse. Normally, the mouse is detected
automatically, but you can change it manually if the automatic detection fails. Refer to
the documentation for your mouse for a description of the model. ClickChange to select
the vendor and model from two lists then click OK to confirm your selection. In the
options part of the dialog, set various options for operating your mouse.

Activate 3-Button Emulation
If your mouse has only two buttons, a third button is emulated when you click both
buttons simultaneously.

Activate Mouse Wheel
Check this box to use a scroll wheel.

Emulate Wheel with Mouse Button
If your mouse does not have a scroll wheel but you want to use similar functionality,
you can assign an additional button for this. Select the button to use. While pressing
this button, any movement of the mouse is translated into scroll wheel commands.
This feature is especially useful with trackballs.

When you are satisfied with your settings, click OK to confirm your changes.
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NOTE

Any changes you make here take effect only after you restart the X server.

3.11.3 Keyboard Properties
Use this dialog to adjust the settings for operating your keyboard in the graphical envi-
ronment. In the upper part of the dialog, select the type, language layout, and variant.
Use the test field at the bottom of the dialog to check if special characters are displayed
correctly. Select additional layouts and variants to use from the list in the middle. De-
pending on the type of your desktop, these may be switched in the running system
without the need for reconfiguration. After you click OK, the changes are applied im-
mediately.

3.11.4 Tablet Properties
Use this dialog to configure a graphics tablet attached to your system. Click the
Graphics Tablet tab to select vendor and model from the lists. Currently, SUSE Linux
supports only a limited number of graphics tablets. To activate the tablet, check Activate
This Tablet at the top of the dialog.

In the Port and Mode dialog, configure the connection to the tablet. SaX2 enables the
configuration of graphics tablets connected to the USB port or the serial port. If your
tablet is connected to the serial port, verify the port. /dev/ttyS0 refers to the first
serial port. /dev/ttyS1 refers to the second. Additional ports use similar notation.
Choose appropriate Options from the list and select the Primary Tablet Mode suitable
for your needs.

If your graphics tablet supports electronic pens, configure them in Electronic Pens.
Add eraser and pen and set their properties after clicking Properties.

When you are satisfied with the settings, click OK to confirm your changes.

3.11.5 Touchscreen Properties
Use this dialog to configure touchscreens attached to your system. If you have more
than one touchscreen installed, each device is shown in a separate dialog reachable by
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a tab. To activate the currently selected touchscreen, check Assign a Touchscreen to
Display at the top of the dialog. Select vendor and model from the lists below and set
an appropriateConnection Port at the bottom. You can configure touchscreens connected
to the USB port or the serial port. If your touchscreen is connected to the serial port,
verify the port. /dev/ttyS0 refers to the first serial port. /dev/ttyS1 refers to the
second. Additional ports use similar notation. When you are satisfied with your settings,
click OK to confirm your changes.

3.11.6 Remote Access Properties
VNC (Virtual Network Computing) is a client-server solution that gives access a remote
X server with a slim and easy-to-use client. This client is available for a variety of op-
erating systems, including Microsoft Windows, Apple's MacOS, and Linux. Find addi-
tional information about VNC at http://www.realvnc.com/.

Use this dialog to configure your X server as a host for VNC sessions. If you want VNC
clients to connect to your X server, check Allow Access to Display Using VNC Protocol.
Set a password to restrict access to your VNC-enabled X server. Check Allow Multiple
VNC Connections if more than one VNC client should connect to the X server at the
same time. Allow HTTP access by checking Activate HTTP Access and setting the port
to be use in HTTP Port.

When you are satisfied with your settings, click OK to save your changes.
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4First Contact
This chapter guides you through the first encounter with your freshly installed Linux
system. Learn all about the different components of your system environment. After
this crash course, you will be able to use and enjoy your SUSE Linux system.

This chapter focuses on the installed system. It does not cover questions regarding the
installation or hardware configuration procedures under SUSE Linux. These procedures
are covered in-depth in the Referencemanual and some of the most frequently encoun-
tered problems are dealt with in Chapter 9, Common Problems and Their Solutions
(page 223).

4.1 Logging In and Out
If your computer is not run in a networking environment and you are the only person
using it, your system automatically boots into the desktop environment. Once you have
started your computer, there is no need for you to authenticate. This feature, called auto
login, is only provided by the KDM display manager, however. It can be disabled at
any time using the YaST user management module described in the Referencemanual.

If more than one user account is configured on your computer, all users must authenti-
cate. After your SUSE Linux system has started, you are prompted for your username
and password.

Depending on the desktop environment installed, the program managing the login
process and sessions is either GDM for GNOME desktops or KDM for KDE. GDM
and KDM differ slightly in functionality, which is why they are treated separately. See
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Section 4.3, “Desktop” (page 114) for details on the desktop environments or refer to
the separate GNOME or KDE chapters, Chapter 8, The GNOMEDesktop (page 201) or
Chapter 7, The KDE Desktop (page 173), respectively.

4.1.1 Introducing GDM
A GDM login screen consists of two main components, the input fields for username
and password and a menu.

The menu contains three items:

Language
Select the language to use in the following GNOME session. You may change the
language temporarily for just the next session or set the choice permanently as your
default.

Session

Determine the session type (GNOME, KDE, etc.). Change this setting only if you
want to use something other than the system default. Future sessions will always
be of the same type as the initial one, unless you change the session type manually.

Shutdown
Shut down the system entirely.

Reboot
Shut down the system and reboot.

To terminate the session, choose Log Out from the System menu. Then determine
whether to save the current state of your session, end your session and leave the system
running, or restart or shut down on logout. Choose to save your session if you want to
start your next one with exactly the same setup as when you leave.

4.1.2 Introducing KDM
A KDM login screen consists of two main elements. As shown in Figure 4.1, “A KDM
Login Screen” (page 113), it has input fields for username and password and a menu.

The menu provides the following options:
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Figure 4.1 A KDM Login Screen

Session Type
Determine the session type. Make changes only if you want to use a session type
other than the default (KDE). Future sessions are automatically of the same type
unless you change the session type manually.

Menu
Remote Login enables you to log in on a remote machine. Shutdown either turns the
computer off completely or reboots the system.

To terminate the session, choose Logout from the main menu. Then determine whether
to end your session and leave the system running or restart or shut down on logout. If
your system provides power management, you are offered to suspend the computer,
making the next system start much faster than a complete boot.

4.2 The User Concept of Linux
Linux distinguishes between “ordinary” users and a superuser. The superuser, called
root, takes care of all kinds of administrative tasks and has access to all parts of the
system. Normal users lack these privileges.
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All users including the superuser have their own home directories where all private
data, like documents, bookmarks, or e-mail, are stored. Write access to these home di-
rectories is strictly limited to the owner. Folders in a home directory holding sensitive
data can also be protected against read access by other users. System directories holding
central configuration files or executable files can only be modified by the superuser.
For more information about the Linux permission and user concept, refer to Sec-
tion “Users and Access Permissions” (Chapter 27,Working with the Shell, ↑Reference).

While this concept may not look very appealing at first, it adds to security. A user
without root privileges cannot damage the entire system. Any damage caused is
strictly limited to the user's own account and data. Any operation executed with root
privileges may potentially harm the entire system. Anyone intending to harm a running
Linux system must gain root privileges first. This is why it is much harder to create
viruses for Linux systems. They must overcome the root barrier first.

As well as offering different user identities for administrators and normal users, Linux
supports multiple users working on one machine simultaneously. These users can connect
to the system via different terminals or network connections.

4.3 Desktop
SUSE Linux offers several choices for your desktop. GNOME and KDE, the most
common desktops, provide features and functions similar to those of the desktop used
in Microsoft Windows or Mac OS. This section introduces their most important features
and helps you to get accustomed to your new desktop environment.

4.3.1 Desktop Terminology
The following list introduces some terms often used in a desktop context, regardless of
the base system. However, some of them have different meanings in different desktop
environments or are even limited to one environment.
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Figure 4.2 An Example Desktop

desktop
The desktop is your primary work environment. It fills the screen, but is more than
just a background. Put icons of your most frequently used applications or objects
on the desktop for easy access.

panel
The panel is a bar, typically located at the top or the bottom of the screen, that holds
the menus, the quick launch area, a notification area or system tray, some little
helper applications, and, in most cases, also the taskbar (called window list in
GNOME). It is designed to provide all vital information needed about running ap-
plications or the system and to provide easy access to some important functions or
applications. Both GNOME and KDE allow you to adjust the panel orientation
(horizontal versus vertical) to your needs. In a KDE environment, you might also
see “Kicker” as another word for the panel.

menu button
Similar to the “start button” on the MS Windows desktop, Linux desktops normally
contain a menu button at the left end of the panel that opens the main menu. This
menu has a well-ordered structure for accessing the main applications or functions,
such as Search, Logout, and Lock Session.
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taskbar or window list
The taskbar (window list in GNOME) is used to switch between different open
windows. In Linux, it also provides an overview of all virtual desktops available
and provides a means to switch between them. The taskbar is part of the panel.

quick launcher
The quick launcher is part of the panel. It holds the icons for the most important
functions or applications to enable you to start them without going through the ap-
plication menu.

notification area or system tray
The rightmost part of the panel holds the system clock, the volume control, and
several other helper applications.

applet
An applet is a small application that is integrated into the panel. An application is
a fully fledged computer program using its own window on screen.

desktop icons
Desktop icons reside on the desktop. They represent files, directories, applications
or functions, and removable media, like CDs or DVDs. The best known desktop
icon is probably the trash bin, where you can drop files to delete.

virtual desktops or workspaces
The concept of virtual desktops (workspaces in GNOME) is like having several
desks at your office. You store things on all of them, but you only work at one of
them at a time. You can devote each to different tasks or just use them as extra
space. Virtual desktops enable you to have multiple windows open at the same time,
but only look at one or some of them. Easily shift windows between virtual desktops,
like shifting papers from one physical desk to another. All desktop environments
offer a means to control the number and use of virtual desktops. A workspace
switcher is provided in both the GNOME and the KDE panel.

terminal
A terminal enables you to send commands to the operating system. There are “real”
(physical) terminals basically consisting of a display screen and a keyboard connected
to the computer. Then there are terminal emulations, which run in a window on
your desktop and offer a prompt where you can pass commands to the operating
system.
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session
Once you log in to your desktop, it starts a session for you. This session is valid
until you log out again. A session includes the start-up and shutdown of certain
programs on login and logout. These settings can be configured individually for
each user account.

4.3.2 Configuring Desktop Components
Almost all desktop components can be configured individually. Right-clicking an element
opens its context menu. To illustrate the procedure, we provide some examples.

TIP: Controlling the Desktop Configuration

Both GNOME and KDE feature a Control Center providing central access to all
key configuration options of the desktop environment. Refer to Chapter 8, The
GNOMEDesktop (page 201) or Chapter 7, The KDEDesktop (page 173) for details.

Configuring GNOME Desktop Components
Procedure 4.1 Adding a New Application to the Quick Launch Area

1 Right-click an empty patch of the panel where you want to add the new applica-
tion.

2 Choose Add to Panel from the menu that appears.

3 Select Application Launcher from the Add to Panel menu.

4 Select the application from the Applications menu and quit the configuration.

Procedure 4.2 Changing the Desktop Background

1 Right-click the desktop.

2 Choose Change Desktop Background from the menu that appears.

3 A dialog box appears, offering several options concerning the desktop. Either
use the mouse cursor to select one of the existing wallpapers or click Add Wall-
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paper to open a file dialog where you can add your own image. Use Style to de-
termine how the image should be rendered to fit into the dimensions of your
display. Use Remove to remove a selected background from the menu. If you
prefer no background image at all, set a desktop color.

4 Your changes are applied automatically. Leave the dialog with Close.

Procedure 4.3 Creating a New Desktop Icon

1 Add a new application or service icon (called “Launcher” in GNOME):

a Right-click the desktop to open the context menu.

b Select Create Launcher to open the appropriate dialog.

c Enter Name, Generic Name, an optional Comment, and the Command to
execute. Determine whether the application should be run in a terminal and
verify that Type is set to the appropriate value, which is Application for
commands.

d Apply your settings and leave the dialog with OK.

2 Add a new folder or document:

a Right-click the desktop to open the context menu.

b SelectCreate Folder orCreate Document to add the new item to the desktop.

c Right-click the new desktop icon and select Properties.

d Enter the name of the new object in the Basic tab. Select an appropriate icon
via the Emblems tab. Determine the file system permissions assigned to this
object using the Permissions tab. Finally, select the preferred application
for opening this document via the Open With tab. Read more about file
system permissions in Section “Users and Access Permissions” (Chapter 27,
Working with the Shell, ↑Reference).

e Close the Properties dialog to apply your changes.
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Configuring KDE Desktop Components
Procedure 4.4 Adding a New Application to the Quick Launch Area

1 Right-click an empty patch of the panel where you want to add the new applica-
tion.

2 Choose Add to Panel → Application from the menu that appears.

3 Select the application from one of the categories of the submenu.

Procedure 4.5 Changing the Desktop Background

1 Right-click the desktop.

2 Choose Configure Desktop. A dialog opens that allows the modification of the
desktop settings Background, Behavior, Multiple Desktops, Screen Saver, and
Display.

3 Choose Background and determine whether your settings should be applied to
one specific desktop or to all. Select a background image, disable background
images, or start a slide show. Options offers several settings for the positioning
of the background image, the background color, and the blending of colored
backgrounds.

4 Apply your changes and leave the dialog with OK.

Procedure 4.6 Creating a New Desktop Icon

1 Add a new folder icon:

a Right-click the desktop to open the context menu.

b Select Create New → Folder.

c Enter the name of the new folder when prompted to do so.

d Right-click the new icon and select Properties in the context menu that ap-
pears.
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e The Properties dialog consists of four tabs: General, Permissions, Meta
Info, and Share. The name and icon of the folder are set in the General tab.
Permissions are modified inPermissions.Meta Info lists the size and number
of items of the new folder. Share can be used to configure file sharing using
NFS or Samba. For more information about these two protocols, refer to
Reference.

f Apply your changes and leave the dialog with OK.

2 Add a new file icon:

a Right-click the desktop for the context menu to appear.

b Select Create New.

c Choose the appropriate file type fromHTML File, Link to Application, Link
to Location, or Text File.

d Enter the name of the new file when prompted to do so.

e Right-click the new icon and select Properties in the context menu that ap-
pears.

f The Properties dialog consists of three tabs: General, Permissions, and
Meta Info. Set the name and icon of the file in the General tab. Change
permissions in Permissions. Meta Info lists line, word, and character count
and the format of the new file.

g Apply your changes and leave the dialog with OK.

3 Add a new device icon:

a Right-click the desktop to open the context menu.

b Select Create New → Link to Device.

c Choose the appropriate device type to open the Properties dialog.
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d The Properties dialog consists of four tabs: General, Permissions, Device,
and Meta Info. Set the name and icon of the device in the General tab.
Modify permissions in Permissions. Device is used to set the device path,
such as /media/dvd for your DVD drive, and several other options.

e Apply your changes and leave the dialog with OK.

4.3.3 Little Helpers
Both GNOME and KDE come with numerous little helper applications that can be in-
cluded in your panel. To add new ones or remove existing ones, proceed as described
in Section 4.3.2, “Configuring Desktop Components” (page 117). Some of the most
useful and prominent ones are:

SuSEWatcher
SUSEWatcher is a program that is integrated into the system tray of the panel. It
checks for new software updates. To be able to find any new updates, it requires an
appropriate network connection. The status of SUSEWatcher is displayed in the
panel by icons in different colors.

When you click the icon in the panel, a window opens, informing you about the
status of your online updates and the availability of any new updates. You can also
launch the check manually by clicking Check for Updates. Start the online update
by selecting Start Online Update and entering the root password. The YaST Online
Update window is displayed.

SUSE Hardware Tool
The SUSE Hardware Tool keeps a list of all hardware components of your system.
Left-click the panel icon to open a dialog window with a tree view featuring the
major hardware categories. Configure a new hardware item by selecting it and
clicking Configure, which starts the appropriate YaST module after you provide
the root password. ClickingDetails reveals all information present for the specific
hardware item. As soon as new hardware is connected and recognized, a pop-up
announces this new hardware.

Beagle
Beagle is a little search tool tailored for the GNOME desktop that indexes and
searches your personal information space, including e-mail messages, chat logs,
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and many other items. Find out more on Beagle in Chapter Using Beagle (↑Refer-
ence).

KRandRTray
KRandRTray allows you to adjust the screen resolution and refresh rate on the KDE
desktop. All options displayed are supported by your current hardware configuration.
To change to another resolution, click the tray icon, select the new resolution, and
confirm the new setting when prompted to do so. With Configure Display, change
Size & Orientation, Monitor Gamma, and Power Control of your display, if your
current hardware configuration provides the option to change these settings.

Resolution Switcher
Resolution Switcher adjusts screen resolution and refresh rate of your display on
the GNOME desktop. Click the panel icon and select an appropriate resolution and
refresh rate for your purposes. The options displayed by Resolution Switcher are
all supported by your current display configuration. To change your display confi-
guration, click the panel icon to open the menu and selectConfigure Display Settings.
Provide the root password and change the hardware configuration if needed.

4.3.4 Switching Users
Both GDM and KDM allow you to switch between different user accounts on the same
system. You can stay logged in while other users work on your system. Your session
is locked while you switch to another account, but your applications continue to run
and your whole session remains unchanged.

Switching Users in GNOME
To open an additional session for another user, select New Login from the GNOME
Applicationsmenu. The other user enters username and password in GDM then another
GNOME session starts. Your original session is locked automatically on the user switch.
To change back into your original session, use Ctrl + Alt + F7 .

IMPORTANT: Switching Displays

Your original session is started on the graphical console that can be reached
with Ctrl + Alt + F7 . Additional sessions are started on the higher consoles,
reachable with F8 and higher.
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Switching Users in KDE
Open an additional session in KDE from the main menu. Select Switch User and deter-
mine whether your original session should be locked while you switch to another user
account. KDM appears, requesting username and password for the new account. Enter
the requested data and a new KDE session starts. To switch back to your original session,
click Switch User again. Select the session to which to switch.

Another way to start a new session is to lock your current session via Lock Session then
click Switch User in the unlock dialog. This goes to the KDM login screen, where
username and password for the new session can be entered.

4.4 File Management
A central part of your desktop environment is a file manager application, enabling you
easily to create, access, and manage all files on your system. Traditional file management
in Linux would have been done via the command line, requiring some deeper knowledge
of several commands to list, create, delete, or edit files and their properties. A file
manager provides a graphical and more intuitive way to handle these tasks. Learn more
about the file managers of GNOME and KDE in Section 8.2, “File Management with
Nautilus” (page 205) and Section 7.2, “Konqueror as a File Manager” (page 176).

4.4.1 The Concept behind a Linux File
System

Unlike a Windows operating system, Linux does not use drive letters. In Windows, you
would address the floppy drive as A:\, Windows system data is under C:\, and so on.
In Linux, all files and directories are located in a tree-like structure. The topmost direc-
tory is referred to as the file system root or just /. All other directories can be accessed
from here.

The following is a short guide through the Linux file system tree, introducing the most
important directories:

First Contact 123



/home/username
/home holds the private data of every user who has an account on your system.
The files located here can only be modified by their owner or the system adminis-
trator. Your e-mail directory is located here, for example.

/media
/media generally holds any type of drive except the hard drive of your system.
Your USB flash drive appears under /media once you have connected it, as do
your digital camera (if it uses USB) and DVD or CD drive.

/usr/share/doc
Under /usr/share/doc, find any kind of documentation on your Linux system
and the installed packages. The manual subdirectory holds a digital copy of this
manual as well as the Referencemanual and the release notes of the installed version
of SUSE Linux. The packages directory holds the documentation included in the
software packages.

/windows
If you have both MS Windows and Linux installed on your system, this is where
you find the MS Windows data.

Learn more about the Linux file system concept and find a more comprehensive list of
directories in Section “Files and Directories” (Chapter 27, Working with the Shell,
↑Reference).

4.4.2 Different Flavors of Your File
Manager

Apart from organizing all your data and previewing almost any type of file, your file
manager can act as a “quick finder” for personal data, system information, and network
services. These modules are part of your standard desktop.

Home Directory
Use the Home desktop icon in GNOME or the icon depicting a small house in the
KDE panel to launch your file manager (Nautilus in GNOME, Konqueror in KDE)
showing all the contents of your home directory. This option allows you to quickly
retrieve any personal data located in your home directory.
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Your System
If you need to know which hard drives or removable media are connected to your
system, click the desktop icons Computer (GNOME) orMy Computer (KDE). The
file managers provide an overview of all drives attached to your system, including
the hard drives. As you click one of the drives listed there, the file manager opens
the files and directories located on this drive. This option allows you to locate data
on any kind of removable device attached to your system. A digital camera appears
in this list as does a USB flash or hard drive.

Your Network
Use the Places menu in the top GNOME panel to access network folders. In KDE,
click the Network Browsing desktop icon to gather all services provided in your
network. Use this functionality to access available network shares and Windows
networks, FTP servers, or any other service type that has been registered for your
network.

4.4.3 Searching Files
If you need to search for a certain file across the whole system, use the graphical search
applications provided by your desktop environment. In GNOME, select Places →
Search for Files to launch the search tool. The first dialog prompts you for the name
or at least a part of the name of the file. Specify the directory to search for the file. If
you know the file should be located in your home directory, accept the /home/
username path that has automatically been selected. To launch a search on the entire
file system, select the file system root by entering /. Refine your search by adding more
search criteria. Click Show more options and select any of the criteria offered there. It
is even possible to use regular expressions or wild cards. After you enter all data, hit
Find to launch the search and see the result in the bottom part of the window. Depending
on the scope of your search, the whole process may take a considerable amount of time.

KDE contains the application KFind, which is launched from the main menu with Find
Files. The search window is divided into the tabs Name/Location, Contents, and Prop-
erties. In theName/Location tab, enter the name of the file using wild cards, like asterisks
or question marks, if needed. Enter the path to search and determine whether the search
should include subfolders or be case sensitive. The Contents tab is used to search the
contents of files for certain expressions. This type of search is only supported for a
limited number of file types, such as text files and OpenOffice.org or KWord formats.
You can even use regular expressions if KRegExpEditor is installed (package
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kdeutils3-extra). To limit the scope of the search by providing attributes like
file owner, file size, or modification date, use the Properties tab.

TIP: More Information about Search Patterns

For more information about search patterns and the use of wild cards or regular
expressions, refer to Section “Using of Bash on the Command Line” (Chapter 27,
Working with the Shell, ↑Reference).

4.5 Applications
SUSE Linux comes with a wealth of applications. There is a Linux option for almost
any purpose. Quite often, you even find more than one suitable application for your
purpose. Chapter 5,Getting to KnowLinux Software (page 137) provides a comprehensive
list of applications you might look for when converting from MS Windows. There,
easily find the Linux analog of your MS Windows application.

There are three different ways to launch an application in Linux. The easiest and most
prominent one is the main menu of your desktop environment. Click at the leftmost
edge of the panel to fold out the menu. Select the appropriate category to fold out a
submenu holding the actual application names and icons.

Some applications do not appear in the main menu even though they are installed. To
launch one of them, open the main menu then select Run Application (GNOME) or
Run Command (KDE) and enter the name of the application in lowercase letters. Alter-
natively, start this dialog using Alt + F2 . The third way to launch an application is to
open a shell and enter the command at the shell prompt, also known as command line.

TIP: Missing Applications

If an application could not be started from the menu or the command line,
you need to install it from your SUSE Linux CD or DVD.
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4.6 Printing
Printers can either be connected to your system locally or via a network. Either kind of
configuration is made initially using YaST. For an in-depth coverage of printer confi-
guration, refer to the printer chapter in the Reference manual. As soon as a connection
has been established, start using the printer. Both desktops provide applications enabling
you to monitor and edit the print jobs queued at the selected printer.

4.6.1 Managing Print Jobs in GNOME
When you send a print job to the printer, such as printing a document from OpenOf-
fice.org or printing an image from The GIMP, the print job is added to the print spool
queue. The print spool queue is a list of print jobs that have been sent to the printer
along with information about each print job, such as the status of the job, the username
of the person who sent the job, the name of the print job, and the job number.

To manage print jobs in GNOME, start the Cups Manager from the command line with
gnome-cups-manager or by clicking Applications → Utilities → Printing →
Printers. A window opens showing any printers attached to your system. Double-click
the icon representing the printer you want to monitor. This opens a window holding
the list of print jobs. See Figure 4.3, “Managing Print Jobs with GNOME Cups Manager”
(page 127).

Figure 4.3 Managing Print Jobs with GNOME Cups Manager

The menu bar of the jobs window contains two menus, Printer and Edit. Use the
Printer menu to pause the current print job, print a test page, or modify the print prop-
erties (such as paper size and orientation, printout mode, and resolution). The Editmenu
allows you to pause, resume, or remove any selected job that is not yet printing.
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4.6.2 Managing Print Jobs in KDE
To control print jobs in KDE, use two different applications. Start and configure the
print job with KPrinter then control the processing of the print job with KJobViewer.

Start KPrinter with the command kprinter from the command line. A small window
opens in which to choose a printer and edit the Properties of your print job, such as
page orientation, pages per sheet, and duplex printing. To specify the file to print, the
number of copies, and various other options, clickExpand at the bottom left. The window
then expands and shows four tabs: Files, Copies, Advanced Options, and Additional
Tags. See Figure 4.4, “Starting a Print Job with KPrinter” (page 128).

Figure 4.4 Starting a Print Job with KPrinter

The first tab, Files, determines the file or files to print. Either drag them from the
desktop and drop them into the list window or use the file dialog to locate them. Copies
determines the page selection (all pages of the selected document, the currently selected
one, or a range) and the number of copies. You may also choose to print only the even
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or only the odd numbered pages of the selected document. Use Advanced Options to
specify any additional information for the print job. Enter any Billing information if
needed or set a custom page label at the top and bottom of the page. The Job Priority
can also be set here. The fourth tab, Additional Tags is hardly ever needed. Once your
print job has been filed, you can watch its progress using KJobViewer.

TIP: Printing from KDE Applications

The KPrinter dialog opens any time you print from a KDE application. The dialog
is basically the same except for the lack of the Files tab, which is not needed
because the file to print was determined when you selected Print.

Start KJobViewer from the main menu or with the command kjobviewer from the
command line. A window like that in Figure 4.5, “Managing Print Jobs with KJobView-
er” (page 129) opens, listing all the print jobs queued on your printer. As long as your
print job is not active, you can edit it. Do this using the entries of the Jobs menu.

Figure 4.5 Managing Print Jobs with KJobViewer

If, for example, you want to check if you sent the correct document to the printer, you
can stop the job and resume it if you decide to print it. Remove your own print jobs
from the queue with Remove. To change the printer, select a different printer withMove
to Printer.

With Restart, reprint a document. To do this, select Filter → Toggle Completed Jobs,
select the desired document, and click Jobs→ Restart. Clicking Jobs→ Job IPP Report
reveals the technical details of a job. Use Jobs→ Increase Priority and Jobs→Decrease
Priority to set the priority, depending on how quickly you need the document.
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Filter enables you to switch between various printers, toggle completed jobs, and limit
the view to your own print jobs by selecting Show Only User Jobs. The current user is
then displayed in the top right field.

Settings → Configure KJobViewer opens a configuration dialog. Here, determine the
maximum number of print jobs to display. Enter a number in the field or use the slider
to the right to determine a value. PressOK to save the setting orCancel to exit the dialog
without saving.

The icons in the toolbar correspond to the functions you can access by way of the menu.
A help text explaining the function is displayed when you move the mouse pointer over
one of the icons.

The job list consists of eight columns. The job ID is automatically assigned by the print
system to identify the various jobs. The next column contains the login of the user who
sent the job followed by the filename of the document. The status column indicates
whether a job is still in the queue, currently being printed, or already completed. Next,
the size of the document is displayed in kilobytes and number of pages. The default
priority of 50 can be increased or reduced if necessary. Billing information can be cost
centers or other company-specific information. If you right-click a job in the list, the
Jobsmenu opens under the mouse pointer, allowing you to select an action. Only a few
functions are available for completed jobs. If you activate Keep window permanent,
KJobViewer opens automatically when you log in the next time.

4.7 Security
If converting to a Linux system from a Microsoft Windows system, you probably expe-
rienced a fair share of trouble caused by multiple kinds of viruses and worms spreading
over the Internet via e-mail. Now that you have made the switch to Linux, you can at
least put that fear aside, because these cannot harm a Linux system as easily as a Win-
dows system.

As mentioned in Section 4.2, “The User Concept of Linux” (page 113), Linux knows
two different kinds of users, a superuser (root) and normal users. root has access
to all system resources and is allowed to change all aspects of the system's configuration.
Switching from your normal user account to root for administrative tasks and
switching back for your normal work sounds tedious and perhaps unnecessary because
root has ultimate power over the system. Still, switching back to the normal user ac-
count after accomplishing the administrative jobs adds to security, because any mistake
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made as root can have severe consequences. The whole system might be affected,
not just the normal user account. Thus, preserve your system's integrity by clearly dis-
tinguishing between the different roles (“normal user” and “superuser”).

Keeping your system up to date by always applying the software updates provided by
SUSE adds to the security of your system. These updates fix possible exploits contained
in the application code.

Protect your system or your network against external “visitors” by running a firewall.
A preconfigured firewall is started on installation, providing maximum security to your
network. If you need to add support for certain services and do not maintain your system
yourself, ask your system administrator to make the necessary adjustments in the firewall
settings. Otherwise read the chapter about security in the Reference manual and learn
how to secure your network using SuSEFirewall.

4.8 Networking and Mobility
GNOME and KDE offer several applications for working in a network environment or
using a mobile computer. It is much more convenient and much easier to click a small
icon to connect to or disconnect from a network than to run a script manually. Monitoring
the power state of your mobile computer via a small icon is easier than watching obscure
system messages. The following sections introduce some of these little helpers, but
many more are offered by your desktop environment.

4.8.1 Networking
Network connections, even wireless ones, can be easily configured and monitored by
small applications seamlessly integrating into your desktop panel. KInternet can be
used to configure and monitor any kind of network connection on the KDE desktop.
Netapplet serves the same purpose in a GNOME desktop environment.

IMPORTANT: Network Configuration

The initial configuration of any network connection is made with YaST, the
SUSE Linux configuration management tool. Find information about this in the
Reference manual.
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KInternet—Connecting to the Internet
After your network device has been configured correctly, control the Internet dial-up
with KInternet. On start-up, KDE loads KInternet. The program checks whether an In-
ternet connection can be established. If this is possible, the application icon, a plug,
automatically appears in the right part of the KDE panel. Depending on the state of the
network connection, the panel icon changes appearance:

Currently there is no connection to the Internet.

The connection is just being established or terminated.

The connection has been established.

Data is transmitted to or from the Internet.

An error has occurred. If a connection has already been configured with YaST, use
View Log to identify the reason for the error. The menu can be accessed by right-
clicking the KInternet icon.

The connection is not yet active, but will be established as soon as a request is made.

Right-click the KInternet panel icon to access its configuration menu. The YaST confi-
guration dialog can be started via Settings → Configure with YaST. After entering the
root password, YaST starts. Depending on the access type, start the modem, ISDN,
network, or DSL configuration of YaST.

If you are using an ISDN connection and you have selectedChannel Bundling in YaST,
a second ISDN channel can be added to an existing connection with Add link. This
doubles the transfer rate (although at a higher price). Activate channel bundling if you
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need to download large files. The activated channel bundling is evident from the red
plus symbol at the top left corner of the KInternet icon.

If your computer has more than one network device and you have configured all of
them with YaST, you can use the KInternet option Interface to switch between these
interfaces. You must have selectedUser Controlled device activation in the appropriate
YaST network dialog to do this. If you have multiple providers as well, choose them
using Provider in KInternet. Providers are also set in YaST.

Users who want to establish Internet connections automatically can use dial on demand
(DoD). If this mode is selected, KInternet automatically connects to your Internet service
provider (ISP) as soon as a request is submitted. After a certain time-out, the connection
is terminated. A DoD connection is evident from the blue D at the bottom right corner
of the KInternet icon.

WARNING: Cost Control

Note that DoD only makes sense if you have a flat rate Internet account. If that
is not the case, connecting and disconnecting all the time can become very
costly.

If you intend to use a wireless network card as your connection to the Internet, configure
it using YaST as described in the Referencemanual and make sure that the device acti-
vation in YaST is set to User Controlled. As soon as the interface is configured, you
can use KInternet to control your wireless network connection, just as you would for
normal network interfaces.

To access the WLAN functionality of KInternet, right-click the icon to open the menu.
Select Wireless Connection and a window showing two tabs opens. First, scan for
suitable wireless networks you could connect to. Select the tab Scan for Wireless Net-
works, shown in Figure 4.6, “KInternet: Scanning for Wireless Networks” (page 134).
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Figure 4.6 KInternet: Scanning for Wireless Networks

Start the scan with Start Scan. For KInternet to continuously scan the network environ-
ment, also select Auto Refresh. Acoustic feedback for each connection found can be
activated via Acoustic Scan. Any connection found is displayed in the list window.
Select one and click Connect to connect to the selected network. If additional configu-
ration efforts are needed to connect to the selected network, click Start YaST to launch
the YaST network module for wireless network devices.

The Current Connection tab allows you to monitor the state of your current wireless
connection. The left-hand view of this tab offers a summary of all connection parameters
regarding network address and ESSID, signal quality, signal and noise level, channel
frequency and speed, and encryption parameters, such as type of encryption and key
length. Select any of these parameters in the tree structure and check the details displayed
in the right part of the window.

Netapplet—Managing Your Internet Connections
Netapplet allows you to easily monitor and switch network connections available on
your computer including wireless connections. Once the initial configuration of the
network interfaces is done with YaST, Netapplet controls your Internet connectivity.

A typical Netapplet menu contains the following items that are displayed when you
click the panel icon:

Network Connections
Depending on the hardware configuration of your machine, all sorts of possible
network interfaces can appear in this area: dial-up, wireless, and ethernet.
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Wireless Connections
If your machine is currently configured to use wireless networking, this area displays
the currently configured ESSID in YaST. Clicking Other allows you to configure
another ESSID temporarily, which comes in handy if you use your laptop in several
different environments. These temporary settings are overwritten with the default
configured in YaST when the computer is restarted.

Connection Information
This option shows the connection parameters of your currently selected connection
(IP address, routing information, etc.).

Configure Network Settings
Use this option to configure additional network hardware using the YaST network
modules.

Remove From Panel
If Netapplet is not needed any more or you prefer not to use it for controlling your
network connectivity, remove the applet from your panel.

4.8.2 Mobile Computing
Working on a mobile computer requires a great deal of flexibility in adjusting to
changing network and system environments. SUSE Linux offers small helpers, like
GNOME Battery Charge Monitor, KPowersave, and Profile Chooser, which assist you
in adjusting the power management scheme and the system configuration of your
computer.

TIP: More Information about Mobile Computing

Refer to the Reference manual to learn more about mobile computing under
SUSE Linux. Get an introduction to the software components involved and learn
how to configure your mobile devices for maximum flexibility.

Power Management
Successfully working on battery power requires a very sophisticated handling of the
system resources by the operating system. Mobile hardware is optimized to allow a
very flexible management of power usage by the CPU and other components. Depending
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on the environment in which the system is run, the power management can easily be
adjusted in SUSE Linux using GNOME Battery Charge Monitor or KDE KPowersave.

Battery Charge Monitor allows you to send your machine into a hibernation state
(Suspend Computer) in which the entire system state is written to disk prior to shutdown.
Once reactivated, this state is recovered. Configure the power management settings
with Power Management Settings. The YaST Power Management module is launched
enabling you to configure all power management settings centrally.

Using KPowersave, you can start the YaST Power Management module and issue both
a suspend to disk or a suspend to RAM (if configured accordingly with YaST). You
can change the CPU frequency policy, meaning your system either lets the CPU fre-
quency drop when the system is idle and adjusts it dynamically if more CPU power is
needed (set the CPU frequency policy to Dynamic), permanently keeps a low CPU
frequency to save power (selectPowersave ), or permanently keeps a high CPU frequen-
cy for maximum CPU performance (select Performance). If you change the active
power management scheme (Set Active Scheme), all components of your system are
part of the powersaving effort. A power management scheme includes settings for CPU
frequency scaling, throttling, hard disk control, and system cooling. To start this program
in a GNOME environment, enter kpowersave at the Run Application prompt.

Profile Management
Your system needs to adapt to changing operating environments when used for mobile
computing. A lot of services depend on the environment and the underlying clients
must be reconfigured. Use the system configuration profile management (SCPM)
framework to create different configuration profiles for all environments your machine
is used in. Change the active profile using Profile Chooser. To modify your SCPM
settings, select Select YaST Profile Manager Module and enter the root password
when prompted to do so. Start Profile Chooser in KDE using the main menu. In
GNOME, enter profile_chooser at the Run Application prompt.
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5Getting to Know Linux Software
Linux comes with a wealth of applications, often offering more than one solution to
specific problems. The difficulty is finding the one application that suits your needs
and offers a similar ease of use compared to the Windows or Mac applications you have
been using so far. This chapter points out the most important and powerful Linux appli-
cations, enabling you to change into your new working environment smoothly.

The next few sections introduce some of the most powerful Linux counterparts of
common Windows software. Each section is dedicated to one particular field of appli-
cation and lists the tasks, Windows applications, and Linux equivalents. These applica-
tions are then discussed in further detail and links to more information are provided.
This list is by no means complete, because software development is an evolutionary
process and new applications are being created every minute.

TIP: Missing Applications

In case one of the listed applications is not installed by default on your SUSE
Linux system, use YaST to install the missing packages. Use the search function
of the YaST package management tool to find the package names.

5.1 Office
This section features the most popular and powerful Linux office and business software
solutions. These include office suites, databases, accounting software, and project
management software.
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Table 5.1 Office Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

OpenOffice.org, StarOffice,
KOffice

MS Office, StarOffice,
OpenOffice.org

Office Suite

OpenOffice.org/StarOffice
Writer

MS Word, StarOffice/OpenOf-
fice.org Writer, WordPerfect

Word Processor

OpenOffice.org/StarOffice
Calc, Gnumeric, KSpread

MS Excel, StarOffice/OpenOf-
fice.org Calc

Spreadsheet

OpenOffice.org Impress,
StarOffice Presentation

MS PowerPoint, StarOffice
Presentation, OpenOffice.org
Impress

Presentation

OpenOffice.org Calc, Gnuplot,
Grace (Xmgr), LabPlot

MS Excel, MicroCall OriginData Plotting

OpenOffice.org + MySQL,
Rekall, kexi, Mergeant, Postgre-
SQL

MS Access, OpenOffice.org +
MySQL

Local Database

GnuCash, moneyplexMS Money, Quicken, money-
plex

Financial Account-
ing

Planner, TaskjugglerMS ProjectProject Manage-
ment

VYM (View Your Mind)MindManager, Free MindMind Mapping

OpenOffice.org
OpenOffice.org is the open source equivalent of MS Office. It is a very powerful
office suite including a word processor (Write), a spreadsheet and database manager
(Calc), a presentation manager (Impress), and a drawing program (Draw). Users
familiar with the MS Office family of applications find a very similar application
interface and all the functionality to which they are accustomed. Because OpenOf-
fice.org is capable of importing data from MS Office applications, the transition
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from one office suite to the other is very smooth. A Windows version of OpenOf-
fice.org even exists, enabling Windows users to switch to an open source alternative
while still using Windows. Find more information about OpenOffice.org at
http://www.openoffice.org/ and read Chapter TheOpenOffice.org Office
Suite (↑Reference) for an introduction to OpenOffice.org and a short guide to mi-
grating your data from one office suite to the other.

StarOffice
StarOffice is a proprietary version of OpenOffice.org and is distributed by Sun
Microsystems. It is available on multiple platforms including Windows and Solaris.
It includes certain advanced features not available with the free version (OpenOf-
fice.org). Find more information about StarOffice at http://www.sun.com/
software/star/staroffice/.

KOffice
KOffice is an integrated office suite for the KDE desktop. It comes with various
modules like word processing (KWord), spreadsheets (KSpread), presentation
(KPresenter), several image processing applications (Kivio, Karbon14, Krita), a
database front-end (Kexi), and many more. Find more information about KOffice
at http://www.koffice.org/.

Gnumeric
Gnumeric is a spreadsheet solution for the GNOME desktop environment. Find
more information about Gnumeric at http://www.gnumeric.org.

Gnuplot
Gnuplot is a very powerful and portable command line controlled data plotting
software. It is also available for MacOS and Windows platforms. Plots created by
Gnuplot can be exported to various formats, such as PostScript, PDF, SVG, and
others, allowing you to process these plots easily. Find more information about
Gnuplot at http://www.gnuplot.info/index.html.

Grace
Grace is a very mature 2D plotting tool for almost all flavors of Unix including
Linux. Plot creation and editing can be done via a graphical user interface. Grace
supports an unlimited number of graphs per plot. Its export formats include JPEG,
PNG, SVG, PDF and (E)PS. More information can be found at http://
plasma-gate.weizmann.ac.il/Grace/.
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LabPlot
LabPlot is a program for creating and managing two or three-dimensional data plots.
Graphs can be produced both from data and functions and one plot might include
multiple graphs. It also offers various data analysis methods. More information
about LabPlot can be found at http://labplot.sourceforge.net/.

Rekall
Rekall is a tool for manipulating databases. Supported databases include MySQL,
PostgreSQL, XBase with XBSQL, IBM DB2, and ODBC. Use Rekall to generate
different sorts of reports and forms, design database queries, or import and export
data to various formats. Find more information about Rekall at http://www
.thekompany.com/products/rekall/.

Kexi
Kexi is a database front-end to various different types of databases. It supports
connections to MySQL, PostgreSQL, and SQLite database servers. Kexi can be
used for manipulating data in tables and creating and storing queries. Find more
information about kexi at http://www.koffice.org/kexi/.

Mergeant
Mergeant is a database front-end for the GNOME desktop. Find more information
at http://www.gnome-db.org.

PostgreSQL
PostgreSQL is an object-relational database management system that supports an
extended subset of the SQL standard, including transactions, foreign keys, subqueries,
triggers, and user-defined types and functions. Find more information about Post-
greSQL at http://www.postgresql.org/.

GnuCash
GnuCash is a software tool to control both your personal and business finances.
Keep track of income and expenses and manage your bank accounts and stock
portfolios all using one piece of software. Learn more about GnuCash at http://
www.gnucash.org.

moneyplex
moneyplex is a tool to control your finances. All tasks from managing incoming
resources and expenses and monitoring your stock portfolio to online transactions
via the HBCI standard are handled by moneyplex. Keep track of your financial
transactions over time using various analysis options. Because this tool is also
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available for Windows, users can migrate very easily without having to learn a
whole new application interface. More information about moneyplex can be found
at http://www.matrica.de.

Planner
Planner is a project management tool aiming to provide functionality similar to the
project management tools used under Windows. Among its various features are
Gantt charting abilities, different kinds of views on tasks and resources, and much
more. Find more information about Planner at http://www.imendio.com/
projects/planner/.

Taskjuggler
Taskjuggler is a lean, but very powerful project management software. Take control
of your projects using the Gantt charting features or by generating all kinds of reports
(in XML, HTML, or CSV format). Those users who are not comfortable with con-
trolling applications via the command line can use a graphical front-end to
Taskjuggler. Find more information about Taskjuggler at http://www
.taskjuggler.org.

VYM (View Your Mind)
VYM is a software for visualizing your thoughts by creating and manipulating mind
maps. Most manipulations do not require more than one mouse click. Branches can
be inserted, deleted, and reordered very easily. VYM also offers a set of flags allow-
ing you to mark certain parts of the map (important, time critical, etc.). Links, notes,
and images can be added to a mind map as well. VYM mind maps use an XML
format, allowing you to export your mind maps to HTML easily. Find more infor-
mation about VYM at http://www.insilmaril.de/vym.

5.2 Network
The following section features various Linux applications for networking purposes.
Get to know the most popular Linux browsers and e-mail and chat clients.
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Table 5.2 Network Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

Konqueror, Firefox, Opera,
Epiphany

Internet Explorer, Firefox,
Opera

Web Browser

Evolution, Kontact, Mozilla
Thunderbird

MS Outlook, Lotus Notes,
Mozilla Thunderbird

E-Mail Client/Personal
Information Management

Gaim, Kopete, Konversa-
tion, XChat

MSN, AIM, Yahoo Messen-
ger, XChat, Gaim

Instant Messaging/IRC
Clients

GnomeMeetingNetMeetingConferencing (Video and
Audio)

Linphone, kphone, SkypeX-LiteVoice over IP

gftp, kbearleechftp, wsftpFTP Clients

Konqueror
Konqueror is a multitalented application created by the KDE developers. It acts as
file manager and document viewer, but is also a very powerful and highly customiz-
able Web browser. It supports the current Web standards, such as CSS(2), Java ap-
plets, JavaScript and Netscape plug-ins (Flash and RealVideo), DOM, and SSL. It
offers neat helpers like an integrated search bar and supports tabbed browsing.
Bookmarks can be imported from various other Web browsers, like Internet Explorer,
Mozilla, and Opera. Find more information about Konqueror at http://www
.konqueror.org/ and read our introduction to using Konqueror in Chapter The
Web Browser Konqueror (↑Reference).

Firefox
Firefox is the youngest member of the Mozilla browser family. It runs on various
platforms, including Linux, MacOS, and Windows. Its main features include built-
in customizable searches, pop-up blocking, RSS news feeds, password management,
tabbed browsing, and some advanced security and privacy options. Firefox is very
flexible, allowing you to customize almost anything you want (searches, toolbars,
skins, buttons, etc.). Neat add-ons and extensions can be downloaded from the
Firefox Web site (https://addons.update.mozilla.org/
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?application=firefox). Find more information about Firefox at http://
www.mozilla.org/products/firefox/ and read our introduction to using
Firefox in Chapter Firefox (↑Reference).

Opera
Opera is a powerful Web browser with neat add-ons like an optional e-mail client
and a chat module. Opera offers pop-up blocking, RSS feeds, built-in and customiz-
able searches, a password manager, and tabbed browsing. The main functionalities
are easily reached via their respective panels. Because this tool is also available for
Windows, it allows a much easier transition to Linux for those who have been using
it under Windows. Find more information about Opera at http://www.opera
.com/.

Epiphany
Epiphany is a lean, but powerful Web browser for the GNOME desktop. Many of
its features and extensions will remind you of Firefox. Find more information about
Epiphany at http://www.gnome.org/projects/epiphany/.

Evolution
Evolution is personal information management software for the GNOME desktop
combining mail, calendar, and address book functionality. It offers advanced e-mail
filter and search options, provides sync functionality for Palm devices, and allows
you to run Evolution as an Exchange or GroupWise client to integrate better into
heterogeneous environments. Find more information about Evolution at http://
www.gnome.org/projects/evolution/ and read our introduction to using
Evolution in Chapter Evolution: An E-Mail and Calendar Program (↑Reference).

Kontact
Kontact is the KDE personal information management suite. It includes e-mail,
calendar, address book, and Palm sync functionalities. Like Evolution, it can act as
an Exchange or GroupWise client. Kontact combines several stand-alone KDE ap-
plications (KMail, KAddressbook, KOrganizer, and KPilot) to form an entity pro-
viding all the PIM functionality you need. Find more information about Kontact at
http://www.kontact.org/ and read our introduction to using Kontact in
Chapter Kontact: An E-Mail and Calendar Program (↑Reference).

Mozilla Thunderbird
Thunderbird is an e-mail client application that comes as part of the Mozilla suite.
It is also available for Microsoft Windows and MacOS which facilitates the transition
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from one of these operating systems to Linux. Find more information about Mozilla
Thunderbird at http://www.mozilla.org/products/thunderbird/.

Gaim
Gaim is a smart instant messenger program supporting multiple protocols, such as
AIM and ICQ (Oscar protocol), MSN Messenger, Yahoo!, IRC, Jabber, SILC, and
GroupWise Messenger. It is possible to log in to different accounts on different IM
networks and chat on different channels simultaneously. Gaim also exists in a
Windows version. Find more information about Gaim at http://gaim
.sourceforge.net/about.php.

Kopete
Kopete is a very intuitive and easy-to-use instant messenger tool supporting protocols
including IRC, ICQ, AIM, GroupWise Messenger, Yahoo, MSN, Gadu-Gadu, Lotus
Sametime, SMS messages, and Jabber. Find more information about Kopete at
http://kopete.kde.org/ and read an introduction to using Kopete in Sec-
tion 7.3.9, “Chatting with Friends: Kopete” (page 192).

Konversation
Konversation is an easy-to-use IRC client for KDE. Its features include support for
SSL connections, strikeout, multichannel joins, away and unaway messages, ignore
list functionality, Unicode, autoconnect to a server, optional time stamps in chat
windows, and configurable background colors. Find more information about Kon-
versation at http://konversation.kde.org.

XChat
XChat is an IRC client that runs on most Linux and UNIX platforms as well as under
Windows and MacOS X. Find more information about XChat at http://www
.xchat.org/.

GnomeMeeting
GnomeMeeting is the open source equivalent of Microsoft's NetMeeting. It features
LDAP and ILS support for address lookup and integrates with Evolution to share
the address data stored there. GnomeMeeting supports PC-to-phone calls, allowing
you to call another party with just your computer, sound card, and microphone
without any additional hardware. Find more information about GnomeMeeting at
http://www.gnomemeeting.org/.
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Linphone
Linphone is a smart and lean Voice over IP client using the SIP protocol to establish
calls. Find more information athttp://www.linphone.org and in ChapterLin-
phone—VoIP for the Linux Desktop (↑Reference).

KPhone
KPhone is a program to initiate Voice over IP connections across the Internet. Find
more information at http://www.wirlab.net/kphone.

gftp
gftp is an FTP client using the GTK toolkit. Its features include simultaneous
downloads, resume of interrupted file transfers, file transfer queues, download of
entire directories, FTP proxy support, remote directory caching, passive and nonpas-
sive file transfers, and drag and drop support. Find more information at http://
gftp.seul.org.

kbear
KBear is a KDE FTP client with the ability to have concurrent connections to mul-
tiple hosts, three separate view modes, support for multiple protocols (like ftp, sftp,
etc.), a site manager plug-in, firewall support, logging capabilities, and much more.
Find more information at http://kbear.sourceforge.net.

5.3 Multimedia
The following section introduces the most popular multimedia applications for Linux.
Get to know media players, sound editing solutions, and video editing tools.

Table 5.3 Multimedia Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

KsCD, Grip, BansheeCD Player, Winamp, Windows
Media Player

Audio CD Player

K3bNero, Roxio Easy CD CreatorCD Burner

Grip, kaudiocreator, Sound
Juicer, Banshee

WMPlayerCD Ripper
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Linux ApplicationWindows ApplicationTask

amaroK, XMMS, Rhythm-
box, Banshee

Winamp, Windows Media
Player, iTunes

Audio Player

Kaffeine, MPlayer, Xine,
XMMS, Totem

Winamp, Windows Media
Player

Video Player

AudacitySoundForge, Cooledit, Auda-
city

Audio Editor

alsamixer, Kmixsndvol32Sound Mixer

LilyPond, MusE, Noteedit,
Rosegarden

Finale, SmartScore, SibeliusMusic Notation

MainActor, KinoWindows Movie Maker, Adobe
Premiere, Media Studio Pro,
MainActor

Video Creator and
Editor

xawtv (analog), motv (ana-
log), xawtv4, tvtime, kdetv,
zapping, Kaffeine

AVerTV, PowerVCR 3.0,
CinePlayer DVR

TV Viewer

KsCD
KsCD is a neat little CD player application for the KDE desktop. Its user interface
very much resembles that of a normal hardware CD player, guaranteeing ease of
use. KsCD supports CDDB, enabling you to get any track and album information
either from the Internet or your local file system. Find more information at http://
docs.kde.org/en/3.3/kdemultimedia/kscd/.

Grip
Grip provides CD player and ripper functionalities for the GNOME desktop. It
supports CDDB lookups for track and album data. Ripping can be done using the
built-in cdparanoia capabilities or via external rippers. Find more information at
http://www.nostatic.org/grip/.
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Sound Juicer
Sound Juicer is a lean CD ripper application for the GNOME desktop. Find more
information about Sound Juicer at http://www.burtonini.com/blog/
computers/sound-juicer.

Banshee
Banshee is a digital jukebox very similar to iTunes.

K3b
K3b is a multitalented media creation tool. Create data, audio, or video CD and
DVD projects by dragging and dropping. Find more information about K3b at
http://www.k3b.org/ or refer to Chapter K3b—Burning CDs or DVDs
(↑Reference).

Kaffeine
Kaffeine is a versatile multimedia application supporting a wide range of audio and
video formats including Ogg Vorbis, WMV, MOV, and AVI. Import and edit play
lists of various types, create screenshots, and save media streams to your local hard
disk. Find more information about Kaffeine at http://kaffeine
.sourceforge.net/.

Totem
Totem is a movie player application for the GNOME desktop. It supports Shoutcast,
m3u, asx, SMIL, and ra play lists, lets you use keyboard controls, and plays a wide
range of audio and video formats. Find more information about Totem at http://
www.gnome.org/projects/totem/.

amaroK
The amaroK media player handles various audio formats and plays the streaming
audio broadcasts of radio stations on the Internet. The program handles all file types
supported by the sound server acting as a back-end—currently aRts or GStreamer.
Find more information about amaroK at http://amarok.kde.org/ or refer
to Section “amaroK” (Chapter 7, Sound in Linux, ↑Reference).

XMMS
XMMS is the traditional choice for multimedia playback. It is focused on music
playback, offering support for CD playback and Ogg Vorbis files. Users of Winamp
should find XMMS comfortable because of its similarity. Find more information
about XMMS at http://www.xmms.org/ or refer to Section “XMMS”
(Chapter 7, Sound in Linux, ↑Reference).
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Rhythmbox
Rhythmbox is a powerful, multitalented media player for the GNOME desktop. It
allows you to organize and browse your music collection using playlists and even
supports Internet radio. Find more information about Rhythmbox at http://www
.gnome.org/projects/rhythmbox/.

Audacity
Audacity is a powerful, free sound editing tool. Record, edit, and play any Ogg
Vorbis or WAV file. Mix tracks at your whim, apply effects to them, and export
the results to WAV or Ogg Vorbis. Find more information about Audacity at
http://audacity.sourceforge.net/ or refer to Section “Hard Disk
Recording with Audacity” (Chapter 7, Sound in Linux, ↑Reference).

LilyPond
LilyPond is a free music sheet editor. Because the input format is text-based, you
can use any text editor to create note sheets. Users do not need to tackle any format-
ting or notation issues, like spacing, line-breaking, or polyphonic collisions. All
these issues are automatically resolved by LilyPond. It supports many special nota-
tions like chord names and tablatures. The output can be exported to PNG, TeX,
PDF, PostScript, and MIDI. Find more information about LilyPond at http://
lilypond.org/web/.

MusE
MusE's goal is to be a complete multitrack virtual studio for Linux. Find more in-
formation about MusE athttp://www.muse-sequencer.org/index.php.

Noteedit
Noteedit is a powerful score editor for Linux. Use it to create sheets of notes and
to export and import scores to and from many formats, such as MIDI, MusicXML
and LilyPond. Find more information about Noteedit at http://developer
.berlios.de/projects/noteedit/.

Rosegarden
Rosegarden is a free music composition and editing environment. It features an
audio and MIDI sequencer and a score editor. Find more information about
Rosegarden at http://rosegardenmusic.com/.
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MainActor
MainActor is a fully fledged video authoring software. Because there is a Windows
version of MainActor, transition from Windows is easy. Find more information
about MainActor at http://www.mainactor.com/.

xawtv and motv
xawtv is a TV viewer and recorder application supporting analog TV. motv is basi-
cally the same as xawtv, but with a slightly different user interface. Find more infor-
mation about the xawtv project at http://linux.bytesex.org/xawtv/.

xawtv4
xawtv4 is a successor of the xawtv application. It supports both analog and digital
audio and video broadcasts. The xawtv4 package contains several useful applications
apart from the TV viewer: pia4 (a command line controlled movie player for streams
recorded by xawtv4), mtt4 (a video text browser), alexplore (a DVB channel scanner;
built-in), dvbradio (a DVB radio player; needs an initial channel scan), and dvbrowse
(an EPG browser). For more information, refer to http://linux.bytesex
.org/xawtv/.

tvtime
tvtime is a lean TV viewer application supporting analog TV. Find more information
about tvtime, including a comprehensive usage guide, at http://tvtime
.sourceforge.net/.

kdetv
A TV viewer and recorder application for the KDE desktop supporting analog TV.
Find more information about kdetv at http://www.kdetv.org/.

zapping
A TV viewer and recorder application for the GNOME desktop supporting analog
TV. Find more information about Zapping athttp://zapping.sourceforge
.net/cgi-bin/view/Main/WebHome.

5.4 Graphics
The following section presents some of the Linux software solutions for graphics work.
These include simple drawing applications as well as fully-fledged image editing tools
and powerful rendering and animation programs.
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Table 5.4 Graphics Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

The GIMP, KritaMS PaintSimple Graphic Edit-
ing

The GIMP, KritaAdobe Photoshop, Paint Shop
Pro, Corel PhotoPaint, The
GIMP

Professional Graphic
Editing

OpenOffice.org Draw,
Inkscape, Dia

Adobe Illustrator, CorelDraw,
OpenOffice.org Draw, Free-
hand

Creating Vector
Graphics

Inkscape, Dia, Karbon14,
Kivio

WebDraw, Freehand, Adobe
Illustrator

SVG Editing

POV-Ray, Blender, KPov-
modeler

3D Studio MAX, Maya, POV-
Ray, Blender

Creating 3D Graphics

Digikam, F-SpotSoftware provided by the
camera manufacturer

Managing Digital Pho-
tographs

Vuescan, Kooka, The
GIMP

VuescanScanning

gwenview, gThumb, Eye
of Gnome

ACDSeeImage Viewing

The GIMP
The GIMP is the open source alternative to Adobe Photoshop. Its feature list rivals
that of Photoshop, so it is well suited for professional image manipulation. There
is even a Windows version of GIMP available. Find more information at http://
www.gimp.org/ or refer to Chapter Manipulating Graphics with The GIMP
(↑Reference).

Krita
Krita is KOffice's answer to Adobe Photoshop and The GIMP. It can be used for
pixel-based image creation and editing. Its features include many of the advanced
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image editing capabilities you would normally expect with either Adobe Photoshop
or The GIMP. Find more information at http://www.koffice.org/krita.

Dia
Dia is a Linux application aiming to be the Linux equivalent of Visio. It supports
many types of special diagrams, such as network or UML charts. Export formats
include SVG, PNG, and EPS. To support your own custom-made diagram types,
provide the new shapes in a special XML format. Find more information about Dia
at http://www.gnome.org/projects/dia/.

Inkscape
Inkscape is a free SVG editor. Users of Adobe Illustrator, Corel Draw, and Visio
can find a similar range of features and a familiar user interface in Inkscape. Among
its features, find SVG-to-PNG export, layering, transforms, gradients, grouping of
objects, and more. Find more information about Inkscape at http://www
.inkscape.org/.

Karbon14
Karbon14 is a vector graphics application that integrates into KOffice. Find more
information at http://www.koffice.org/karbon/.

Kivio
Kivio is a flow-charting application that integrates into the KOffice suite. Former
users of Visio will find a familiar look and feel in Kivio. Find more information
about Kivio at http://www.koffice.org/kivio/.

POV-Ray
The Persistence of Vision Raytracer creates three-dimensional, photo-realistic images
using a rendering technique called ray tracing. Because there is a Windows version
of POV-Ray, it does not take much for Windows users to switch to the Linux version
of this application. Find more information about POV-Ray at http://www
.povray.org/.

Blender
Blender is a powerful rendering and animation tool available on many platforms,
including Windows, MacOS, and Linux. Find more information about Blender at
http://www.blender3d.com/.
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KPovmodeler
KPovmodeler is a POV-Ray front-end that integrates with the KDE desktop.
KPovmodeler saves users from needing a detailed knowledge of POV-Ray scripting
by translating the POV-Ray language in an easy to understand tree view. Native
POV-Ray scripts can be imported to KPovmodeler as well. Find more information
at http://www.kpovmodeler.org.

Digikam
Digikam is a smart digital photo management tool for the KDE desktop. Importing
and organizing your digital images is a matter of a few clicks. Create albums, add
tags to spare you from copying images around different subdirectories, and eventu-
ally export your images to your own Web site. Find more information about Digikam
at http://digikam.sourceforge.net/Digikam-SPIP/ and in Sec-
tion “Using Digikam” (Chapter 15, Digital Cameras and Linux, ↑Reference).

f-spot
f-spot is a flexible digital photographs management tool for the GNOME desktop.
It lets you create and manage albums, supports various export options like HTML
pages or burning of image archives to CD. Find more information about f-spot at
http://www.gnome.org/projects/f-spot/ and in Section “Using f-
spot” (Chapter 15, Digital Cameras and Linux, ↑Reference).

Kooka
Kooka is a scan and OCR (text recognition) suite for the KDE desktop. It allows
you to configure the main scan parameters, choose from various export formats,
and organize the scanned data. The OCR module provided by the Kooka package
adds some basic text recognition features. Find more information about Kooka at
http://www.kde.org/apps/kooka/ or refer to ChapterKooka—AScanning
Application (↑Reference).

Gwenview
Gwenview is a simple image viewer for KDE. It features a folder tree window and
a file list window that provides easy navigation of your file hierarchy. Find more
information at http://gwenview.sourceforge.net/home/.

gThumb
gThumb is an image viewer, browser, and organizer for the GNOME desktop. It
supports the import of your digital images via gphoto2, allows you to carry out basic
transformation and modifications, and lets you tag your images to create albums
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matching certain categories. Find more information about gThumb at http://
gthumb.sourceforge.net/.

Eye of Gnome (eog)
Eye of Gnome is an image viewer application that is part of the GNOME Office
suite. Find more information at http://www.gnome.org/gnome-office/
eog.shtml.

5.5 System and File Management
The following section provides an overview of Linux tools for system and file manage-
ment. Get to know text and source code editors, backup solutions, and archiving tools.

Table 5.5 System and File Management Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

kate, gedit, (X)Emacs, vimNotePad, WordPad,
(X)Emacs

Text Editor

ScribusAdobe DistillerPDF Creator

Adobe Reader, Evince,
KPDF, Xpdf

Adobe ReaderPDF Viewer

GOCRRecognita, FineReaderText Recognition

zip, tar, gzip, bzip2, etc.zip, rar, arj, lha, etc.Command Line Pack
Programs

Ark, File RollerWinZipGUI Based Pack Pro-
grams

YaST, GNU PartedPowerQuest, Acronis, Parti-
tion Commander

Hard Disk Partitioner

dar, taper, dumpntbackup, VeritasBackup Software

Getting to Know Linux Software 153

http://gthumb.sourceforge.net/
http://gthumb.sourceforge.net/
http://www.gnome.org/gnome-office/eog.shtml
http://www.gnome.org/gnome-office/eog.shtml


kate
Kate is part of the KDE suite. It has the ability to open several files at once either
locally or remotely. With syntax highlighting, project file creation, and external
scripts execution, it is a perfect tool for a programmer. Find more information at
http://kate.kde.org/.

gedit
GEdit is the official text editor of the GNOME desktop. It provides similar features
to Kate. Find more information at http://www.gnome.org/projects/
gedit/.

(X)Emacs
GNU Emacs and XEmacs are very professional editors. XEmacs is based on GNU
Emacs. To quote the GNU Emacs Manual, “Emacs is the extensible, customizable,
self-documenting real-time display editor.” Both offer nearly the same functionality
with minor differences. Used by experienced developers, they are highly extensible
through the Emacs Lisp language. They support many languages, like Russian,
Greek, Japanese, Chinese, and Korean. Find more information at http://www
.xemacs.org/ and http://www.gnu.org/software/emacs/emacs
.html.

vim
vim (vi improved) is a program similar to the text editor vi. Users may need time
to adjust to vim, because it distinguishes between command mode and insert mode.
The basic features are the same as in all text editors. vim offers some unique options,
like macro recording, file format detection and conversion, and multiple buffers in
a screen. Find more information at http://www.vim.org/ or in Reference.

GOCR
GOCR is an OCR (optical character recognition) tool. It converts scanned images
of text into text files. It is also part of Kooka, a KDE scanning tool. Find more in-
formation at http://jocr.sourceforge.net/ and in Chapter Kooka—A
Scanning Application (↑Reference).

Adobe Reader
Adobe Reader for Linux is the exact counterpart of the Windows and Mac versions
of this application. The look and feel on Linux are the same as on other platforms.
The other parts of the Adobe Acrobat suite have not been ported to Linux. Find
more information at http://www.adobe.com/products/acrobat/
readermain.html.
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Evince
Evince is a document viewer for PDF and PostScript formats for the GNOME
desktop. Find more information at http://www.gnome.org/projects/
evince/.

KPDF
KPDF is a PDF viewing application for the KDE desktop. Its features include
searching the PDF and full screen reading mode like in Adobe Reader. Find more
information at http://kpdf.kde.org/.

Xpdf
Xpdf is lean PDF viewing suite for Linux and Unix platforms. It includes a viewer
application and some export plug-ins for PostScript or text formats. Find more in-
formation at http://www.foolabs.com/xpdf/.

gzip, tar, bzip2
There are plenty of packaging programs for reducing disk usage. In general, they
differ only in their pack algorithm. Linux can also handle the packaging formats
used on Windows. Find more information about gzip and tar in Section “File
Administration” (Chapter 27, Working with the Shell, ↑Reference). bzip2 is a bit
more efficient than gzip, but needs more time, depending on the pack algorithm.

GNU Parted
GNU Parted is a command-line tool for creating, destroying, resizing, checking,
and copying partitions and the file systems on them. If you need to create space for
new operating systems, use this tool to reorganize disk usage and copy data between
different hard disks. Find more information at http://www.gnu.org/
software/parted/.

KDar
KDar stands for KDE disk archiver and is a hardware-independent backup solution.
KDar uses catalogs (unlike tar), so it is possible to extract a single file without
having to read the whole archive and it is also possible to create incremental backups.
KDar can split an archive into multiple slices and trigger the burning of a data CD
or DVD for each slice. Find more information about KDar at http://kdar
.sourceforge.net/.

taper
Taper is a backup and restore program that provides a friendly user interface to allow
backup and restoration of files to and from a tape drive. Alternatively, files can be
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backed up to archive files. Recursively selected directories are supported. Find more
information at http://taper.sourceforge.net/.

dump
The dump package contains both dump and restore. dump examines files in a file
system, determines which ones need to be backed up, and copies those files to a
specified disk, tape, or other storage medium. The restore command performs the
inverse function of dump—it can restore a full backup of a file system. Find more
information at http://dump.sourceforge.net/.

5.6 Software Development
This section introduces Linux IDEs, toolkits, development tools, and versioning systems
for professional software development.

Table 5.6 Development Software for Windows and Linux

Linux ApplicationWindows ApplicationTask

KDevelop, Eric, Eclipse,
MonoDevelop, Anjuta

Borland C++, Delphi, Visual
Studio, .NET

Integrated Development
Environments

Qt, GTKMFC, Qt, GTKToolkits

GCCVisualStudioCompilers

GDB, valgrindVisual StudioDebugging Tools

Glade, Qt DesignerVisual Basic, Visual C++GUI Design

CVS, SubversionClearcase, Perforce, Source-
Safe

Versioning Systems

KDevelop
KDevelop allows you to write programs for different languages (C/C++, Python,
Perl, etc.). It includes a documentation browser, a source code editor with syntax
highlighting, a GUI for the compiler, and much more. Find more information at
http://www.kdevelop.org.
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Eclipse
The Eclipse Platform is designed for building integrated development environments
that can be extended with custom plug-ins. The base distribution also contains a
full-featured Java development environment. Find more information at http://
www.eclipse.org.

MonoDevelop
The Mono Project is an open development initiative that is working to develop an
open source Unix version of the .NET development platform. Its objective is to
enable Unix developers to build and deploy cross-platform .NET applications.
MonoDevelop complements the Mono development with an IDE. Find more infor-
mation about MonoDevelop at http://www.monodevelop.com/.

Anjuta
Anjuta is an IDE for GNOME/GTK application development. It includes an editor
with automated formatting, code completion and highlighting. Apart from GTK it
supports Perl, Pascal, and Java development. A GDB based debugger is also included.
Find more information about Anjuta at http://anjuta.sourceforge.net.

Eric
Eric is an IDE optimized for Python and Python-Qt development. Find more infor-
mation about Eric at http://www.die-offenbachs.de/detlev/eric3
.html.

Qt
Qt is a program library for developing applications with graphical user interfaces.
It allows you to develop professional programs rapidly. The Qt library is available
not only for Linux, but for a number of Unixes and even for Windows and Macintosh.
Thus it is possible to write programs that can be easily ported to those platforms.
Find more information at http://www.trolltech.com. Language bindings
for Qt development are summarized under http://developer.kde.org/
language-bindings/.

GTK
GTK is a multiplatform toolkit for creating graphical user interfaces. It is used for
all GNOME applications, The GIMP, and several others. GTK has been designed
to support a range of languages, not only C/C++. Originally it was written for GIMP,
hence the name “GIMP Toolkit.” Find more information at http://www.gtk
.org. Language bindings for GTK are summarized under http://www.gtk
.org/bindings.html.
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GCC
GCC is a compiler collection with front-ends for various programming languages.
Check out a complete list of features and find extensive documentation at http://
gcc.gnu.org.

GDB
GDB is a debugging tool for programs written in various programming languages.
Find more information about GDB at http://www.gnu.org/software/
gdb/gdb.html.

Valgrind
Valgrind is a suite of programs for debugging and profiling x86 applications. Find
more information about Valgrind at http://valgrind.org/info/.

Glade
Glade is a user interface builder for GTK and GNOME development. As well as
GTK support, it offers support for C, C++, C#, Perl, Python, Java, and others. Find
more information about Glade at http://glade.gnome.org/.

Qt Designer
Qt Designer is a user interface and form builder for Qt and KDE development. It
can be run as part of the KDevelop IDE or in stand-alone mode. QtDesigner can be
run under Windows and even integrates into the Visual Studio development suite.
Find more information about Qt Designer at http://www.trolltech.com/
products/qt/designer.html.

CVS
CVS, the Concurrent Versions System, is one of the most important version control
systems for open source. It is a front-end to the Revision Control System (RCS)
included in the standard Linux distributions. Read more about CVS in Reference.
Find more information at the home page http://www.cvshome.org/.

Subversion
Subversion does the same thing CVS does but has major enhancements, like moving,
renaming, and attaching meta information to files and directories. Read more about
Subversion inReference or go to the home pagehttp://subversion.tigris
.org/.
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6Help and Documentation
SUSE Linux comes with various sources of information and documentation. The SUSE
Help Center provides central access to the most important documentation resources on
your system in searchable form. These resources include online help for installed appli-
cations, manual pages, info pages, databases on hardware and software topics, and all
manuals delivered with your product.

6.1 Using the SUSE Help Center
When you start the SUSE Help Center for the first time from the main menu (SuSE
Help Center) or with the command susehelp in the shell, a window as shown in
Figure 6.1, “The Main Window of the SUSE Help Center” (page 160) is displayed. The
dialog window consists of three main areas:

Menu Bar and Toolbar
The menu bar provides the main editing, navigation, and configuration options.File
contains the option for printing the currently displayed content. Under Edit, access
the search function.Go contains all navigation possibilities: Table of Contents (home
page of the Help Center), Back, Forward, and Last Search Result. With Settings→
Build Search Index, generate a search index for all selected information sources.
The toolbar contains three navigation icons (forward, back, home) and a printer
icon for printing the current contents.

Navigation Area with Tabs
The navigation area in the left part of the window provides an input field for a quick
search in selected information sources. Details regarding the search and the confi-
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guration of the search function in the Search tab are presented in Section 6.1.2, “The
Search Function” (page 161). The Contents tab presents a tree view of all available
and currently installed information sources. Click the book icons to open and browse
the individual categories.

View Window
The view window always displays the currently selected contents, such as online
manuals, search results, or Web pages.

Figure 6.1 The Main Window of the SUSE Help Center

6.1.1 Contents
The SUSE Help Center provides access to useful information from various sources. It
contains special documentation for SUSE Linux (Start-Up andReference), all available
information sources for your workstation environment, online help for the installed
programs, and help texts for other applications. Furthermore, the SUSE Help Center
provides access to SUSE's online databases that cover special hardware and software
issues for SUSE Linux. All these sources can be searched comfortably once a search
index has been generated.
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6.1.2 The Search Function
To search all installed information sources of SUSE Linux, generate a search index and
set a number of search parameters. To do this, open the Search tab. See Figure 6.2,
“Configuring the Search Function” (page 161).

Figure 6.2 Configuring the Search Function

If no search index has been generated, the system automatically prompts you to do so
when you click the Search tab or enter a search string then click Search. In the window
for generating the search index, shown in Figure 6.3, “Generating a Search Index”
(page 162), use the check boxes to determine the information sources to index. The index
is generated when you exit the dialog with Build Index.
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Figure 6.3 Generating a Search Index

To limit the search base and the hit list as precisely as possible, use the three drop-down
menus to determine the number of displayed hits and the selection area of sources to
search. The following options are available for determining the selection area:

Default
A predefined selection of sources is searched.

All
All sources are searched.

None
No sources selected for the search.

Custom
Determine the sources to search by activating the respective check boxes in the
overview.

When you have completed the search configuration, click Search. The relevant items
are then displayed in the view window and can easily be navigated with mouse clicks.
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6.2 Man Pages
Man pages are an essential part of any Linux system. They explain the usage of a
command and all available options and parameters. Man pages are sorted in categories
as shown in Table 6.1, “Man Pages—Categories and Descriptions” (page 163) (taken
from the man page for man itself).

Table 6.1 Man Pages—Categories and Descriptions

DescriptionNumber

Executable programs or shell commands1

System calls (functions provided by the kernel)2

Library calls (functions within program libraries)3

Special files (usually found in /dev)4

File formats and conventions (/etc/fstab)5

Games6

Miscellaneous (including macro packages and conventions), e.g.,
man(7), groff(7)

7

System administration commands (usually only for root)8

Kernel routines (nonstandard)9

Generally, man pages are delivered with the associated command. They can be browsed
in the help center or directly in a shell. To display a man page in a shell, use the man
command. For example, to display the man page for ls enter man ls. Each man page
consists of several parts labeled NAME, SYNOPSIS, DESCRIPTION, SEE ALSO, LI-
CENSING, and AUTHOR. There may be additional sections available depending on
the type of command. With Q , exit the man page viewer.
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Another possibility to display a man page is to use Konqueror. Start Konqueror and
type, for example,man:/ls. If there are different categories for a command, Konqueror
displays them as links.

6.3 Info Pages
Info pages are another important source of information on your system. Usually they
are more verbose than man pages. You can browse an info page with an info viewer
and display the different sections, called “nodes.” Use the command info for this task.
For example, to view the info page of info itself, type info info in the shell.

For more convenience, use the Help Center or Konqueror. Start Konqueror and type
info:/ to view the top level. To display the info page for grep, type info:/grep.

6.4 The Linux Documentation Project
The Linux Documentation Project (TLDP) is run by a team of volunteers who write
Linux and Linux-related documentation (see http://www.tldp.org). The set of
documents contains tutorials for beginners, but is mainly focused on experienced users
and professional system administrators. TLDP publishes HOWTOs, FAQs, and guides
(handbooks) under a free license.

6.4.1 HOWTOs
HOWTOs are usually a short, informal, step-by-step guide to accomplishing a specific
task. It is written by experts for nonexperts in a procedural manner. For example, how
to configure a DHCP server. HOWTOs can be found in the package howto and are
installed under /usr/share/doc/howto

6.4.2 Frequently Asked Questions
FAQs (frequently asked questions) are a series of questions and answers. They originate
from Usenet newsgroups where the purpose was to reduce continuous reposting of the
same basic questions.
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6.5 Wikipedia: the Free Online
Encyclopedia

Wikipedia is “a multilingual encyclopedia designed to be read and edited by anyone”
(see http://en.wikipedia.org). The content of Wikipedia is created by its
users and is published under a free license (GFDL). Any visitors can edit articles, which
gives the danger of vandalism, but this does not repel visitors. With over four hundred
thousand articles, find an answer for nearly every topic.

6.6 Guides and Books
A broad range of guides and books are available for Linux topics.

6.6.1 SUSE Books
SUSE provides detailed and informative books. We provide HTML and PDF versions
of our books in different languages. The PDF file is available on DVD in the directory
docu. For HTML, install the package suselinux-manual_LANG (replace LANG
with your preferred language.) After the installation you find them in the SUSE Help
Center.

6.6.2 Other Manuals
The SUSE help center offers additional manuals and guides for various topics or pro-
grams. More can be found athttp://www.tldp.org/guides.html. They range
from Bash Guide for Beginners to Linux FilesystemHierarchy to Linux Administrator's
Security Guide. Generally, guides are more detailed and exhaustive than a HOWTO or
FAQ. They are usually written by experts for experts. Some of these books are old but
still valid. Install books and guides with YaST.
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6.7 Package Documentation
If you install a package in your system, a directory /usr/share/doc/packages/
packagename is created. You can find files from the package maintainer as well as
additional information from SUSE. Sometimes there are also examples, configuration
files, additional scripts, etc., available. Usually you can find the following files, but
they are not standard and sometimes not all files are available.

AUTHORS
This file contains the list of the main developers of this package and usually their
tasks.

BUGS
Lists known bugs or malfunctions of this package. Usually it also contains a link
to a Bugzilla Web page where you can search all bugs.

CHANGES, ChangeLog
Summary of changes from version to version. Usually interesting for developers,
because it is very detailed.

COPYING, LICENSE
Contains licensing information

FAQ
This file contains question and answers collected from mailing lists or newsgroups.

INSTALL
This file contains procedures for installing this package in your system. Normally
you do not need it, because you have the package installed already.

README, README.*
General information about how to use it, what you can do with this package, etc.

TODO
Things that are not implemented yet, but probably will be in the future.

MANIFEST
List of files with a brief summary.
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NEWS
Describes what is new in this version

6.8 Usenet
Created in 1979 before the rise of the Internet, Usenet is one of the oldest computer
networks and still in active use. The format and transmission of Usenet articles is very
similar to e-mail, but is developed for a many-to-many communication.

Usenet is organized into seven topical categories: comp.* for computer-related discus-
sions, misc.* for miscellaneous topics, news.* for newsgroup-related matters,
rec.* for recreation and entertainment,sci.* for science-related discussions,soc.*
for social discussions, and talk.* for various controversial topics. The top levels are
split in subgroups. For instance, comp.os.linux.hardware is a newsgroup for
Linux-specific hardware issues.

Before you can post an article, have your client connect to a news server and subscribe
to a specific newsgroup. News clients include Knode or Evolution. Each news server
communicates to other news servers and exchanges articles with them. Not all news-
groups may be available on your news server.

Interesting newsgroups for Linux users are comp.os.linux.apps,
comp.os.linux.questions, andcomp.os.linux.hardware. If you cannot
find a specific newsgroup, go tohttp://www.linux.org/docs/usenetlinux
.html. Follow the general Usenet rules available online at http://www.faqs
.org/faqs/usenet/posting-rules/part1/.

6.9 Standards and Specifications
There are various sources that provide information about standards or specifications.

www.linuxbase.org
The Free Standards Group is an independent nonprofit organization that promotes
the distribution of free software and open source software. The organization endeav-
ors to achieve this by defining distribution-independent standards. The maintenance
of several standards, such as the important LSB (Linux Standard Base), is supervised
by this organization.
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http://www.w3.org
The World Wide Web Consortium (W3C) is certainly one of the best-known stan-
dards organizations. It was founded in October 1994 by Tim Berners-Lee and con-
centrates on standardizing Web technologies. W3C promotes the dissemination of
open, license-free, and manufacturer-independent specifications, such as HTML,
XHTML, and XML. These Web standards are developed in a four-stage process in
working groups and are presented to the public as W3C recommendations (REC).

http://www.oasis-open.org
OASIS (Organization for the Advancement of Structured Information Standards)
is an international consortium specializing in the development of standards for Web
security, e-business, business transactions, logistics, and interoperability between
various markets.

http://www.ietf.org
The Internet Engineering Task Force (IETF) is an internationally active cooperative
of researchers, network designers, suppliers, and users. It concentrates on the devel-
opment of Internet architecture and the smooth operation of the Internet by means
of protocols.

Every IETF standard is published as an RFC (Request for Comments) and is available
free-of-charge. There are six types of RFC: proposed standards, draft standards,
Internet standards, experimental protocols, information documents, and historic
standards. Only the first three (proposed, draft, and full) are IETF standards in the
narrower sense (see http://www.ietf.org/rfc/rfc1796.txt).

http://www.ieee.org
The Institute of Electrical and Electronics Engineers (IEEE) is an organization that
draws up standards in the areas of information technology, telecommunication,
medicine and health care, transport, and others. IEEE standards are subject to a fee.

http://www.iso.org
The ISO Committee (International Organization for Standards) is the world's largest
developer of standards and maintains a network of national standardization institutes
in over 140 countries. ISO standards are subject to a fee.

http://www.din.de, http://www.din.com
The Deutsches Institut für Normung (DIN) is a registered technical and scientific
association. It was founded in 1917. According to DIN, the organization is “the in-
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stitution responsible for standards in Germany and represents German interests in
worldwide and European standards organizations.”

The association brings together manufacturers, consumers, trade professionals,
service companies, scientists and others who have an interest in the establishment
of standards. The standards are subject to a fee and can be ordered using the DIN
home page.
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Part III Desktop





7The KDE Desktop
The KDE desktop offers an intuitive graphical interface. The following sections show
you how to make efficient use of KDE's features and how to customize the desktop to
meet your personal needs. This is followed by an introduction to the file manager
Konqueror and a brief description of some small but useful utilities.

7.1 Desktop Components
The main components are the icons on the desktop and the panel at the bottom of the
screen. The mouse is your most important tool. Click a symbol or an icon once to start
the associated program or the file manager Konqueror. When you right-click icons,
different menus appear, depending on the program. As well as the icons, there are two
desktop menus.

7.1.1 The Desktop Menus
If you middle-click the desktop (if your mouse only has two buttons, press both buttons
at the same time), a window and desktop management menu is displayed. The menu
lists the various desktops and the windows opened in them. It also offers the following
items:

Unclutter Windows
If you have several windows on your desktop, they are placed next to each other
and aligned with the top left corner.
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Cascade Windows
Starting from the top left corner, the windows on the desktop are placed on top of
each other in such a way that only the top and left borders of the lower windows
are visible.

Desktop x
Desktop 1 is your default desktop. This part of the menu lists all the windows cur-
rently opened. You can bring them to the foreground by clicking one of the respective
items.

Additional Desktops
You can use the additional (virtual) desktops provided and switch to them with the
menu or the panel. All functions are available on all desktops. This limits the number
of programs and associated windows that need to be arranged on one desktop. These
virtual desktops resemble additional desks in your office.

If you right-click the desktop, a more complex menu is displayed, allowing you to
customize your desktop.

Create New
Use this menu item to create new directories, files, or devices on the desktop. A list
of possible elements is provided for selection in a submenu.

Bookmarks
The bookmark editor allows you to create, group, change, or delete bookmarks. The
bookmarks are used by the browser and file manager Konqueror. The bookmark
editor can also import bookmarks from other browsers, such as Mozilla, Netscape,
Opera, and Internet Explorer.

Run Command
This menu item opens a window in which to enter a command manually. Execute
the command by pressing Enter .

Undo
Use this item to undo the last action. For example, if you have just created a new
directory on the desktop, clicking this item reverts the creation so the directory
disappears.

Paste
To keep a folder or document handy on the desktop, you can copy an icon from the
file manager by right-clicking and selecting Copy then moving the mouse to the
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desired location on the desktop. Right-click again and select Paste. The icon is now
available on your desktop and can be moved around by dragging it with the left
mouse button pressed.

Icons
This allows you to rearrange the icons on the desktop. You can also change the order
of the icons.

Windows
This arranges the windows on the desktop, either on top of each other beginning
from the top left corner or next to each other.

Refresh Desktop
If the desktop appears garbled in some way, use this menu item to redraw it.

Configure Desktop
This menu item starts a configuration dialog with which to configure the appearance
and behavior of the desktop.

Start New Session
This menu opens a dialog box asking if you want to start a new user environment.
After clicking Start New Session, the current session disappears into the background
and the system switches to a new login screen. Each session has a function key as-
signed to it: F7 represents the first session, F8 the second one, and so on. To switch
between different sessions, press Ctrl + Alt + Fx , where Fx is the function key
corresponding to the desired session.

Lock Screen
If you leave your workstation and do not log out, you should use this function to
prevent others from gaining access to your files. Depending on the setting, the screen
turns blank or starts displaying a screensaver. To continue using the computer, enter
your password.

Logout
Log out of your system if you are not going to use the system for some time.

7.1.2 The Main Menu
Open the main menu by clicking the icon to the far left of the panel. Alternatively, press
Alt + F1 . The main menu is subdivided into these sections: Most Used Applications,
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All Applications (a menu with all applications sorted according to categories), and Ac-
tions. The following section provides information about a number of actions that can
be triggered from the main menu.

Bookmarks
By selecting Edit Bookmarks from this menu, start an editor in which to organize
your bookmarks. If you select one of the bookmarks present in the menu, the Kon-
queror browser starts and loads the corresponding URL.

Run Command
This item opens a dialog in which to enter a command. You can use it to start an
application whose command you know without navigating through the program
submenus.

Switch User
To start a second session with a graphical user interface on your machine, select
Start New Session from the main menu. Your current session remains active while
you are taken to the login screen. Log in. You can also start another window man-
ager. Access the first session by pressing Ctrl + Alt + F7 . Press F8 instead of F7
to access the new session. Additional sessions can be accessed by pressing Ctrl +
Alt + F9 to F12 .

Lock Session
If you leave your workstation, you can blank your screen or start a screensaver.
Access to the session can only be regained with a password. To unlock, enter your
normal login password. Locking the screen ensures that others cannot read or ma-
nipulate your documents or e-mail messages.

Log Out
You can log out from the system by means of this menu item. However, first you
are asked what should happen after the logout. If you select Login as different user,
the login screen is displayed, allowing you or another user to log in to the system.
You can also shut down and turn off the computer or shut it down and reboot imme-
diately. Confirm your selection with OK or remain logged in by clicking Cancel.

7.2 Konqueror as a File Manager
Konqueror is a unified Web browser, file manager, document viewer, and image
viewer. This section covers the use of Konqueror for file management. If you are inter-

176



ested in Konqueror as a Web browser, see Chapter The Web Browser Konqueror
(↑Reference).

Start Konqueror by clicking the house icon in the panel or by pressing Alt + F2 and
enteringkonqueror $HOME. The contents of your home directory are then displayed.
The file manager window consists of the menu bar at the top, the toolbar, and the location
bar. The lower part of the window is split vertically into the navigation panel and the
main window, which displays the contents.

Figure 7.1 The File Manager Konqueror

7.2.1 File Preview
Konqueror can show you a preview of certain files. Normally this is switched on if you
browse in a directory. It only works if your icon view is activated (look into View →
View Mode). The preview function can simplify your daily work. In big directories, it
gives a rough overview of what is inside the files. Sometimes this is not useful, for ex-
ample, for packed files. But if you point to the respective file, Konqueror opens a tool
tip with additional information, like name, owner, and size.
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You can change which files have a preview. Go to Settings → Configure Konqueror
and open the section Previews &Meta-Data. Konqueror differentiates between Internet
and local protocols. Each protocol can be activated. Approve with Ok.

7.2.2 File Associations
A modern desktop system should know how to handle its file types. With Konqueror,
decide which application can be used to process a file. Go to Settings → Configure
Konqueror and open the section File Associations. If you are searching for an extension,
use Find filename pattern. Only file types with a matching file pattern appear in the
list.

For example, to modify the application for MP3 files, enter mp3 and see an entry
x-mp3. After a click, the setting dialog opens on the right side for this file type. You
can change the icon, the filename patterns, a description, and the order of the applica-
tions. If your tool is not listed, press Add and enter its command. Sometimes the order
of the list entries is inappropriate. To change it, click the program to move then give it
a higher or lower priority with Move Up or Move Down. The application listed at the
top is used by default if you click a file of this type.

Sometimes you need a file type that is not in the list. With Add, open a dialog box in
which to select a group and enter a type name. The group determines the main type,
for example, audio, image, text, or video. Usually your file type can be assigned to one
of those. In Type name, name your file type. After clickingOk, determine the extensions
of the filename. Put a description in the text field and decide which application to use.
Approve with Ok.

7.2.3 The Konqueror Menu
Location

Using Location, open additional Konqueror windows. If you click New Window,
your home directory is displayed in a new window. Duplicate Window produces a
second window with the same content. You can also send a file or a link (using the
browser function) by e-mail. If you click one of these menu items, the KMail com-
poser opens. Specify the recipient and compose a text. Depending on the selected
item, the file is already attached or the link is displayed in the e-mail body. You can
also print directly from this menu.
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Edit
Most items underEdit only become active if you select an object in the main window.
Apart from the standard editing functions, like cutting, copying, pasting, renaming,
moving to the trash, and deleting, there is also the Create New item, which can be
used to create directories, files, and devices. Another item in the Editmenu lets you
view and change the properties of files and directories and their permissions. With
it, grant or deny the owner, a group, or all users read, write, and execute permissions.
In the main window, select one or several files by moving the mouse pointer over
them while keeping the left mouse button pressed or using Selection → Select.

View
Use the View menu to change views. If a directory has many objects in it, the text
view or the tree view may be more efficient. To view HTML pages, activate Use
index.html. If a directory contains a file with this name, Konqueror loads and displays
it.

To influence the way in which the main window displays directory contents, use
the items Icon Size, ShowHidden Files, Sort, and Preview. In addition, useConfigure
Background to set the main window's background to a certain color or use an image
for it.

Go
The Go menu contains the navigation functions Up, Back, Forward, and Home
Page. However, the same functions can be accessed more quickly and conveniently
through the toolbar. You can also call applications from this menu and open all
folders that have an icon on the desktop. In the lower part of the menu, find a list
of the recently-viewed directories or links.

Bookmarks
Bookmarks can be made for Internet addresses (URLs) and paths to specific files
or directories on your host. If you select Add Bookmark, the current content of the
location bar is saved as a bookmark. To access this location, simply click this
bookmark. For practical reasons, arrange bookmarks in folders. The SUSE folder
already exists. This folder contains bookmarks of important SUSE Web pages. Edit
Bookmarks opens the bookmark editor in which to perform tasks like deleting obso-
lete bookmarks, renaming bookmarks, and moving bookmarks from one folder to
another.
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Tools
This menu includes entries for a variety of items, such as Run Command, Open
Terminal Window, and Find Files. You can use View Filter to limit the view to
certain types of files. For example, one of your directories may hold graphics files
of different formats, but you only want to see those in PNG format. You could then
use this submenu item to hide all files that are not in PNG format.

Selecting Create Image Gallery causes Konqueror to search the directory for any
image files. The program then creates thumbnail pictures of them and combines
these into an HTML page. A dialog box prompts you to set the options for the
HTML page, such as the font and the number of thumbnails per line.

Settings
Use the Settings menu to configure the look and feel of Konqueror. If you do not
want a menu, selectHideMenubar. Press Ctrl + M to display it again. The Toolbars
submenu allows you to hide or display other elements of the file manager.

View profiles can be used to change the view according to predefined usage patterns.
To switch between the available profiles, select Load View Profile. One of the pro-
files is the Web browser profile, which is used automatically when you click the
Konqueror icon in the panel. Add your own profiles by selecting Configure View
Profiles. In addition, you can specify individual keyboard shortcuts with Configure
Shortcuts, customize the toolbar with Configure Toolbars, and configure global
settings for the file manager with Configure Konqueror.

Window
TheWindowmenu allows you to split the main window horizontally and vertically.
It also allows you to manage the tabbed subwindows within the main window by
opening or closing a tab, duplicating an existing tab, or detaching a tab into a separate
window.

Help
Under theHelpmenu, access the Konqueror handbook or theWhat's This function.
Normally this function can also be accessed with the question mark symbol at the
top right in the title bar. The mouse pointer is then displayed with a question mark.
If you click an icon, a brief help text is displayed, if available. The Help menu also
provides a short introduction to Konqueror and the possibility to report bugs and
other concerns to the developers. About Konqueror and About KDE provide infor-
mation about the version, license, authors, and translators of the project.
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7.2.4 The Toolbar
The toolbar provides quick access to frequently-used functions that can also be accessed
via the menu. If you let the mouse pointer rest above an icon, a short description is
displayed. Right-click a free space in the toolbar to open a menu with which to change
the position of the toolbar, switch from icons to text, change the icon size, and display
or hide the individual bars. Start the configuration dialog with Configure Toolbars. To
the right, the toolbar features the Konqueror icon, which is animated while a directory
or Web page is loaded.

7.2.5 The Location Bar
The location bar is preceded by a black symbol with a white X. If you click this icon,
the contents of the line are deleted, allowing entry of a new location. Valid locations
can be path specifications, like the one that appears when the home directory is displayed,
or Web page URLs. After entering an address, press Enter or click Go to the right of
the input line. Access directories or Web pages visited recently via the black arrow to
the right of the location bar. This function saves some typing if you need to access
certain contents repeatedly. If there are locations that you need to view again and again,
it is more convenient to create bookmarks for them.

7.2.6 The Main Window
The main window displays the content of the selected directory. If you click an icon,
the respective file is displayed in Konqueror or loaded into the appropriate application
for further processing. Clicking an RPM package lists the contents of the file. Selecting
Install package with YaST prompts for the root password entry, after which the
package is installed.

If you right-click an icon, a menu opens. The kind of menu displayed depends on the
file type and offers common actions, such as Cut, Copy, Paste, and Delete. Use Open
with to select the application with which to open the file from a list of suitable programs.

The quickest way to perform many actions is the drag and drop method. For example,
easily move files from one Konqueror window to another by simply dragging them
there while pressing the left mouse button. Subsequently, you are asked whether the
objects should be moved or copied.
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7.3 Important Utilities
The following pages introduce a number of small KDE utilities intended to assist in
daily work. These applications perform various tasks, such as managing your keys for
encrypting and signing files and e-mail messages, managing your clipboard, formatting
floppy disks, compressing and decompressing diverse file archive types, and sharing
your desktop with other users.

7.3.1 Creating an Image Gallery
If you have a large collection of images in a directory, you may find it difficult to
manage them. Konqueror can help you by creating an HTML file with thumbnails.
Open the respective directory in Konqueror and select Tools → Create Image Gallery.
A dialog opens in which to specify the page title, the number of thumbnails per line,
the background and foreground colors, and some other details. When you are finished,
select Create to start the action. By default, Konqueror creates a file named images
.html. It can be opened with Konqueror and presents a well-arranged thumbnail index
of your image collection. To view an image in full size, simply click the corresponding
thumbnail.

7.3.2 Managing Passwords with KWallet
Manager

Remembering all the passwords for protected resources to which you need to log in
can be problematic. KWallet remembers them for you. It collects all passwords and
stores them in an encrypted file. With a single password, open your wallet to view,
search, delete, or create new entries. Normally you do not need to insert an entry man-
ually. KDE recognizes if a resource requires authentication and KWallet starts automat-
ically.

IMPORTANT: Protect Your KWallet Password

If you forget your KWallet password, it cannot be recovered. Furthermore,
anyone who knows your password can obtain all information contained in the
wallet.
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Configuring KWallet
When start KWallet for the first time, a window appears with the welcome screen.
Choose between Basic setup and Advanced setup. Basic setup is recommended. If you
choose it, select in the next screen whether you want to store personal information.
Some KDE applications, like Konqueror or KMail, can use the wallet system to store
Web form data and cookies. Select Yes, I wish to use the KDE wallet to store my per-
sonal information for this purpose and leave with Finish.

If you choose Advanced setup, you have an additional security level screen. The default
settings are generally acceptable for most users, but others may wish to change them.
Automatically close idle wallets closes wallets after a period of inactivity. To separate
network passwords and local passwords, activate Store network passwords and local
passwords in separate wallet files. Close with Finish.

Once configured, KWallet appears in the panel. Right-click the KWallet icon and select
Configure Wallet if you want to modify the configured. A dialog box opens. Configure
different settings, like how KWallet closes a wallet, which wallet is automatically se-
lected, and two options about the wallet manager itself.

The KWallet Manager Window
To store data in your wallet or view its contents, open the manager window by right-
clicking the KWallet icon in the panel and selectingConfigureWallet. The kdewallet
folder is the default folder for your passwords. Click kdewallet and a window
prompts for your password. After a successful login, you can see the main window. It
is divided into four different parts: the top left part displays a summary, the top right
part displays subfolders, the lower left part shows a list with folder entries, and the
lower right part shows the contents of a selected entry. The window is shown in Fig-
ure 7.2, “The KWallet Manager Window” (page 184).
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Figure 7.2 The KWallet Manager Window

To insert a new item, proceed as follows:

Procedure 7.1 Inserting New Entries in Your Wallet

1 You can add a new entry to Maps or Passwords only. Use Maps if you have key
and value pairs. Passwords can contain multiline entries.

2 Right-click the respective folder entry.

3 A dialog box appears and prompts for a name of the new entry. Name your entry
and approve it with Ok.

4 Your new entry is sorted under your folder entry. Click the new entry to display
it on the right side. Initially it is empty.

5 Insert a new key and value pair with a right-click and choose New Entry. All
entries are shown in a table view.

6 Name your key. Activate Show values to view the value row. Click to write into
the cell.

7 Store your modifications with Save.
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You can always change your password with File → Change Password.

Advanced Features
You probably do not need to pay very much attention to KWallet. It resides silently in
the panel and is automatically activated if needed. One nice feature of KWallet is that
you can move your wallet files to another computer, for example, to your laptop. To
simplify this task, wallets can be dragged from the manager window to a file browser
window. For example, save it on a USB stick and carry your passwords with you.

7.3.3 The Download Manager KGet
KGet is the download manager for KDE. It manages your transfers in a window. Stop,
resume, delete, queue, and add transfers.

Adding Transfers
Start KGet by pressing Alt + F2 and entering the command kget. When the program
starts for the first time, a dialog is displayed. Confirm this dialog to integrate KGet in
Konqueror. When you close the dialog, KGet is integrated in the system tray of the
panel as an icon with a down arrow.

Click this arrow to open the dialog displaying your transfers. To add a transfer to the
list, select File → Paste. A dialog opens. Enter a URL in the input field and confirm
withOK. Then specify the location for saving the downloaded file. After all information
has been entered, the entry for the transfer is added to the main window of KGet and
started.

Another way to add a transfer is by means of drag and drop. Simply drag a file, for
example, from an FTP server, from Konqueror and drop it in the main window.

Timer-Controlled Transfers
You can also instruct KGet to perform your transfers at a specific time. ActivateOptions
→ Offline Mode. All transfers inserted from this point are not started immediately but
queued. To start the clock, double-click the respective entry. A dialog opens. Select
Advanced. The dialog is expanded by the settings needed for starting the transfer at a
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certain time. Enter the day, month, year, and time and activate the Timer icon. Then
close the window.

After making the desired settings for all your transfers, set KGet back to the online
mode by deactivatingOptions→OfflineMode. The transfers should start at the specified
times.

Settings
In Settings→Configure KGet, set preferences for the connection, determine directories
for specific file extensions, and specify other settings.

7.3.4 The Clipboard Klipper
The KDE program Klipper serves as a clipboard for selected text, normally marked by
keeping the left mouse button pressed. This text can be transferred to another application
by moving the mouse pointer to the target location then pressing the middle mouse
button (on a two-button mouse, press both buttons simultaneously). The text is copied
to the selected location from the clipboard.

By default, Klipper is started when KDE is loaded and appears as a clipboard icon in
the panel. View the contents of the clipboard by clicking this icon. The Klipper context
menu and the last seven entries, also referred to as the history, are displayed. If an ex-
tensive text was copied to Klipper, only the first line of the text is displayed. The most
recent entry is listed on top and is marked as active with a black check mark. To copy
an older text fragment from Klipper to an application, select it by clicking it, move the
mouse pointer to the target application, then middle-click.

As well as the contents of the clipboard, the context menu features the following menu
items:

Enable Actions
If you click this, a black check mark is displayed in front of it. For example, if you
mark a URL with the mouse when actions are enabled, a window opens, enabling
you to select a browser for displaying this URL. Click Enable Actions to disable
this function.

Clear Clipboard History
Deletes all entries from the clipboard.
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Configure Klipper
This opens the Klipper configuration dialog. Control the program with keyboard
shortcuts or use regular expressions. Check the Klipper handbook for details. Former
Windows users may appreciate the option for activating the keyboard shortcuts Ctrl

+ C and Ctrl + X for cutting and Ctrl + V for pasting under the General tab. To
use this feature, activate the entry Synchronize contents of the clipboard and the
selection in Clipboard/Selection Behavior. Subsequently, use the mouse or the
keyboard shortcuts to which you are accustomed.

Help
This item opens a submenu from which to open the Klipper handbook, send a bug
report to the developers, and view information about Klipper and KDE.

Quit
If you click Quit, a dialog is displayed asking whether Klipper should be started
automatically the next time you log in. If you click No, start the program from the
main menu the next time you want to use it. If you click Cancel, the program is not
terminated.

7.3.5 Ark: Displaying, Decompressing, and
Creating Archives

To save space on the hard disk, use a packer that compresses files and directories to a
fraction of their original size. The application Ark can be used to manage such archives.
It supports common formats, such as zip, tar.gz, tar.bz2, lha, and rar.

Start Ark from the main menu or from the command line with ark. If you already have
some compressed files, move these from an open Konqueror window to the Ark window
to view the contents of the archive. To view an integrated preview of the archive in
Konqueror, right-click the archive in Konqueror and select Preview in Archiver. Alter-
natively, select File→ Open in Ark to open the file directly. See Figure 7.3, “Ark: File
Archive Preview” (page 188).
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Figure 7.3 Ark: File Archive Preview

Once you have opened an archive, perform various actions. Action offers options such
as Add File, Add Folder, Delete, Extract, View, Edit With, and Open With.

To create a new archive, select File → New. Enter the name of the new archive in the
dialog that opens and specify the format using Filter. After confirming with Save or by
pressing Enter , Ark opens an empty window. You can drag and drop files and directories
from the file manager into this window. As the final step, Ark compresses everything
into the previously selected archive format. For more information about Ark, select
Help → Ark Handbook.

7.3.6 Screenshots with KSnapshot
With KSnapshot, create snapshots of your screen or individual application windows.
Start the program from the main menu or from the command line with the command
ksnapshot. The dialog of KSnapshot, shown in Figure 7.4, “KSnapshot” (page 189),
consists of two parts. The upper area contains a preview of the current screen and three
buttons for creating and saving the screenshots. In the lower part of the window, set
some options to decide how the screenshot should be created.
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Figure 7.4 KSnapshot

To take a screenshot, use Snapshot delay to determine the period in seconds to wait
between when New Snapshot is clicked and the actual creation of the screenshot. If
Only grab the window containing the pointer is active, only the window currently under
the pointer is “photographed.” By default, the program creates a shot of the entire screen.
To change this, select an item from Capture Mode. To save the screenshot to a file,
select Save as and set the directory and filename in the dialog that opens. To print the
screenshot right away, select Print.

7.3.7 Viewing PDF Files with KPDF
PDF is probably one of more important formats. KPDF is a KDE program that can view
and print them.

Start KPDF by pressing Alt + F2 and entering the command kpdf. Load a PDF file
with File → Open. KPDF displays it in its main window. On the left side, there is a
sidebar with thumbnails and a contents view. Thumbnails give an overview of the page.
The contents view contains bookmarks to navigate in your document. Sometimes it is
empty, meaning bookmarks are not supported by this PDF.

To view two pages in the main window, select View → Two Pages. The view depends
on what last two options you activate in the View menu.

Another nice option is to select the area in which you are interested with the select tool
from the toolbar. Draw a rectangle and choose from the pop-up menu whether you need
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the selected area as text or as a graphic. It is copied to the clipboard. You can even save
the area to a file.

7.3.8 Getting News with Akregator
Users who want to get the latest news can get their information with a newsfeed reader.
One reader is Akregator. It connects to a server that contains a newsticker file and
downloads it then shows the headlines and sometimes a small text to get an overview.
See Figure 7.5, “Akregator Showing Some News” (page 190). If interested in this news,
click it and view it in a separate tab.

Figure 7.5 Akregator Showing Some News

Akregator contains some predefined news feeds for KDE to get in touch with this tool.
You can add news feeds manually or some Web sites announce it. For example, a Web
site with feed support contains an orange rectangle in the bottom right corner. Click it
to open a pop-up menu where you can select Add Feed to Akregator. Sometimes a Web
site does not announce that it supports a news feed. Then you can search this site with
some keywords like feed or rss. Sometimes you are successful and can obtain a link.
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If you want to add a news feed, do the following:

Procedure 7.2 Adding a News Feed to Akregator

1 Determine the URL of your news feed. Normally this can be found on your pre-
ferred Web site. More links can be found in the KNewsticker tool, an applet for
the KDE panel.

2 Open Akregator by pressing Alt + F2 and entering akregator. It opens a new
window with the list of all feeds in your configuration. If you close this window
it docks in the system tray.

3 Create a new folder with Feed → New Folder. This gives you the opportunity
to group your feeds in categories.

4 Name your new folder.

5 Click this folder and choose Feed → Add Feed.

6 Insert the feed URL, for examplehttp://www.novell.com/newsfeeds/
rss/coolsolutions.xml. A new window opens where you can change
the feed name, URL, or the update interval. With the Feed Archive tab, change
how long articles should be stored.

7 Proceed with Ok. Akregator downloads the latest articles.

After the download of the latest headers is finished, you can click an entry. Depending
on the feed, this can list a small summary or just a link. With Complete Story, read the
entire article.

You can check for new news manually with Fetch Feed. Another option is to specify
an update interval. Configure this by clicking Settings → Configure Akregator. A
window opens where you can select the interval in General → Use interval fetching.
Confirm with Ok.

You can read the complete story either in Akregator or in an external browser. Clicking
Complete Story lets you select which.
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7.3.9 Chatting with Friends: Kopete
Kopete is an online messenger application allowing multiple partners connected to the
Internet to chat with each other. Kopete currently supports all common messenger
protocols, such as ICQ, MSN, Yahoo, SMS, Jabber, and IRC.

Configuring Kopete
Configure Kopete by entering your personal user data. Click Settings → Configure
Kopete. With Accounts, enter your user data. You must register with a provider offering
instant messaging services before using such service. ClickNew to open a configuration
assistant that can assist you in completing your user profile.

The next step lists the available messaging services. Select the service with which you
have registered and click Continue. Then enter the user data received on registration
with the messaging service. This usually consists of the nickname or e-mail address
and a password. Complete the configuration of the messenger account by clicking
Finish.

Figure 7.6 Kopete Configuration Panels

The next item in the configuration dialog is Appearance. It influences how Kopete is
displayed. Emoticons provides a selection of various types of smileys.

Use Chat window and Colors & Fonts to adjust the appearance of the chat windows
for communication with other participants. Choose from the classic themes of the cor-
responding providers or create a custom theme by adjusting the font or color to your
preferences.
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Adding Contacts
Add contacts to chat with them. If you have already created an account on another PC,
this data is imported and automatically added to your contact list. To create a contact
entry manually, click File→ Add Contact. A new assistant appears to help with creation.
However, you must be online and connect with Kopete to the selected messaging service
to add a contact to your list.

Adding Groups
Access this with File → Create New Group. Name the group and confirm this with
OK. A new folder appears in the contact list that can be used to store the desired contacts.
Drag and drop contacts into the desired folder. Grouping contacts can give a better
overview.

Figure 7.7 The Main Kopete Window

Empty groups can be disabled by activating Settings → Hide Empty Groups.

Using Kopete
It is necessary to establish a connection to the Internet to be able to chat with other
participants. When this is done, you should set your status by clicking File→ Set Status
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→ Online. This establishes a connection between Kopete and the selected messaging
service. After the successful login, you are visible to others.

The main application windows features a list of contacts. You must have contacts to
chat with others (see Section “Adding Contacts” (page 193) for more information).
When you right-click a contact marked as online, a menu opens with various options.
Send that person a message or start a chatting session. A chat allows invitation of addi-
tional participants for real-time discussion. Connection to all participants is closed when
the creator of the chat session closes it.

If you want to see your former chatting session, select a contact and go to Edit→ View
History. This menu item opens a dialog where you can search and view your chatting
sessions with this person.

You can view other options by right-clicking a username. A pop-up menu opens. An
important option is Start Chat to start a chatting session. With Rename Contact and
Remove Contact, you can run the respective action. The pop-up menu also contains a
submenu item with the username where you can block the user or get user information.

7.3.10 KDE Accessibility Tools
KDE offers handicap support for daily computer work. There are a number of options
in KDE, especiallyRegional & Accessibility→ Accessibility in the KDE Control Center.
Some additional programs also help meet particular needs.

KMag—Magnify Your Desktop
People with low vision have limited possibilities for improving the visibility of their
desktop. The font size can be increased, but that is not always a good solution. The tool
KMag solves this problem. It magnifies your desktop. Start it with the command kmag
then see a part of the screen in the KMag window.

With the toolbar, choose some important options, such as the zoom factor, the refresh
rate, and how KMag should behave. You can magnify around the mouse cursor, show
a window for selecting the magnified area, or magnify the entire screen. With F5 , halt
the process. Press it again to restart it.
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KTTS—The KDE Text-to-Speech Manager
KTTS is an implementation of a system for producing speech from text. This enables
other applications to use this subsystem in a consistent manner. The capabilities of
KTTS include speaking the content of a text file, KDE notification events, and all or
part of the text of a Web page in Konqueror. Before configuring KTTS, make sure that
you have festival and the KDE accessibility package installed.

NOTE: Additional Languages

Due to incompatible licenses, only the English may be included in our distribu-
tion. For more information about festival, see http://festvox.org/.

To start KTTS, press Alt + F2 and type kttsmgr. If you have not configured KTTS
yet, the talkers screen appears with an empty list. Click Add to add a talker to the list.
This opens a new dialog box. Select a speech synthesis plug-in by name or by language.
When the synthesizer method is chosen, the synthesizer box and the language box are
updated. For example, check the synthesizer box and choose Festival Interactive. If
you leave with OK, the synthesizer automatically configures itself.

In this example, the Festival Interactive talker is added to the list. To configure it, select
it and go to Edit. A dialog box like that in Figure 7.8, “Configuring Talkers” (page 195)
appears. In it, select the voice (if more than one is available), set the volume, speed,
and pitch, and test it. Approve with OK.

Figure 7.8 Configuring Talkers
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KTTS has some additional tabs. With General, enable or disable the text-to-speech
service. Notifications are messages routed from an application to the KDE notification
system. You can configure it with Speak notifications (KNotify). To embed KTTS in
the system tray, check the respective option.

The Talker tab was already explained above. In Audio, choose between aRts and
GStreamer, two sound systems. Jobs gives an overview of your current speech jobs.
You can pause, resume, restart, remove, or change the order of the jobs.

KMouth—Speak Text with KDE
KMouth is a program designed to speak for those who cannot. You must have installed
and configured a speech synthesizer as described in Section “KTTS—The KDE Text-
to-Speech Manager” (page 195).

When you start KMouth for the first time, a wizard opens. This enables you to specify
the command to use to speak the text. If you already configured your text to speech
system with KTTS, this is not necessary.

The second page lets you select some phrase books. A phrase book is a collection of
frequently-used phrases. This has the advantage that the user does not need to type
them. KMouth supports different languages and different topics (courteousness, greet-
ings, “How are you?,” and personal). You can select all or only one of them.

With the third page, define a dictionary. It is used for word completion. You can define
either the KDE documentation of the respective language or the OpenOffice.org dictio-
nary as a text base. After leaving with Finish, KMouth generates the dictionary and
opens the main dialog.

The main dialog, shown in Figure 7.9, “Using KMouth” (page 197), displays the topics
of the phrase books, a history of spoken sentences, and an edit field. To speak, type the
sentence in the text field or choose it from the list. Click Speak.
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Figure 7.9 Using KMouth

Improve the application by entering your own sentences in your phrase book. Choose
Phrase Books → Edit and a window appears like that in Figure 7.10, “Using Phrase
Books in KMouth” (page 197). You can see the phrase and the assigned shortcut. By
right-clicking the phrase book or a phrase itself, open pop-up menu in which to select
New Phrase. Insert your phrase in the text field. You can assign a shortcut with the
keycap button. When satisfied with your settings, choose File → Save. Your added
phrase book is shown in your toolbar.

Figure 7.10 Using Phrase Books in KMouth
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7.3.11 Font Administration with KFontinst
By default, SUSE Linux provides various fonts commonly available in different file
formats (Bitmap, TrueType, etc.). These are known as system fonts. Users can addition-
ally install their own fonts from various collections on CD-ROM. Such user-installed
fonts are, however, only visible and available to the corresponding user.

The KDE control center provides a comfortable tool for administering system and user
fonts. It is shown in Figure 7.11, “Font Administration from the Control Center”
(page 198).

Figure 7.11 Font Administration from the Control Center

To check which fonts are currently available, type the URL fonts:/ into the address
field of a Konqueror session. This displays two windows: Personal and System.
User-installed fonts are installed to the folder Personal. Only root can install to the
System folder.

To install fonts as a user, follow these steps:

1. Start the Control Center and access the appropriate module with System Admin-
istration → Font Installer.
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2. Choose Add Fonts from the toolbar or from the menu available when right-
clicking the list.

3. In the dialog that opens, select one or more fonts for installation.

4. The marked fonts are then installed to your personal font folder. Selecting a font
shows a preview.

To update system fonts, first select Administrator mode and enter your root password.
Then proceed as described for user font installation.
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8The GNOME Desktop
This chapter introduces the GNOME (GNU Network Object Model Environment)
desktop. It provides a brief overview of the most important elements and functionalities
of your desktop, including an in-depth description of the Nautilus file manager. It also
includes descriptions of several smart and useful applications that can help you feel at
home in your new desktop environment.

GNOME has a very intuitive look and feel. However, users migrating to Linux from a
Microsoft Windows desktop might need to get accustomed to a few things. Users mi-
grating from a Macintosh might notice that GNOME feels very much like home, because
it provides a Mac-like look-and-feel on the Linux desktop.

The following issues are very important in GNOME:

double-click
Like a Mac desktop, the GNOME desktop is entirely ruled by the double-click. To
trigger an event by clicking a desktop icon (for example, to open your home folder),
double-click it. To open subdirectories in the file manager, double-click the parent
folder.

instant apply
Any configuration dialog opened from a GNOME application or as part of the
GNOME desktop configuration follows the principle of instant apply. After you
specify your preferences, click the Close button to save your changes and exit the
dialog. You will not find Apply, OK, or Cancel buttons in this kind of dialog.
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8.1 Desktop Components
The most important elements of the GNOME desktop are the icons on the desktop, the
panels at the top and bottom border of the screen, and the panel menus. The mouse is
your most important tool, although GNOME does have built-in support for assistive
technologies, such as braille, speech synthesizers, and on-screen keyboards to support
handicapped users. For information about these technologies, see Section 8.4, “Assistive
Technology Support” (page 217).

8.1.1 The Icons
The default GNOME desktop features the following desktop icons providing basic
navigation and functionalities for your system:

Computer
The Computer desktop icon can be used to quickly access any device attached to
your computer. This includes hard drives, partitions, digital cameras, and USB flash
drives.

Home
The Home desktop icon provides easy access to your private data.

Trash
Anything you want to delete can be dropped onto the Trash desktop icon. As long
as you do not empty the trash can, these items are not deleted permanently and can
still be restored.

You can right-click an icon to display a menu offering file operations such as copying,
cutting, or renaming. SelectingProperties from the menu displays a configuration dialog.
The title of an icon and the icon itself can be changed with Select Custom Icon. Use
the Emblems tab to add a small icon to an item (such as a file or a folder) to visually
mark the item. For example, to mark a file as important, you can add an Important
emblem to the file icon. Use Permissions to view and modify the access, read, and write
permission settings for this file for the user, the group, or others. Notes manages com-
ments. The menu for the trash can additionally features Empty Trash, which deletes the
contents of the trash can.

To remove an icon from the desktop, simply drag it to the trash can. Be careful with
this option—if you throw folder or file icons into the trash can, the actual data is
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deleted. If the icons only represent links to a file or directory, only the links are deleted.

To create a link on the desktop to a folder or a file, access the object with Nautilus (see
Section 8.2.1, “Navigating in Nautilus” (page 206)). Right-click the object then click
Make Link. Drag the link from the Nautilus window and drop it onto the desktop.

8.1.2 The Desktop Context Menu
Right-clicking an empty spot on the desktop displays a menu with various options.
Select Create Folder to create a new folder or Create Document to create a new docu-
ment. You can create a launcher icon for an application with Create Launcher. Provide
the name of the application and the command for starting it, then choose an icon to
represent it. The order and alignment of desktop icons are controlled by the Clean Up
by Name andKeep Aligned options. It is also possible to change the desktop background
or paste an item on the desktop.

8.1.3 The Panels
On your first login, the GNOME desktop starts with two panels, one located at the top
of the screen and the other located at the bottom of the screen. The upper panel holds
the three panel menus (Applications,Places, andDesktop), a quick launch area providing
application buttons for the most important programs (Firefox Web browser and
OpenOffice.org Writer), a system tray holding applet icons (SUSEWatcher, SUSEPlug-
ger, Display Settings, and Network Settings), and a notification area with the system
clock and the volume control.

The bottom panel contains the window icons of all started applications in the taskbar
on the left. If you click the name of a window in the taskbar, the window is moved to
the foreground. If the program is already in the foreground, a mouse click minimizes
it. Clicking a minimized application reopens the window.

To the right of the taskbar, the Workspace Switcher provides access to additional work
areas. These virtual desktops provide extra space in which to arrange open applications
and windows. For example, you can open an editor in one workspace, some shells on
another, and your e-mail application and Web browser on a third. Move a window to
another workspace by dragging its icon in the Workspace Switcher from one workspace
to another.
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Right-click an empty spot in a panel to open a menu offering help, information, and
commands for GNOME and the panels. Select Properties to open a configuration dialog
where you can change the position and background of the panel. You can add launchers,
tools, and various applets to the existing panels with Add to Panel. Remove panel ele-
ments by right-clicking their icons and selecting Delete This Panel. Add a new panel
by clicking New Panel.

The Applications Menu
The Applications menu provides an easily accessible hierarchy of the applications in-
stalled on your system. Most of them are grouped into smaller submenus dedicated to
a category, such as System,Office, and Internet. To start any application, click Applica-
tions to display the complete menu, select a suitable category, click the submenu, then
click the application's name.

Applications not listed in the menu can be started via the Run Application prompt ( Alt
+ F2 ) if you know the command. For example, if you want to browse your digital
photographs and can not find gThumb in the menu, entergthumb at theRun Application
prompt.

The Places Menu
The Placesmenu provides easy access to common locations, such as your home direc-
tory, drives, the desktop, and network folders. A search function for recent documents
and a file search can also be launched with this menu. For more information about file
management of local and remote folders, see Section 8.2.2, “File Management”
(page 207).

The Desktop Menu
TheDesktopmenu contains controls for managing your desktop. Here, find theGNOME
Control Center (customizes your desktop), Lock Screen (starts the screen saver and
requires the password to stop it), and Log Out (ends your session), and an easy-to-use
program for taking screen shots of your desktop. The screen shot function can also be
accessed by pressing Print Screen (also known as PrtSc ).
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Applets
An applet is a small application that resides within a panel, indicated by a small icon
that you click to interact with the applet. Unlike “real” applications, applets do not have
their own windows on screen. Some applets are already preconfigured to be in your
panel on first start, but there are many more applets you can add to your own panels.

Add an applet to a panel from the panel menu. Right-click any empty space on the
panel then click Add to Panel. Select the applet to add then click Add. The new applet
is then permanently added to the panel.

Figure 8.1 Adding a New Icon to the Panel

To modify the properties of an applet, right-click the applet to display the panel object
pop-up menu then click Preferences. To move an applet, middle-click the applet.

8.2 File Management with Nautilus
Nautilus is GNOME's file manager and viewer. You can use Nautilus to create folders
and documents, display and manage your files and folders, run scripts, write data to a
CD, and open URI locations. The following sections provide an overview of the basic
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functions of Nautilus and a few tips on its configuration. For more information, see the
help pages for Nautilus.

You can open Nautilus in any of the following ways:

• Click Applications → System → File Manager

• Click the Computer icon on the desktop

• Click the Home icon on the desktop

8.2.1 Navigating in Nautilus
The standard window of Nautilus is shown in Figure 8.2, “Nautilus Standard Window”
(page 206). The default view of a folder's content is the icon view featuring just an icon
and the filename for each file. If configured accordingly, a preview of the file's content
can be provided, as described in Section 8.2.4, “Configuring Nautilus” (page 209). When
you double-click a folder icon, a new Nautilus window opens, displaying the folder's
content.

Figure 8.2 Nautilus Standard Window

To navigate between folders, use the drop-down menu in the bottom left corner of the
Nautilus window. In it, find all parent folders to the current directory up to the root file
system. You can select the folder you want and open it in a new Nautilus window on
top of the old one or you can open just the immediate parent of the current folder by
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clicking File → Open Parent. If you want to close these parent folders, click File →
Close Parent Folders.

If you prefer a browser-like file navigation, switch to the Nautilus browser interface
by right-clicking a folder then clicking Browse Folder. A new Nautilus window opens,
providing the normal functionality but with a browser's look-and-feel.

To navigate folders and files, use the Back, Forward, and Up buttons as you would in
a Web browser. The functionalities and configuration options described in Section 8.2.2,
“File Management” (page 207) and Section 8.2.4, “Configuring Nautilus” (page 209)
also apply to the file browser interface.

8.2.2 File Management
You can use drag-and-drop to perform several tasks in Nautilus. For example, you can
drag any file from the desktop and drop it onto an open Nautilus window. If you have
two Nautilus windows open, you can drag a file or folder from one window and drop
it onto another. To copy an item, select the item, press and hold Ctrl , then drag the item
to a new location.

To move files between directories, you can open the source directory containing the
file you want to move, click File→Open Location, type the path to the target directory,
clickOpen, then drag the files to the Nautilus window holding the target directory. Files
and folders can be moved to and from an open Nautilus window and the desktop.

If you need to create multiple copies of a file, click Edit→Duplicate. For a simple cut,
copy, and paste of files, use the Edit menu or right-click the file icon then select the
appropriate item from the context menu that appears. To rename a file, right-click it
then click Rename.

Nautilus also supports file browsing across a network. To connect to a remote server
such as FTP, SSH, HTTP, or Samba, click File → Connect to Server. You are then
prompted for the type of server you want to connect to as well as some additional infor-
mation, such as the name of the folder you want to access, the port number, and a
username. When you clickConnect, the remote folder is displayed as part of the Places
panel menu and appears as a desktop icon. For any future connections, select the appro-
priate item from the Places menu and provide the necessary authentication to log in to
these network folders. To close these connections, right-click the desktop icon then
click Unmount Volume.
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Nautilus provides basic CD and DVD burning functionality. To copy data to CD or
DVD, create a directory containing the data you want to burn, click Places→CD/DVD
Creator, drag the folder holding the data onto the CD/DVD Creatorwindow, then click
File → Write to Disc.

8.2.3 Editing MIME Types
MIME types determine which application should open a file when clicked in a Web or
file browser. The actual file type and the MIME type of a file are closely associated
with each other. An HTML file has the html file type and would be registered to have
a text/html MIME type. Nautilus has built-in support for most of the common
MIME types and proposes the appropriate application when you choose to open a file.
In this case, it would propose a Web browser.

However, you might want to change the MIME type for certain files if you are not
happy with the default applications suggested by Nautilus. Changing the default appli-
cation assigned to a certain MIME type is very straightforward.

Figure 8.3 Editing the MIME Type
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To edit a MIME type:

1 In a Nautilus window, right-click a file of the MIME type to change.

2 Click Properties → Open With.

3 Click Add to search for a suitable application.

4 Select the application to use then click Add.

5 Click Close to exit the dialog.

Even if a MIME type has not yet been properly registered, the procedure is the same
as described above. These modifications are applied globally, which means that any
file of this type is subsequently opened by the defined application.

8.2.4 Configuring Nautilus
Nautilus retrieves its default font and other preferences from the desktop configuration.
To set Nautilus-specific preferences, click Edit→ Preferences in any Nautilus window
to open the File Management Preferences dialog. This dialog offers five tabs (Views,
Behavior, Display, List Columns, and Preview) that you can use to set the following
preferences:

• The default settings for views

• The behavior of files and folders, executable text files, and Trash

• The information that is displayed in icon captions

• Preview options to improve the performance of Nautilus

In Views, specify a default view and select sort options and display settings. You can
choose to display hidden files and backup files in the view window, set a default zoom
level for folders, and arrange items in icon view so that the items in the folder are
closer to each other. You can also choose to place icon captions beside the icons instead
of under them.

Behavior lets you choose to single-click or double-click an item to activate it and run
executable files when you click them. Alternatively, choose to display the contents of
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an executable file when it is clicked. The operating mode of the trash is also set here.
You can activate a confirmation dialog before deletion or add a Delete item to the Edit
menu and the pop-up menu that is displayed when you right-click a a file, folder, or
desktop object. If you select an item then click Delete, the item is immediately deleted
from your file system.

Use Display to set icon caption preferences. An icon caption displays the name of a
file or folder in an icon view. The icon caption also includes three additional items of
information on the file or folder that are displayed after the filename. Normally, only
one item of information is visible, but when you zoom in on an icon, more of the infor-
mation is displayed. You can modify what additional information is displayed in icon
captions.

In List Columns, specify what information is displayed in list view in Nautilus windows.
Set which columns are displayed in list view and the order in which the columns are
displayed.

With Preview, select whether to activate preview thumbnails for certain file types. The
preview features can affect the speed at which Nautilus responds to your requests. You
can modify the behavior of some of these features to improve the speed of the file
manager.

8.3 Important Utilities
GNOME has many applets and applications designed to interact with the desktop and
each other. This section introduces some of them. Learn how to manage little notes on
your desktop, use the GNOME dictionary, chat using Gaim, and enjoy various types
of multimedia applications.

8.3.1 Taking Notes with Tomboy
Tomboy is a desktop note-taking application that helps you organize ideas and informa-
tion. See an example in Figure 8.4, “Examples of Tomboy Notes” (page 211). Add
Tomboy to a panel by right-clicking the panel then clicking Add to Panel. Scroll down
the list of items, select Tomboy Notes, then click Add. The Tomboy icon appears in
your panel.
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To create a new note, left-click the Tomboy icon then select Create New Note. Type
the text of your note. Link notes with each other by clicking Link. These links can even
survive renaming and reorganizing. The Search Notes function located in the panel
menu of Tomboy lets you search your notes. Web links and e-mail addresses can also
be dropped onto Tomboy. Click Recent Changes to view a list of your notes in the order
they were last modified.

Tomboy also supports advanced editing features, such as highlighted text, inline spell
checking, autolinking Web and e-mail addresses, undo and redo, and font styling and
sizing.

Figure 8.4 Examples of Tomboy Notes

8.3.2 Dictionary
GNOME Dictionary, shown in Figure 8.5, “GNOME Dictionary” (page 212), provides
dictionary definitions of words using any server that supports the dict protocol (an In-
ternet standard for client/server dictionary applications). An Internet connection is re-
quired because this applet accesses an online dictionary. To open Dictionary, click
Applications → Office → Dictionary → Dictionary or enter gnome-dictionary
in a terminal window.
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Figure 8.5 GNOME Dictionary

Type a word in Look Up then press Enter . By default, the query is sent to the dict.org
server. To use a different server, click Edit → Preferences. dict.org lets you choose
between various databases for special vocabularies, such as jargon or computer termi-
nology. Under Strategy, specify the search strategy to use, such as matching the exact
word, parts of the word, or the prefix or suffix. Click Help to access the application's
help.

8.3.3 The Gaim Messenger
Gaim is a powerful instant messenger client. It is shown in Figure 8.6, “Gaim” (page 213).
The application supports various protocols, such as AIM, ICQ, GroupWise®, IRC,
Jabber, and MSN. Its most popular features include the ability to log in to multiple ac-
counts on multiple instant messaging networks at the same time, automatic text replace-
ment, and spell checking. Gaim has buddy pounces (known as “buddy alerts” in AOL
Messenger), meaning that you can configure Gaim to notify you whenever one of your
buddies enters or leaves a channel you are currently connected to. Gaim can send you
a message announcing this, play a sound, or execute a command.

To access Gaim, click Applications → Internet → Chat → Gaim Internet Messenger
or enter gaim in a terminal window. On first start-up, create a list of your accounts on
different instant messaging networks by clicking Accounts → Add. Select the protocol
then specify your screen name, password, and alias. Select Remember password and
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Auto-login if you want Gaim to log in automatically on start-up. To keep track of your
e-mail while using Gaim, select New mail notifications. To use a buddy icon with your
account, open a file dialog and select one. Additional options, such as proxy settings
and server addresses, can be configured after clicking Show more options. When you
have completed your account settings, click Save to exit this dialog.

Figure 8.6 Gaim

As soon as you are finished specifying the account data, it is shown in the login window.
To sign on, select your account from the Accountmenu, type your password, click Sign
on, and start chatting.

8.3.4 Playing Streaming Media with
RealPlayer

RealPlayer* gives you access to multimedia files stored on the Internet or locally on
your computer. See Figure 8.7, “RealPlayer” (page 214). It supports RealAudio*, Re-
alVideo* 10, MP3, Ogg Vorbis, Theora, H263, AAC, and more. To launch RealPlayer,
click Applications → Multimedia → RealPlayer 10.

The first time you open RealPlayer, see the RealPlayer Setup Assistant. Click Forward
to start then follow the instructions in the assistant to set up RealPlayer on your com-
puter.
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Figure 8.7 RealPlayer

There are two ways to play media clips on your computer. The first is local playback,
which is when you click File → Open File on the RealPlayer menu then select the
media file to play. The other way clips are played is as streamed content. This is when
any clip is played in real time over the Internet. You can connect to streamed content
by clicking links on a Web page or selecting File → Open Location.

Use the options on the Play menu or the buttons in the lower-left of the program to
navigate through a clip. You can play, pause, stop, fast forward, or rewind a clip; turn
the volume up or down; or mute a clip. The Position Slider (located in the lower-right
of the program window) indicates where you are in the clip. Drag the slider to jump to
a different position in the clip.

8.3.5 Internet Telephony and Video
Conferencing with GnomeMeeting

GnomeMeeting lets you see and speak to other people via Internet telephony (VoIP)
and video conferencing. The GnomeMeeting address book is shared with the Evolution
e-mail client, so you do not need to specify contact information in more than one place.

You can browse for other GnomeMeeting users on your local network without knowing
their contact details first, and you can view your own video output side by side with
the video from your conversation partners so you see what they see.
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To open GnomeMeeting, clickApplications→ Internet→ Telephone→GnomeMeeting.
The first time you access GnomeMeeting, you need to complete the steps in the First
Time Configuration Druid that automatically opens.

8.3.6 Managing Archives with File Roller
In GNOME, you can manage file archives with File Roller. As an archive manager, it
can create and modify archives, view the content of an archive, view a file contained
in the archive, and extract files from the archive. File Roller supports the following
formats: tar archives uncompressed (.tar) or compressed with gzip (.tar.gz,
.tgz), bzip (.tar.bz, .tbz), bzip2 (.tar.bz2, .tbz2), compress (.tar.Z,
.taz), or lzop (.tar.lzo, .tzo); Zip archives (.zip); Jar archives (.jar, .ear,
.war); Lha archives (.lzh); Rar archives (.rar); and single files compressed with
gzip, bzip, bzip2, compress, and lzop.

You can easily view archive contents from File Roller with other applications without
needing to decompress the archives. File Roller supports drag-and-drop, allowing you
to drag file icons from the desktop or from the file manager (Nautilus) to the File Roller
window and drop them there.

To open File Roller, click Applications → Utilities → Archiving → Archive Manager.
To create a new archive, click Archive → New. Specify a name for the new archive
(without a file extension) and the directory where you want to create the archive. Then
select an archive type from the drop-down menu. Click New to exit the dialog. Add
files to the archive by dragging-and-dropping files from the desktop or the file manager
or by clicking Edit → Add Files.

After completing the selection and configuration, exit the dialog. The archive you cre-
ated is available for further processing at the specified location. To decompress an
archive, load it to File Roller, click Edit → Extract, then specify the target directory.

8.3.7 Reading News Feeds with Blam
Blam, shown in Figure 8.8, “Blam Feed Reader” (page 216), is a tool that helps you
keep track of the growing number of news feeds distributed as RSS. RSS provides news
updates from a Web site in a simple form for your computer. You can read these files
in a program called an aggregator, which collects news from various Web sites and
provides it to you in a simple form. Blam is a GNOME aggregator that lets you subscribe
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to any number of feeds and provides an easy-to-use interface to stay up to date. Blam
lets you print the news entries you like and automatically updates feeds at regular inter-
vals.

To open Blam, click Applications → Internet → RSS Reader → Blam Feed Reader.
Channels appear in a list on the left of the Blam window. Click any channel then view
the headlines in the top-right panel. Clicking a headline displays the article in the lower-
right panel. To see the full article, scroll to the bottom of the lower-right panel and click
Show in browser.

Figure 8.8 Blam Feed Reader

To add a new channel, clickChannel→Add, enter the URL, then clickOK. For example,
entering http://www.novell.com/newsfeeds/rss/slp.xml adds the
SUSE Linux Professional Cool Solutions channel to your list and downloads the latest
articles.

8.3.8 Exchanging News with Pan
Newsreader

Usenet is a collection of computers that let users exchange public messages on various
topics. These messages are similar to e-mail, but are transmitted by special software
that is separate from your e-mail system. They are intended for public discussions rather
than personal communication. A Usenet message is called an article. Articles are
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grouped by topic into newsgroups. The entire collection of articles and newsgroups is
called news.

Pan is an open source newsgroup client that supports basic newsreader features, such
as reading and writing news, threading articles, and replying via e-mail. Articles can
be sorted by author, date, subject, or the number of unread children in the thread. Pan
also supports yEnc (see http://www.yenc.org), offline newsreading, article fil-
tering, multiple connections, and more features for power users and alt.binaries
fans.

To open Pan, clickApplications→ Internet→Usenet News Reader→Pan Newsreader.
When you start Pan for the first time, it prompts you for configuration information.
Click Forward then follow the online instructions to configure Pan.

To read the messages in a group, click the group in the left pane. You are then
prompted for how many headers to download. If this is the first time you have viewed
a group, selectDownload All Headers. Otherwise, selectDownload NewHeaders. Then
click Execute.

To subscribe to a newsgroup, right-click the group in the left pane then click Subscribe.

8.4 Assistive Technology Support
GNOME offers a number of applications to support users with disabilities. These appli-
cations include an on-screen keyboard (GOK), a powerful screen reader (Gnopernicus)
with magnification, speech and braille support, and a text entry interface (Dasher).
Activate the support for any assistive technology in the GNOME control center, which
can be accessed by clicking Desktop → GNOME Control Center.

8.4.1 GNOME On-Screen Keyboard
GNOME On-Screen Keyboard (GOK) provides a virtual keyboard on screen if you
cannot use standard mouse and keyboard devices to control you computer. With appro-
priate hardware support, you can use a joystick or any pointer device as the input device.
To access GOK, click Applications → Utilities → Desktop → On-Screen Keyboard.
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Figure 8.9 GOK in Use

To edit a text file using GOK:

1 Click Launcher in the main menu, which is shown in Figure 8.9, “GOK in Use”
(page 218).

2 Click Text Editor to launch a GNOME text editor, then click back to return to
the main menu.

3 Click Compose to launch the actual on-screen keyboard and start entering your
text. If you need advanced editing functionality such as selecting, copying,
pasting, or skipping characters, words, sentences, or lines, click Edit. To return
to the keyboard window, click back.

4 To save the text you have written, click back to return to the main window then
click Menus to launch a window containing buttons to open any menu from the
text editor's menu bar.

5 Click File → Save As to open the file dialog of the text editor.

6 Click Compose to type the filename via the virtual keyboard then click Return
on the virtual keyboard.

7 To terminate the text editor, return to the main menu then click Menus → File
→ Quit.

To configure the behavior of GOK, clickGOK→ Preferences in the main window and
adjust the Appearance, Keyboard, Actions, Feedback, Access Methods, and Prediction
settings.

For more information on GOK, see http://www.gok.ca, where you can also find
comprehensive online help for this tool.
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8.4.2 Gnopernicus
Gnopernicus is a powerful tool collection with various types of screen reading applica-
tions for blind and visually impaired users. It provides the following functionalities:

Speech
A speech synthesizer software is used to translate the actions on screen to spoken
words. If your computer has a sound card, you can configure Gnopernicus to speak
about anything that happens on screen.

Braille and Braille Monitor
If a braille device is connected to your computer, Gnopernicus can translate the
screen directly to this device. If you also activated Braille Monitor, you get an on-
screen display of the braille output. This option is useful for demonstration purposes.

Magnifier
This module assists visually impaired users by magnifying the screen using a cus-
tomizable zoom factor.

To access Gnopernicus, click Applications → Utilities → Desktop → Screen Reader
andMagnifier. After Gnopernicus is started, its main menu appears in the top-left corner
of the screen, as shown in Figure 8.10, “Configuring Gnopernicus” (page 219). You can
determine which functionalities should be provided when your desktop starts by clicking
Startup Mode. Each active module can be configured using the Preferences dialog.

Figure 8.10 Configuring Gnopernicus
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For more information on the Gnopernicus project, see http://www.baum.ro/
gnopernicus.html.

8.4.3 Dasher
Dasher lets you create texts without using a keyboard. You can use it on any computer
device that comes without a keyboard (handheld or wearable computers) or on a normal
computer that is controlled with a joystick, touchpad, head mouse, or eyetracker instead
of keyboard and mouse.

Figure 8.11 Writing with Dasher

Dasher is driven by continuous pointer gestures. Start with one character, then drag the
pointer to the next one until your text input is finished. Dasher supports various languages
(English and European languages, Japanese, and some African languages) and can
easily be trained to support other languages. For more information on the Dasher project,
see http://www.inference.phy.cam.ac.uk/dasher.
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Part IV Troubleshooting





9Common Problems and Their
Solutions
This chapter offers a range of common problems that can arise with SUSE Linux, with
an intention of covering as many of the various types of potential problems as possible.
That way, even if your precise situation is not listed here, there might be one similar
enough to offer hints as to the solution.

9.1 Finding Information
Linux logs things in a fair amount of detail. This means that when things do go wrong,
there is usually some information about what happened. Even if the logs do not tell you
why (although they do, sometimes), you can at least get a head start on figuring it out.
There are several places to look when you have problems with a SUSE Linux system,
most of which are standard to Linux systems in general and some of which are peculiar
to SUSE Linux systems.

The following is a list of the most commonly checked log files and what they typically
contain.

DescriptionLog File

Messages from the kernel during the boot
process.

/var/log/boot.msg

Messages from the mail system./var/log/mail.*
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DescriptionLog File

Ongoing messages from the kernel and sys-
tem log daemon when running.

/var/log/messages

Hardware messages from the SaX display
and KVM system.

/var/log/SaX.log

Messages from the desktop applications cur-
rently running. Replace userwith the actual
username.

/home/user/
.xsession-errors

All messages from the kernel and system log
daemon assigned WARNING level or higher.

/var/log/warn

Binary file containing user login records for
the current machine session. View it with
last.

/var/log/wtmp

Various start-up and runtime logs from the
X Window system. It is useful for debugging
failed X start-ups.

/var/log/Xorg.*.log

Directory containing YaST's actions and their
results.

/var/log/YaST2/

Directory containing Samba server and client
log messages.

/var/log/samba/

Linux comes with a number of tools for system analysis and monitoring. See Chap-
ter System Monitoring Utilities (↑Reference) for a selection of the most important ones
used in system diagnostics.

Each scenario included in the following begins with a header describing the problem
followed by a paragraph or two offering suggested solutions, available references for
more detailed solutions, and cross-references to other scenarios that might be related.

224



9.2 Installation Problems
Installation problems are situations when a machine fails to install. It may fail entirely
or it may not be able to start the graphical installer. This section highlights some of the
typical problems you might run into and offers possible solutions or workarounds for
this kind of situations.

9.2.1 No Bootable CD-ROM Drive Available
If your computer does not contain a bootable CD or DVD-ROM drive or if the one you
have is not supported by Linux, there are several options for installing your machine
without a need for a built-in CD or DVD drive:

Booting from a Floppy Disk
Create a boot floppy and boot from floppy disk instead of CD or DVD.

Using an External Boot Device
If it is supported by the machine's BIOS and the installation kernel, boot for instal-
lation from external CD or DVD drives.

Network Boot via PXE
If a machines lacks a CD or DVD drive, but provides a working ethernet connection,
perform a completely network-based installation. See Section “Remote Installation
via VNC—PXE Boot and Wake on LAN” (Chapter 1, Remote Installation, ↑Refer-
ence) and Section “Remote Installation via SSH—PXE Boot and Wake on LAN”
(Chapter 1, Remote Installation, ↑Reference) for details.

Booting from a Floppy Disk (SYSLINUX)
On some older computers, there is no bootable CD-ROM drive available, but a floppy
disk drive. To install on such a system, create boot disks and boot your system with
them. See Section 3.7.3, “Boot and Rescue Disks” (page 85) for directions for creating
boot disks with YaST.

The boot disks include the loader SYSLINUX and the program linuxrc. SYSLINUX
enables the selection of a kernel during the boot procedure and the specification of any
parameters needed for the hardware used. The program linuxrc supports the loading of
kernel modules for your hardware and subsequently starts the installation.

Common Problems and Their Solutions 225



When booting from a boot disk, the boot procedure is initiated by the boot loader
SYSLINUX (package syslinux). When the system is booted, SYSLINUX runs a
minimum hardware detection that mainly consists of the following steps:

1. The program checks if the BIOS provides VESA 2.0–compliant framebuffer
support and boots the kernel accordingly.

2. The monitor data (DDC info) is read.

3. The first block of the first hard disk (MBR) is read to map BIOS IDs to Linux
device names during the boot loader configuration. The program attempts to
read the block by means of the the lba32 functions of the BIOS to determine if
the BIOS supports these functions.

If you keep Shift pressed when SYSLINUX starts, all these steps are skipped. For
troubleshooting purposes, insert the line
verbose 1

in syslinux.cfg for the boot loader to display which action is currently being per-
formed.

If the machine does not boot from the floppy disk, you may need to change the boot
sequence in the BIOS to A,C,CDROM.

External Boot Devices
Most CD-ROM drives are supported. If problems arise when booting from the CD-
ROM drive, try booting CD 2 of the CD set.

If the system does not have a CD-ROM or floppy disk, it is still possible that an external
CD-ROM, connected with USB, FireWire, or SCSI, can be used to boot the system.
This depends largely on the interaction of the BIOS and the hardware used. Sometimes
a BIOS update may help if you encounter problems.
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9.2.2 Installation Fails or Machine Does Not
Boot from the Installation Media

There are two possible reasons for a machine not to boot for installation:

CD or DVD-ROM Drive Unable to Read the Boot Image
Your CD-ROM drive might not be able to read the boot image on CD 1. In this
case, use CD 2 to boot the system. CD 2 contains a conventional 2.88 MB boot
image that can be read even by unsupported drives and allows you to perform the
installation over the network as described in Chapter Remote Installation (↑Refer-
ence).

Incorrect Boot Sequence in BIOS
The BIOS boot sequence must have CD-ROM set as the first entry for booting.
Otherwise the machine would try to boot from another medium, typically the hard
disk. Guidance for changing the BIOS boot sequence can be found the documentation
provided with your motherboard or in the following paragraphs.

The BIOS is the software that enables the very basic functions of a computer. Mother-
board vendors provide a BIOS specifically made for their hardware. Normally, the
BIOS setup can only be accessed at a specific time—when the machine is booting.
During this initialization phase, the machine performs a number of diagnostic hardware
tests. One of them is a memory check, indicated by a memory counter. When the counter
appears, look for a line, usually below the counter or somewhere at the bottom, men-
tioning the key to press to access the BIOS setup. Usually the key to press is Del , F1 ,
or Esc . Press this key until the BIOS setup screen appears.

Procedure 9.1 Changing the BIOS Boot Sequence

1 Enter the BIOS using the proper key as announced by the boot routines and wait
for the BIOS screen to appear.

2 To change the boot sequence in an AWARD BIOS, look for the BIOS FEATURES
SETUP entry. Other manufacturers may have a different name for this, such as
ADVANCEDCMOS SETUP. When you have found the entry, select it and confirm
with Enter .

3 In the screen that opens, look for a subentry called BOOT SEQUENCE. The boot
sequence is often set to something like C,A or A,C. In the former case, the ma-
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chine first searches the hard disk (C) then the floppy drive (A) to find a bootable
medium. Change the settings by pressing PgUp or PgDown until the sequence is
A,CDROM,C.

4 Leave the BIOS setup screen by pressing Esc . To save the changes, select SAVE
& EXIT SETUP or press F10 . To confirm that your settings should be saved,
press Y .

Procedure 9.2 Changing the Boot Sequence in a SCSI BIOS (Adaptec Host
Adapter)

1 Open the setup by pressing Ctrl + A .

2 Select Disk Utilities, which displays the connected hardware components.

Make note of the SCSI ID of your CD-ROM drive.

3 Exit the menu with Esc .

4 Open Configure Adapter Settings. Under Additional Options, select Boot Device
Options and press Enter .

5 Enter the ID of the CD-ROM drive and press Enter again.

6 Press Esc twice to return to the start screen of the SCSI BIOS.

7 Exit this screen and confirm with Yes to boot the computer.

Regardless of what language and keyboard layout your final installation will be using,
most BIOS configurations use the US keyboard layout as depicted in the following
figure:
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Figure 9.1 US Keyboard Layout
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9.2.3 Installation Fails and Machine Fails to
Boot

Some hardware types, mainly fairly old or very recent ones, fail to install. In many
cases, this might happen because missing support for this type of hardware in the instal-
lation kernel or due to certain functionalities included in this kernel, such as ACPI, that
still cause problems on some hardware.

If your system fails to install using the standard Installationmode from the first instal-
lation boot screen, try the following:

1 With the first CD or DVD still in the CD-ROM drive, reboot the machine with
Ctrl + Alt + Del or using the hardware reset button.

2 When the boot screen appears, use the arrow keys of your keyboard to navigate
to Installation--ACPI Disabled and press Enter to launch the boot and installation
process. This option disables the support for ACPI power management techniques.

3 Proceed with the installation as described in Chapter 1, Installation with YaST
(page 3).

If this fails, proceed as above, but choose Installation--Safe Settings instead. This option
disables ACPI and DMA support. Most hardware should boot with this option.

If both of these options fail, use the boot options prompt to pass any additional param-
eters needed to support this type of hardware on to the installation kernel. For more
information about the parameters available as boot options, refer to the kernel documen-
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tation located in /usr/src/kernel_version/Documentation/
kernel-parameters.txt.

There are various other ACPI-related kernel parameters that can be entered at the boot
prompt prior to booting for installation:

acpi=off
This parameter disables the complete ACPI subsystem on your computer. This may
be useful if your computer cannot handle ACPI at all or if you think ACPI in your
computer causes trouble.

acpi=oldboot
Switch off ACPI for everything but those parts that are necessary for booting.

acpi=force
Always enable ACPI even if your computer has an old BIOS dated before the year
2000. This parameter also enables ACPI if it is set in addition to acpi=off.

pci=noacpi
Disables PCI IRQ routing of the new ACPI system.

For more information about these issues, search for Support Database articles with the
keyword “acpi” at https://portal.suse.com.

Once you have determined the right parameter combination, YaST automatically writes
them to the boot loader configuration to make sure that the system boots properly next
time.

If unexplainable errors occur when the kernel is loaded or during the installation, select
Memory Test in the boot menu to check the memory. If Memory Test returns an error,
it is usually a hardware error.

9.2.4 Machine Fails to Launch the Graphical
Installer

After you insert the first CD or DVD into your drive and rebooted your machine, the
installation screen comes up, but after you select Installation, the graphical installer
does not start.
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There are several ways to deal with this situation:

• Try to select another screen resolution for the installation dialogs.

• Select Text Mode for installation.

• Do a remote installation via VNC using the graphical installer.

To change to another screen resolution for installation, proceed as follows:

1 Boot for installation.

2 Press F3 to open a menu from which to select a lower resolution for installation
purposes.

3 Select Installation and proceed with the installation as described in Chapter 1,
Installation with YaST (page 3).

To perform an installation in text mode, proceed as follows:

1 Boot for installation.

2 Press F3 and select Text Mode.

3 Select Installation and proceed with the installation as described in Chapter 1,
Installation with YaST (page 3).

To perform a VNC installation, proceed as follows:

1 Boot for installation.

2 Enter the following text at the boot options prompt:
vnc=1 vncpassword=some_password

Replace some_password with the password to use for installation.

3 Select Installation then press Enter to start the installation.

Instead of starting right into the graphical installation routine, the system continues
to run in text mode then halts, displaying a message containing the IP address
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and port number under which the installer can be reached via a brower interface
or a VNC viewer application.

4 If using a browser to access the installer, launch the browser and enter the address
information provided by the installation routines on the future SUSE Linux ma-
chine and hit Enter :
http://ip_address_of_machine:5801

A dialog opens in the browser window prompting you for the VNC password.
Enter it and proceed with the installation as described in Chapter 1, Installation
with YaST (page 3).

IMPORTANT

Installation via VNC works with any browser under any operating system,
provided Java support is enabled.

If you use any kind of VNC viewer on your preferred operating system, enter
the IP address and password when prompted to do so. A window opens, displaying
the installation dialogs. Proceed with the installation as usual.

9.2.5 Machine Boots but Starts a
Minimalistic Boot Screen

You inserted the first CD or DVD into the drive, the BIOS routines are finished, but
the system does not start with the graphical boot screen. Instead it launches a very
minimalistic text-based interface. This might happen on any machine not providing
sufficient graphics memory for rendering a graphical boot screen.

Although the text boot screen looks minimalistic, it provides nearly the same function-
ality as the graphical one:

Boot Options
Unlike the graphical interface, the different boot options cannot be selected using
the cursor keys of your keyboard. The boot menu of the text mode boot screen offers
some keywords to enter at the boot prompt. These keywords map to the options
offered in the graphical version. Enter your choice and hit Enter to launch the boot
process.
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Custom Boot Options
After selecting a boot option, enter the appropriate keyword at the boot prompt or
enter some custom boot options as described in Section 9.2.3, “Installation Fails
and Machine Fails to Boot” (page 229). To launch the installation process, press
Enter .

Screen Resolutions
Use the F keys to determine the screen resolution for installation. If you need to
boot in text mode, choose F3 .

9.3 Boot Problems
Boot problems are situations when your system does not boot properly (that is, does
not boot to the expected runlevel and login screen).

9.3.1 Machine Loads the BIOS Properly but
Fails to Load the GRUB Boot Loader

If the hardware is functioning properly, it is possible that the boot loader has become
corrupted and Linux cannot start on the machine. In this case, it is necessary to reinstall
the boot loader.

To reinstall the boot loader, proceed as follows:

1 Insert the installation media into the drive.

2 Reboot the machine.

3 Select Installation from the boot menu.

4 In the first installation screen, select Expert and set the installation mode to Repair
Installed System.

5 Once in the YaST System Repair module, select Expert Tools then select Install
New Boot Loader.

6 Restore the original settings and reinstall the boot loader.
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7 Leave YaST System Repair and reboot the system.

Other reasons for the machine not booting may be BIOS-related:

BIOS Settings
Check your BIOS for references to your hard drive. GRUB might simply not be
started if the hard drive itself cannot be found with the current BIOS settings.

BIOS Boot Order
Check whether your system's boot order includes the hard disk. If the hard disk
option was not enabled, your system might install properly, but fail to boot when
access to the hard disk is required.

9.3.2 Machine Loads GRUB Properly and
Boots Linux but Text-Based Login Is
Presented Instead of Graphical Login

If the machine comes up, but does not boot into the graphical login manager, anticipate
problems either with the choice of the default runlevel or the configuration of the X
Window System. To check the runlevel configuration, log in as the root user and check
whether the machine is configured to boot into runlevel 5 (graphical desktop). A quick
way to check this is to examine the contents of /etc/inittab, as follows:
nld-machine:~ # grep "id:" /etc/inittab 
id:5:initdefault:
nld-machine:~ #

The returned line indicates that the machine's default runlevel (initdefault) is set
to 5 and that it should boot to the graphical desktop. If the runlevel is set to any other
number, use the YaST Runlevel Editor module to set it to 5.

IMPORTANT

Do not edit the runlevel configuration manually. Otherwise SuSEconfig (run by
YaST) will overwrite these changes on its next run. If you need to make manual
changes here, disable future SuSEconfig changes by setting CHECK_INITTAB
in /etc/sysconfig/suseconfig to no.
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If the runlevel is set to 5, you might have corruption problems with your desktop or X
Windows software. Examine the log files at /var/log/Xorg.*.log for detailed
messages from the X server as it attempted to start. If the desktop fails during start, it
might log error messages to /var/log/messages. If these error messages hint at
a configuration problem in the X server, try to fix these issues. If the graphical system
still does not come up, consider reinstalling the graphical desktop. For more information
about X server configuration, refer to Chapter The X Window System (↑Reference).

One quick test: the startx command should force the X Window System to start with
the configured defaults if the user is currently logged in on the console. If that does not
work, it should log errors to the console. For more information about the X Window
system configuration, refer to Chapter The X Window System (↑Reference).

9.4 Login Problems
Login problems are those where your machine does, in fact, boot to the expected wel-
come screen or login prompt, but refuses to accept the username and password or accepts
them but then does not behave properly (fails to start the graphic desktop, produces
errors, drops to a command line, etc.).

9.4.1 User Cannot Log In—Valid Username
and Password Combinations Not
Accepted

This usually occurs when the system is configured to use network authentication or
directory services and, for some reason, is unable to retrieve results from its configured
servers. The root user, as the only local user, is the only user that can still log in to these
machines. The following are some common reasons why a machine might appear
functional but be unable to process logins correctly:

• The network is not working. For further directions on this, turn to Section 9.5,
“Network Problems” (page 240).

• DNS is not working at the moment (which prevents GNOME or KDE from working
and the system from making validated requests to secure servers). One indication
that this is the case is that the machine takes an extremely long time to respond to
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any action. More information about this topic can be found in Section 9.5, “Network
Problems” (page 240).

• If the system is configured to use Kerberos, the system's local time might have
drifted past the accepted variance with the Kerberos server time (this is typically
300 seconds). If NTP (network time protocol) is not working properly or local NTP
servers are not working, Kerberos authentication ceases to function because it de-
pends on common clock synchronization across the network.

• The system's authentication configuration is misconfigured. Check the PAM confi-
guration files involved for any typos or misordering of directives. For additional
background information about PAM and the syntax of the configuration files in-
volved, refer to Chapter Authentication with PAM (↑Reference).

In all cases that do not involve external network problems, the solution is to reboot the
system into a single-user mode and repair the configuration before booting again into
operating mode and attempting to log in again.

To boot into single-user mode:

1 Reboot the system. The boot screen appears, offering a prompt.

2 Enter 1 at the boot prompt to make the system boot into single-user mode.

3 Enter the username and password for root.

4 Make all the necessary changes.

5 Boot into the full multiuser and network mode by entering telinit 5 at the
command line.

9.4.2 User Cannot Log In—Particular Valid
Username and Password Not
Accepted

This is by far the most common problem users encounter, because there are many reasons
this can occur. First, if using network authentication, determine that the user's username
and password do, in fact, work on other (properly functioning) machines. See if another
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user can log in to the misbehaving machine. If another user can log in without difficulty
or if root can log in, log in and examine the /var/log/messages file. Locate the
time stamps that correspond to the login attempts and determine if PAM has produced
any coherent error messages.

The following are some common reasons why authentication for a particular user might
fail on a specific machine:

• The username exists in the machine's local authentication files and is also provided
by a network authentication system, causing conflicts.

• The home directory exists but is corrupt or unavailable. Perhaps it is write protected
or is on a server that is inaccessible at the moment.

• The user does not have permission to log in to that particular host in the authentica-
tion system.

• The machine has changed hostnames, for whatever reason, and the user does not
have permission to log in to that host.

• The machine cannot reach the authentication server or directory server that contains
that user's information.

• There might be problems with the X Window System authenticating this particular
user, especially if the user's home has been used with another Linux distribution
prior to installing the current one.

• Check whether the user remembered his password correctly before trying to debug
the whole authentication mechanism on the misbehaving machine. If the user indeed
entered the wrong password, use the YaST User Management module to change
the user's password.

To locate the cause of the login problems, try the following options:

1 Try to log in from a console (using Ctrl + Alt + F1 ).

If this is successful, the blame cannot be put on PAM or the directory server on
which the user's home is hosted, because it is possible to authenticate this user
on this machine. Try to locate any problems with the X Window System or the
desktop (GNOME or KDE). For more information, refer to Section 9.4.3, “ Login
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Successful but GNOME Desktop Fails ” (page 238) and Section 9.4.4, “ Login
Successful but KDE Desktop Fails” (page 239).

2 If the user's home directory has been used with another Linux distribution, remove
the Xauthority file in the user's home. Use a console login via Ctrl + Alt +
F1 and run rm .Xauthority as this user. This should eliminate X authenti-
cation problems for this user. Try a graphical login again.

3 If graphical login still fails, do a console login with Ctrl + Alt + F1 . Try to start
an X session on another display, the first one (:0) is already in use:
startx -- :1

This should bring up a graphical screen and your desktop. If it does not, check
the log files of the X Window System (/var/log/Xorg.displaynumber
.log) or the log file for your desktop applications (.xsession-errors in
the user's home directory) for any irregularities.

4 If the desktop could not start because of corrupt configuration files, proceed with
Section 9.4.3, “ Login Successful but GNOME Desktop Fails ” (page 238) or
Section 9.4.4, “ Login Successful but KDE Desktop Fails” (page 239).

9.4.3 Login Successful but GNOME Desktop
Fails

If this is true for a particular user, it is likely that the user's GNOME configuration files
have become corrupted. Some symptoms might include the keyboard failing to work,
the screen geometry becoming distorted, or even the screen coming up as a bare gray
field. The important distinction is that if another user logs in, the machine works nor-
mally. If this is the case, it is likely that the problem can be fixed relatively quickly by
simply moving the user's GNOME configuration directory to a new location, which
causes GNOME to initialize a new one. Although the user is forced to reconfigure
GNOME, no data is lost.

1 Log in as root.

2 cd to the user's home directory.

3 Move the user's GNOME configuration directories to a temporary location:
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mv ./gconf ./gconf-ORIG-RECOVER
      mv ./gnome2 ./gnome2-ORIG-RECOVER

4 Log out.

5 Have the user log in, but do not allow him to run any applications.

6 Recover the user's individual application configuration data (including the Evo-
lution e-mail client data) by copying the ~/gconf-ORIG-RECOVER/apps/
directory back into the new ~/gconfdirectory as follows:
cp -a ./gconf-ORIG-RECOVER/apps ./gconf/

If this causes the login problems, attempt to recover only the critical application
data and force the user to reconfigure the remainder of the applications.

9.4.4 Login Successful but KDE Desktop
Fails

There are several reasons why a KDE desktop would not allow users to login. Corrupted
cache data can cause login problems as well as corrupt KDE desktop configuration
files.

Cache data is used at desktop start-up to increase performance. If this data is corrupted,
start-up is slowed down or fails entirely. Removing them forces the desktop start-up
routines to start from scratch. This takes more time than a normal start-up, but data is
intact after this and the user can login.

To remove the cache files of the KDE desktop, issue the following command as root:
rm -rf /tmp/kde-user /tmp/socket-user

Replace user with the actual username. Removing these two directories just removes
the corrupted cache files, no real data is harmed using this procedure.

Corrupted desktop configuration files can always be replaced with the initial configura-
tion files. If you want to recover the user's adjustments, carefully copy them back from
their temporary location, after the configuration has been restored using the default
configuration values.
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To replace a corrupted desktop configuration with the initial configuration values,
proceed as follows:

1 Log in as root.

2 Enter the user's home directory:
cd /home/user

3 Move the KDE configuration directory and the .skel files to a temporary loca-
tion:
mv .kde.kde-ORIG-RECOVER 
mv .skel .skel-ORIG-RECOVER

4 Log out.

5 Let the user log in to this machine.

6 After the desktop has started successfully, copy the user's own configurations
adjustments back into place:
user@nld-machine:~ > cp -a .kde-ORIG-RECOVER/share .kde/share

IMPORTANT

If the user's own adjustments caused the login to fail and continue to do
so, repeat the procedure as described above, but do not copy the .kde/
share directory.

9.5 Network Problems
Many problems of your system may be network-related, even though they do not seem
to be at first. For example, the reason for a system not allowing users to log in might
be a network problem of some kind. This section introduces a simple check list you
can apply to identify the cause of any network problem encountered.

When checking the network connection of your machine, proceed as follows:
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1 If using an ethernet connection, check the hardware first. Make sure that your
network cable is properly plugged into your computer. The control lights next
to your Ethernet connector, if available, should both be active.

If the connection fails, check whether your network cable works with another
machine. If it does, your network card causes the failure. If hubs or switches are
included in your network setup, suspect them to be the culprits as well.

2 If using a wireless connection, check whether the wireless link can be established
by other machines. If this is not the case, contact the wireless network's adminis-
trator.

3 Once you have checked your basic network connectivity, try to find out which
service is not responding.

Gather the address information of all network servers needed in your setup. Either
look them up in the appropriate YaST module or ask your system administrator.
The following list gives some of the typical network servers involved in a setup
together with the symptoms of an outage.

DNS (Name Service)
A broken or malfunctioning name service affects the network's functioning
in many ways. If the local machine relies on any network servers for authen-
tication and these servers cannot be found due to name resolution issues,
users would not even be able to log in. Machines in the network managed by
a broken name server would not be able to “see” each other and communicate.

NTP (Time Service)
A malfunctioning or completely broken NTP service could affect Kerberos
authentication and X server functionality.

NFS (File Service)
If any application needed data stored in an NFS mounted directory, it would
not be able to start up or function properly if this service was down or mis-
configured. In a worst case scenario, a user's personal desktop configuration
would not come up if his home directory containing his .gconf or .kde
subdirectories could not be found due to an outage of the NFS server.

Samba (File Service)
If any application needed data stored in a directory on a Samba server, it
would not be able to start or function properly if this service was down.
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NIS (User Management)
If your SUSE Linux system relied on a NIS server to provide the user data,
users would not be able to log in to this machine if the NIS service was down.

LDAP (User Management)
If your SUSE Linux system relied on an LDAP server to provide the user
data, users would not be able to log in to this machine if the LDAP service
was down.

Kerberos (Authentication)
Authentication would not work and login to any machine would fail.

CUPS (Network Printing)
Users would not be able to print.

4 Check whether the network servers are running and whether your network setup
allows you to establish a connection:

a Use ping hostname (replace hostname with the hostname of the
server) to check whether each one of them is up and responding to the net-
work. If this command is successful, it tells you that the host you were
looking for is up and running and that the name service for your network is
configured correctly.

If ping fails with destination host unreachable, either your
system or the desired server is not properly configured or down. Check
whether your system is reachable by running ping your_hostname
from another machine. If you succeed to reach your machine from another
machine, it is the server that is not running at all or not configured correctly.

If ping fails with unknown host, the name service is not configured
correctly or the hostname used was incorrect. Use ping -n ipaddress
to try to connect to this host without name service. If this is successful,
check the spelling of the hostname and for a misconfigured name service
in your network. For further checks on this matter, refer to Step 4.b
(page 242). If ping still fails, either your network card is not configured
correctly or your network hardware is faulty. Refer to Step 4.c (page 244)
for information about this.

b Use host hostname to check whether the hostname of the server you
are trying to connect to is properly translated into an IP address and vice
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versa. If this command returns the IP address of this host, the name service
is up and running. If this the host command fails, check all network confi-
guration files relevant to name and address resolution on your host:

/etc/resolv.conf
This file is used to keep track of the name server and domain you are
currently using. It can be modified manually or be automatically adjusted
by YaST or DHCP. Automatic adjustment is preferable. However, make
sure that this file has the following structure and all network addresses
and domain names are correct:
search fully_qualified_domain_name
nameserveripaddress_of_nameserver

This file can contain more than one name server address, but at least
one of them must be correct to provide name resolution to your host. If
needed, adjust this file using the YaST DNS and Hostname module.

If your network connection is handled via DHCP, enable DHCP to
change hostname and name service information by selecting Change
Hostname via DHCP and Update Name Servers and Search List via
DHCP in the YaST DNS and Hostname module.

/etc/nsswitch.conf
This file tells Linux where to look for name service information. It should
look like this:
...
hosts: files dns
networks: files dns
...

The dns entry is vital. It tells Linux to use an external name server.
Normally, these entries are automatically made by YaST, but it never
hurts to check.

If all the relevant entries on the host are correct, let your system admin-
istrator check the DNS server configuration for the correct zone infor-
mation. For detailed information about DNS, refer to Chapter The Do-
main Name System (↑Reference). If you have made sure that the DNS
configuration of your host and the DNS server are correct, proceed with
checking the configuration of your network and network device.
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c If your system cannot establish a connection to a network server and you
have excluded name service problems from the list of possible culprits,
check the configuration of your network card.

Use the command ifconfig network_device (executed as root) to
check whether this device was properly configured. Make sure that both
inet address and Mask are configured correctly. An error in the IP
address or a missing bit in your network mask would render your network
configuration unusable. If necessary, perform this check on the server as
well.

d If name service and network hardware are properly configured and running,
but some external network connections still get long time-outs or fail entirely,
use traceroute fully_qualified_domain_name (executed as
root) to track the network route these requests are taking. This command
lists any gateway (hop) a request from your machine passes on its way to
its destination. It lists the response time of each hop and whether this hop
is reachable at all. Use a combination of traceroute and ping to track down
the culprit and let the administrators know.

Once you have identified the cause of your network trouble, you can resolve it yourself
(if the problem is located on your machine) or let the system administrators of your
network know about your findings so they can reconfigure the services or repair the
necessary systems.

9.6 Data Problems
Data problems are when the machine might or might not boot properly but, in either
case, it is clear that there is data corruption on the system and that the system needs to
be recovered. These situations call for a backup of your critical data, enabling you to
recover the status quo once your system failed. SUSE Linux offers dedicated YaST
modules for system backup and restoration as well as a rescue system that can be used
to recover a corrupted system from the outside.

9.6.1 Backing Up Critical Data
System backups can be easily managed using the YaST System Backup module:
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1 As root, start YaST and select System → System Backup.

2 Create a backup profile holding all details needed for the backup, filename of
the archive file, scope, and type of the backup:

a Select Profile Management → Add.

b Enter a name for the archive.

c Enter the path to the location of the backup if you want to keep a local
backup. For your backup to be archived on a network server (via NFS),
enter the IP address or name of the server and the directory that should hold
your archive.

d Determine the archive type and click Next.

e Determine the backup options to use, such as whether files not belonging
to any package should be backed up and whether a list of files should be
displayed prior to creating the archive. Also determine whether changed
files should be identified using the time-consuming MD5 mechanism.

Use Expert to enter a dialog for the backup of entire hard disk areas. Cur-
rently, this option only applies to the Ext2 file system.

f Finally, set the search constraints to exclude certain system areas from the
backup area that do not need to be backed up, such as lock files or cache
files. Add, edit, or delete items, until your needs are met and leave withOK.

3 Once you have finished the profile settings, you can start the backup right away
with Start or configure automatic backup. It is also possible to create other profiles
tailored for various other purposes.

To configure automatic backup for a given profile, proceed as follows:

1 Select Automatic Backup from the Profile Management menu.

2 Select Start Backup Automatically.

3 Determine the backup frequency. Choose daily, weekly, or monthly.
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4 Determine the backup start time. These settings depend on the backup frequency
selected.

5 Decide whether to keep old backups and how many should be kept. To receive
an automatically generated status message of the backup process, check Send
Summary Mail to user root.

6 Click OK for your settings to be applied and the first backup started at the time
specified.

9.6.2 Restoring a System Backup
Use the YaST System Restoration module to restore the system configuration from a
backup. Restore the entire backup or select specific components that were corrupted
and need to be reset to their old state.

1 Start YaST → System → System Restoration.

2 Enter the location of the backup file. This could be a local file, a network
mounted file, or a file on a removable device, such as a floppy or a CD. Then
click Next.

The following dialog displays a summary of the archive properties, such as the
filename, date of creation, type of backup and optional comments.

3 Review the archived content by clicking Archive Content. Clicking OK returns
you to the Archive Properties dialog.

4 Expert Option opens a dialog in which to fine-tune the restore process. Return
to the Archive Properties dialog by clicking OK.

5 Click Next to open the view of packages to restore.

Press Accept to restore all files in the archive or use the various Select buttons
for a fine-tuning of your selection. Only check the Restore RPM database option
if it is corrupted or deleted and if this file is included in the backup.

6 After you click Accept, the backup is restored. Click Finish to leave the module
after the restore process is completed.
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9.6.3 Recovering a Corrupted System
There are several reasons why a system could fail to come up and run properly. A cor-
rupted file system after a system crash, corrupted configuration files, or a corrupted
boot loader configuration are the most common ones.

SUSE Linux offers a graphical front-end for system repair. The following section intro-
duces the YaST System Repair module.

Using YaST System Repair
Before launching the YaST System Repair module, determine in which mode to run it
to best fit your needs. Depending on the severeness and cause of your system failure
and your expertise, there are three different modes to choose from:

Automatic Repair
If your system failed due to an unknown cause and you basically do not know which
part of the system is to blame for the failure, use Automatic Repair. An extensive
automated check will be performed on all components of your installed system. For
a detailed description of this procedure, refer to Section “Automatic Repair”
(page 248).

Customized Repair
If your system failed and you already know which component is to blame, you can
cut the lengthy system check with Automatic Repair short by limiting the scope of
the system analysis to those components. For example, if the system messages prior
to the failure seem to indicate an error with the package database, you can limit the
analysis and repair procedure to checking and restoring this aspect of your system.
For a detailed description of this procedure, refer to Section “Customized Repair”
(page 249).

Expert Tools
If you already have a clear idea of what component failed and how this should be
fixed, you can skip the analysis runs and directly apply the tools necessary for the
repair of the respective component. For details, refer to Section “Expert Tools”
(page 250).

Choose one of the repair modes as described above and proceed with the system repair
as outlined in the following sections.
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Automatic Repair

To start the automatic repair mode of YaST System Repair, proceed as follows:

1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.

3 Select Automatic Repair.

YaST now launches an extensive analysis of the installed system. The progress
of the procedure is displayed at the bottom of the screen with two progress bars.
The upper bar shows the progress of the currently running test. The lower bar
shows the overall progress of the analysis. The log window in the top section
tracks the currently running test and its result. See Figure 9.2, “Automatic Repair
Mode” (page 248). The following main test runs are performed with every run.
They contain, in turn, a number of individual subtests.

Figure 9.2 Automatic Repair Mode

Partition Tables of All Hard Disks
Checks the validity and coherence of the partition tables of all detected hard
disks.
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Swap Partitions
The swap partitions of the installed system are detected, tested, and offered
for activation where applicable. The offer should be accepted for the sake of
a higher system repair speed.

File Systems
All detected file systems are subjected to a file system–specific check.

Entries in the File /etc/fstab
The entries in the file are checked for completeness and consistency. All valid
partitions are mounted.

Boot Loader Configuration
The boot loader configuration of the installed system (GRUB or LILO) is
checked for completeness and coherence. Boot and root devices are examined
and the availability of the initrd modules is checked.

Package Database
This checks whether all packages necessary for the operation of a minimal
installation are present. While it is optionally possible also to analyze the
base packages, this takes a long time because of their vast number.

4 Whenever an error is encountered, the procedure stops and a dialog opens outlin-
ing the details and possible solutions.

Read the screen messages carefully before accepting the proposed fix. If you
decide to decline a proposed solution, your system remains unchanged.

5 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

Customized Repair

To launch the Customized Repair mode and selectively check certain components of
your installed system, proceed as follows:

1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.
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3 Select Customized Repair.

Choosing Customized Repair shows a list of test runs that are all marked for ex-
ecution at first. The total range of tests matches that of automatic repair. If you
already know where no damage is present, unmark the corresponding tests.
Clicking Next starts a narrower test procedure that probably has a significantly
shorter running time.

Not all test groups can be applied individually. The analysis of the fstab entries
is always bound to an examination of the file systems, including existing swap
partitions. YaST automatically resolves such dependencies by selecting the
smallest number of necessary test runs.

4 Whenever an error is encountered, the procedure stops and a dialog opens outlin-
ing the details and possible solutions.

Read the screen messages carefully before accepting the proposed fix. If you
decide to decline a proposed solution, your system remains unchanged.

5 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

Expert Tools

If you are knowledgeable with SUSE Linux and already have a very clear idea of what
needs to be repaired in your system, directly apply the tools skipping the system analysis.

To make use of the Expert Tools feature of the YaST System Repair module, proceed
as follows:

1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.

3 Select Expert Tools.

Choose one or more of the following options to repair your faulty system:
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Install New Boot Loader
This starts the YaST boot loader configuration module. Find details in Sec-
tion “Configuring the Boot Loader with YaST” (Chapter 29, The Boot
Loader, ↑Reference).

Run Partitioning Tool
This starts the expert partitioning tool in YaST. Find details in Section 3.7.5,
“Partitioner” (page 86).

Fix File System
This checks the file systems of your installed system. You are first offered a
selection of all detected partitions and can then choose the ones to check.

Restore Lost Partitions
It is possible to attempt to reconstruct damaged partition tables. A list of de-
tected hard disks is presented first for selection. ClickingOK starts the exam-
ination. This can take a while depending on the processing power and size
of the hard disk.

IMPORTANT: Reconstructing a Partition Table

The reconstruction of a partition table is tricky. YaST attempts to
recognize lost partitions by analyzing the data sectors of the hard
disk. The lost partitions are added to the rebuilt partition table when
recognized. This is, however, not successful in all imaginable cases.

Save System Settings to Disk
This option saves important system files to a floppy disk. If one of these files
become damaged, it can be restored from disk.

Check Installed Software
This checks the consistency of the package database and the availability of
the most important packages. Any damaged installed packages can be rein-
stalled with this tool.

4 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

Common Problems and Their Solutions 251



9.7 Support for SUSE Linux
Useful support information for SUSE Linux is available in a number of sources. If you
encounter problems with the installation or use of SUSE Linux that you are unable to
solve, our experienced support staff can offer practical assistance with the free installa-
tion support for registered products and the incident-based support by phone or e-mail.
Nearly all common customer problems can be eliminated quickly and competently.

9.7.1 Advanced Support
Qualified support is available by phone and e-mail at transparent rates. SUSE Linux
10.0 comes with 90-day installation support. Additionally, if you are running SUSE
Linux for personal use, you can take advantage of our at-home Advanced Support
program. You can reach us by phone:

• Germany: 0190-86 28 00 (1.86 €/minute)

• Austria: 0900-47 01 10 (1.80 €/minute)

• Switzerland: 0900-70 07 10 (3.13 SFr/minute)

• Rest of Europe: Phone: +44-1344-326-666, Price: € 46 including VAT. Monday-
Friday from 12:00 to 18:00 CET

• United States and Canada: Phone: +1-800-796-3700. Price: $39 including tax.
Monday-Friday from 09:00 a.m. to 06:00 p.m. EST or 06:00 a.m. to 03:00 p.m.
PST.

• All other countries: Phone: +44-1344-326-666, Price: € 46 including VAT, Monday-
Friday, 12:00-18:00 CET

One incident covers up to twenty minutes of assistance from our experienced support
staff. The payment is credit-card based. Visa, Eurocard, and Mastercard are accepted.
Financial transactions may be handled by our service partner, Stream / ECE EMEA
Ltd.

Please be aware that the phone numbers may change during the sales cycle of SUSE
Linux 10.0. Current numbers as well as a detailed listing of the subjects covered by the
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Advanced Support Service can be found at http://www.novell.com/
usersupport.

NOTE

While our expert staff will do their best to provide top-quality support, we
cannot guarantee a solution.

We endeavor to help you as quickly and precisely as possible. The effort and time
needed is considerably reduced if the question is formulated clearly. Please have answers
to the following questions ready before contacting us:

1. Which program and version are you using? During which process does the
problem occur?

2. What exactly is the problem? Try to describe the error as precisely as possible,
using phrases with words such as when (for example, “When X is pressed, this
error appears”).

3. What hardware do you use (graphics card, monitor, printer, ISDN card, etc.)?

Detailed documentation can be found in manuals, online help, and the Support Database.
In most cases, even problems that seem more difficult to solve are covered in the
comprehensive documentation included with SUSE Linux. The SUSE Help Center on
your desktop provides additional information about installed packages, the vital
HOWTOs, and info pages.

You can access the latest Support Database articles online at http://www.novell
.com/usersupport. By means of the Support Database, which is one of the most
frequently used databases in the Linux world, we offer our customers a wealth of
analysis and solution approaches. You can retrieve tested solutions using the keyword
search, history function, or version-dependent search.

9.7.2 Free Installation Support
Our free installation support is provided for a period of 90 days following the activation
of your registration code (starting latest with the release of a new version). If you cannot
find an answer to your question in any of the available information sources, we will
gladly provide assistance for the following issues:
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• Installation on a typical private workstation or laptop equipped with a single pro-
cessor, at least 256 MB RAM, and 3 GB of free hard disk space.

• Resizing of one Windows partition that occupies the entire hard disk.

• Installation of a local ATAPI CD or DVD drive.

• Installation on the first or second hard disk in an IDE-only system (/dev/hda or
/dev/hdb) or supported S-ATA system, excluding RAID.

• Integration of a standard keyboard and standard mouse.

• Configuration of the graphical user interface (without the hardware acceleration
feature of the graphics card).

• Installation of the boot manager in the MBR of the first hard disk or on a floppy
disk without modifying the BIOS mapping.

• Setup of Internet access with a supported PCI ISDN card or external serial modem
(not USB). Alternatively, setup of DSL based on PPPoE with a supported NIC.

• Basic configuration of an ALSA-supported PCI sound card.

• Basic configuration of a locally-attached compatible printer with YaST.

• Basic configuration of an IDE CD writer for use with k3b (CD burning application)
without changing the jumper setting.

• Configuration of a supported PCI ethernet card for LAN access with either DHCP
(client) or static IP. This does not include the configuration of the LAN or any
other computers or network components. It also does not cover the configuration
of the computer as a router. Fault analysis is limited to checking for proper loading
of the kernel module and the correct local network settings.

• Configuration of an e-mail client (only Evolution and KMail) for collecting mail
from a POP3 account. Fault analysis is limited to checking for proper settings in
the e-mail client.

• Support for the package selection Standard System.

• Upgrade from the previous version of the product.
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• Kernel updates (only official SUSE Linux update RPMs).

• Installation of bug fixes and security updates from ftp.suse.com or a SUSE FTP
mirror using YOU or the manual method.

For a detailed listing of the subjects covered by the free installation support, please
check http://www.novell.com/usersupport.

Contact Information for Free Installation Support

• http://www.novell.com/usersupport

• usersupport@novell.com

• Germany: Phone: 0180-500 36 12 (12 Cent/min) (Monday through Friday from
13:00 to 17:00 CET)

• Austria: Phone: +43 1 36 77 4440 (Monday through Friday from 13:00 to 17:00
CET)

• Switzerland: Phone: +41 43 299 7800 (Monday through Friday from 13:00 to 17:00
CET)

• UK: Phone: +44-1344-326-666 (Monday through Friday from 13:00 to 17:00 GMT)

• United States and Canada: Phone: +1-800-796-3700 (Monday through Friday from
12:00 p.m. to 6:00 p.m. EST or 09:00 a.m. to 03:00 p.m. PST)

• France: Phone: +33 1 55 62 50 50 (Monday through Friday from 13:00 to 17:00
CET)

• Spain: Phone: +34 (0)91 375 3057 (Monday through Friday from 13:00 to 17:00
CET)

• Italy: Phone: +39 02 2629 5555, support is available in Italian (Monday through
Friday from 13:00 to 17:00 CET)

• Czech Republic: E-mail:support@portal.suse.cz (Monday through Friday)

• All other countries: Support is provided in English only. Phone: +44-1344-326-666
(Monday through Friday from 12:00 to 18:00 CET)
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For the most recent contact information, refer to http://www.novell.com/
products/linuxprofessional/support/contact.html.

Important Notes
1. Only customers with a valid, activated registration code are entitled to free sup-

port. You can activate your registration code athttp://www.novell.com/
usersupport.

2. The registration code is not transferable to another person.

3. The free support covers only the initial installation on one computer. Refer to
our Web site for further information.

4. We can provide support only for hardware supported by SUSE Linux. Refer to
our Component Database atwww.novell.com/usersupport/hardware
for information about supported hardware components.

5. There are no guaranteed turnaround times for mail inquiries.

Contact Recommendations
Misspelled commands, links, or directory names often cause frustrating problems and
are particularly common during phone conversations. To help prevent this problem,
please send us a brief description of your question or problem by e-mail. You will receive
a reply soon after that provides a practical solution.
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10File System Checking
Each Linux file system comes with its own set of analysis and repair utilities. Use these
tools in the event of a system failure to first analyze then repair the corrupted file system.
Because their documentation (man pages) is only available in a running system, it is
included in this manual for printed reference.

10.1 Manual Page of reiserfsck
REISERFSCK(8)                                       REISERFSCK(8)

NAME
       reiserfsck - The checking tool for the ReiserFS filesystem.

SYNOPSIS
       reiserfsck [ -afprVy ] [ --rebuild-sb |  --check  |  --fix-
       fixable  |  --rebuild-tree  |  --clean-attributes  ] [ -j |
       --journal device ] [ -z | --adjust-size ] [ -n | --nolog  ]
       [  -B  |  --badblocks file ] [ -l | --logfile file ] [ -q |
       --quiet ] [ -y | --yes ] [ -S | --scan-whole-partition ]  [
       --no-journal-available ] device

DESCRIPTION
       Reiserfsck  searches for a Reiserfs filesystem on a device,
       replays any necessary transactions, and  either  checks  or
       repairs the file system.

       device is  the special file corresponding to a device or to
              a partition (e.g /dev/hdXX for an IDE disk partition
              or /dev/sdXX for a SCSI disk partition).

OPTIONS
       --rebuild-sb
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              This  option  recovers  the superblock on a Reiserfs
              partition.  Normally you only need  this  option  if
              mount  reports "read_super_block: can't find a reis-
              erfs file system" and you are sure that  a  Reiserfs
              file  system is there. But remember that if you have
              used some partition editor program and now you  can-
              not  find  a filesystem, probably something has gone
              wrong while repartitioning and the start of the par-
              tition  has been changed. If so, instead of rebuild-
              ing the super block on a wrong place you should find
              the correct start of the partition first.

       --check
              This  default  action  checks filesystem consistency
              and reports, but does not repair any corruption that
              it  finds.  This  option  may be used on a read-only
              file system mount.

       --fix-fixable
              This option recovers  certain  kinds  of  corruption
              that  do not require rebuilding the entire file sys-
              tem tree (--rebuild-tree). Normally  you  only  need
              this  option  if the --check option reports "corrup-
              tion that can be  fixed  with  --fix-fixable".  This
              includes:  zeroing invalid data-block pointers, cor-
              recting st_size and st_blocks for  directories,  and
              deleting invalid directory entries.

       --rebuild-tree
              This  option  rebuilds  the  entire  filesystem tree
              using leaf nodes found on the device.  Normally  you
              only  need  this  option  if  the reiserfsck --check
              reports "Running with --rebuild-tree  is  required".
              You are strongly encouraged to make a backup copy of
              the whole partition before attempting the --rebuild-
              tree   option.  Once  reiserfsck  --rebuild-tree  is
              started it must finish its work (and you should  not
              interrupt it), otherwise the filesystem will be left
              in the unmountable state to  avoid  subsequent  data
              corruptions.

       --clean-attributes
              This  option  cleans  reserved  fields  of Stat-Data
              items. There were days when there were  no  extended
              attributes  in  reiserfs. When they were implemented
              old partitions needed to be cleaned first  --  reis-
              erfs  code in the kernel did not care about not used
              fields in its strutures. Thus if you have  used  one
              of  the  old (pre-attrbutes) kernels with a ReiserFS
              filesystem and you want to  use  extented  attribues
              there, you should clean the filesystem first.

       --journal device , -j device
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              This  option supplies the device name of the current
              file system journal.  This option is  required  when
              the  journal  resides  on a separate device from the
              main data device (although it can  be  avoided  with
              the expert option --no-journal-available).

       --adjust-size, -z
              This  option causes reiserfsck to correct file sizes
              that are larger than the offset of the last  discov-
              ered  byte.  This implies that holes at the end of a
              file will be removed.  File sizes that  are  smaller
              than the offset of the last discovered byte are cor-
              rected by --fix-fixable.

       --badblocks file, -B  file
              This option sets the badblock list to be the list of
              blocks specified in the given `file`. The filesystem
              badblock list is cleared  before  the  new  list  is
              added.  It can be used with --fix-fixable to fix the
              list of badblocks (see  debugreiserfs  -B).  If  the
              device  has  bad blocks, every time it must be given
              with the --rebuild-tree option.

       --logfile file, -l  file
              This option causes reiserfsck to report any  corrup-
              tion  it finds to the specified log file rather than
              to stderr.

       --nolog, -n
              This option prevents reiserfsck from  reporting  any
              kinds of corruption.

       --quiet, -q
              This  option  prevents reiserfsck from reporting its
              rate of progress.

       --yes, -y
              This option inhibits reiserfsck from asking you  for
              confirmation  after  telling you what it is going to
              do. It will assuem you confirm. For safety, it  does
              not work with the --rebuild-tree option.

       -a, -p These  options  are usually passed by fsck -A during
              the automatic checking of those partitions listed in
              /etc/fstab.  These options cause reiserfsck to print
              some information about the specified filesystem,  to
              check  if  error flags in the superblock are set and
              to do some  light-weight  checks.  If  these  checks
              reveal a corruption or the flag indicating a (possi-
              bly  fixable)  corruption  is  found  set   in   the
              superblock, then reiserfsck switches to the fix-fix-
              able mode. If the flag indicating a fatal corruption
              is  found  set  in  the  superblock, then reiserfsck
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              finishes with an error.

       -V     This option prints  the  reiserfsprogs  version  and
              then exit.

       -r, -f These  options are not yet operational and therefore
              are ignored.

EXPERT OPTIONS
       DO NOT USE THESE OPTIONS  UNLESS  YOU  KNOW  WHAT  YOU  ARE
       DOING.  WE ARE NOT RESPONSIBLE IF YOU LOSE DATA AS A RESULT
       OF THESE OPTIONS.

       --no-journal-available
              This option allows reiserfsck to  proceed  when  the
              journal  device is not available. This option has no
              effect when the journal is located on the main  data
              device.  NOTE:  after  this  operation  you must use
              reiserfstune to specify a new journal device.

       --scan-whole-partition, -S
              This option causes --rebuild-tree to scan the  whole
              partition  but not only the used space on the parti-
              tion.

AN EXAMPLE OF USING reiserfsck
       1. You think something may be wrong with a reiserfs  parti-
       tion on /dev/hda1 or you would just like to perform a peri-
       odic disk check.

       2. Run reiserfsck --check --logfile check.log /dev/hda1. If
       reiserfsck  --check  exits with status 0 it means no errors
       were discovered.

       3. If reiserfsck --check exits with status 1  (and  reports
       about  fixable  corruptions)  it  means that you should run
       reiserfsck --fix-fixable --logfile fixable.log /dev/hda1.

       4. If reiserfsck --check exits with status 2  (and  reports
       about  fatal  corruptions)  it  means  that you need to run
       reiserfsck --rebuild-tree.  If reiserfsck --check fails  in
       some way you should also run reiserfsck --rebuild-tree, but
       we also encourage you to submit this as a bug report.

       5. Before running reiserfsck --rebuild-tree, please make  a
       backup  of  the whole partition before proceeding. Then run
       reiserfsck --rebuild-tree --logfile rebuild.log  /dev/hda1.

       6.  If the reiserfsck --rebuild-tree step fails or does not
       recover what you expected, please  submit  this  as  a  bug
       report.  Try  to  provide  as  much information as possible
       including your platform and Linux kernel version.  We  will
       try to help solve the problem.
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EXIT CODES
       reiserfsck uses the following exit codes:
          0 - No errors.
          1 - File system errors corrected.
          2 - Reboot is needed.
          4 - File system fatal errors left uncorrected,
              reiserfsck --rebuild-tree needs to be launched.
          6 - File system fixable errors left uncorrected,
              reiserfsck --fix-fixable needs to be launched.
          8 - Operational error.
          16 - Usage or syntax error.

AUTHOR
       This version of reiserfsck has been written by Vitaly Fert-
       man <vitaly@namesys.com>.

BUGS
       Please report bugs to the  ReiserFS  developers  <reiserfs-
       dev@namesys.com>,  providing  as much information as possi-
       ble--your hardware, kernel, patches, settings, all  printed
       messages,  the  logfile;  check  the  syslog  file  for any
       related information.

TODO
       Faster recovering, signal handling.

SEE ALSO
       mkreiserfs(8),  reiserfstune(8)  resize_reiserfs(8),  debu-
       greiserfs(8),

Reiserfsprogs-3.6.18       February 2004             REISERFSCK(8)

10.2 Manual Page of e2fsck
E2FSCK(8)                                                E2FSCK(8)

NAME
       e2fsck - check a Linux ext2/ext3 file system

SYNOPSIS
       e2fsck  [ -pacnyrdfkvstDFSV ] [ -b superblock ] [ -B block-
       size ] [ -l|-L bad_blocks_file ] [ -C fd ] [  -j  external-
       journal ] [ -E extended_options ] device

DESCRIPTION
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       e2fsck is used to check a Linux second extended file system
       (ext2fs).  E2fsck also supports ext2 filesystems  countain-
       ing  a  journal,  which  are  also  sometimes known as ext3
       filesystems, by first applying the journal to the  filesys-
       tem before continuing with normal e2fsck processing.  After
       the journal has been applied, a filesystem will normally be
       marked  as clean.  Hence, for ext3 filesystems, e2fsck will
       normally run the journal and exit,  unless  its  superblock
       indicates that further checking is required.

       device  is  the  device file where the filesystem is stored
       (e.g.  /dev/hdc1).

OPTIONS
       -a     This option does the same thing as  the  -p  option.
              It  is provided for backwards compatibility only; it
              is suggested that people use -p option whenever pos-
              sible.

       -b superblock
              Instead  of  using  the  normal  superblock,  use an
              alternative  superblock  specified  by   superblock.
              This  option  is  normally  used  when  the  primary
              superblock has been corrupted.  The location of  the
              backup  superblock  is dependent on the filesystem's
              blocksize.  For filesystems with  1k  blocksizes,  a
              backup  superblock  can  be found at block 8193; for
              filesystems with 2k blocksizes, at block 16384;  and
              for 4k blocksizes, at block 32768.

              Additional  backup  superblocks can be determined by
              using the mke2fs program  using  the  -n  option  to
              print  out where the superblocks were created.   The
              -b option to mke2fs, which  specifies  blocksize  of
              the  filesystem  must  be specified in order for the
              superblock locations that  are  printed  out  to  be
              accurate.

              If  an  alternative  superblock is specified and the
              filesystem is not opened read-only, e2fsck will make
              sure  that  the primary superblock is updated appro-
              priately upon completion of the filesystem check.

       -B blocksize
              Normally, e2fsck will search for the  superblock  at
              various  different block sizes in an attempt to find
              the appropriate block  size.   This  search  can  be
              fooled  in some cases.  This option forces e2fsck to
              only try locating the  superblock  at  a  particular
              blocksize.   If  the superblock is not found, e2fsck
              will terminate with a fatal error.

       -c     This option causes e2fsck to  run  the  badblocks(8)
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              program  to  find  any  blocks  which are bad on the
              filesystem, and then marks them  as  bad  by  adding
              them  to  the  bad  block  inode.  If this option is
              specified twice, then the bad  block  scan  will  be
              done using a non-destructive read-write test.

       -C fd  This option causes e2fsck to write completion infor-
              mation to the specified file descriptor so that  the
              progress  of  the filesystem check can be monitored.
              This option is typically used by programs which  are
              running e2fsck.  If the file descriptor specified is
              0, e2fsck will print a completion  bar  as  it  goes
              about  its  business.   This requires that e2fsck is
              running on a video console or terminal.

       -d     Print  debugging  output  (useless  unless  you  are
              debugging e2fsck).

       -D     Optimize  directories  in  filesystem.   This option
              causes e2fsck to try to  optimize  all  directories,
              either by reindexing them if the filesystem supports
              directory indexing,  or by sorting  and  compressing
              directories for smaller directories, or for filesys-
              tems using traditional linear directories.

       -E extended_options
              Set e2fsck extended options.  Extended  options  are
              comma  separated, and may take an argument using the
              equals ('=') sign.  The following options  are  sup-
              ported:

                   ea_ver=extended_attribute_version
                          Assume   the   format  of  the  extended
                          attribute blocks in  the  filesystem  is
                          the  specified version number.  The ver-
                          sion number may be 1 or 2.  The  default
                          extended  attribute version format is 2.

       -f     Force checking even if the file system seems  clean.

       -F     Flush  the  filesystem device's buffer caches before
              beginning.  Only really useful for doing e2fsck time
              trials.

       -j external-journal
              Set the pathname where the external-journal for this
              filesystem can be found.

       -k     When combined with the -c option, any  existing  bad
              blocks in the bad blocks list are preserved, and any
              new bad blocks found by running badblocks(8) will be
              added to the existing bad blocks list.
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       -l filename
              Add  the  block numbers listed in the file specified
              by filename to the list of bad blocks.   The  format
              of this file is the same as the one generated by the
              badblocks(8) program.  Note that the  block  numbers
              are  based  on  the  blocksize  of  the  filesystem.
              Hence, badblocks(8) must be given the  blocksize  of
              the  filesystem  in order to obtain correct results.
              As a result, it is much simpler and safer to use the
              -c  option  to e2fsck, since it will assure that the
              correct parameters are passed to the badblocks  pro-
              gram.

       -L filename
              Set  the  bad  blocks  list to be the list of blocks
              specified by filename.  (This option is the same  as
              the -l option, except the bad blocks list is cleared
              before the blocks listed in the file  are  added  to
              the bad blocks list.)

       -n     Open  the filesystem read-only, and assume an answer
              of `no' to all questions.  Allows e2fsck to be  used
              non-interactively.   (Note:  if  the  -c,  -l, or -L
              options are specified in addition to the -n  option,
              then  the  filesystem  will be opened read-write, to
              permit the bad-blocks list to be updated.   However,
              no other changes will be made to the filesystem.)

       -p     Automatically repair ("preen") the file system with-
              out any questions.

       -r     This option does nothing at all; it is provided only
              for backwards compatibility.

       -s     This option will byte-swap the filesystem so that it
              is using the normalized, standard byte-order  (which
              is  i386  or  little  endian).  If the filesystem is
              already in the standard byte-order, e2fsck will take
              no action.
       -S     This  option  will byte-swap the filesystem, regard-
              less of its current byte-order.

       -t     Print timing statistics for e2fsck.  If this  option
              is  used  twice,  additional  timing  statistics are
              printed on a pass by pass basis.

       -v     Verbose mode.

       -V     Print version information and exit.

       -y     Assume an answer of `yes' to all  questions;  allows
              e2fsck to be used non-interactively.
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EXIT CODE
       The  exit code returned by e2fsck is the sum of the follow-
       ing conditions:
            0    - No errors
            1    - File system errors corrected
            2    - File system errors corrected, system should
                   be rebooted
            4    - File system errors left uncorrected
            8    - Operational error
            16   - Usage or syntax error
            32   - E2fsck canceled by user request
            128  - Shared library error

SIGNALS
       The following signals have the following effect  when  sent
       to e2fsck.

       SIGUSR1
              This signal causes e2fsck to start displaying a com-
              pletion bar.  (See discussion of the -C option.)

       SIGUSR2
              This signal causes e2fsck to stop displaying a  com-
              pletion bar.

REPORTING BUGS
       Almost any piece of software will have bugs.  If you manage
       to find a filesystem which causes e2fsck to crash, or which
       e2fsck is unable to repair, please report it to the author.

       Please include as much information as possible in your  bug
       report.   Ideally,  include  a  complete  transcript of the
       e2fsck run, so I can see exactly what  error  messages  are
       displayed.   If  you  have a writeable filesystem where the
       transcript can be stored, the script(1) program is a  handy
       way to save the output of e2fsck to a file.

       It  is also useful to send the output of dumpe2fs(8).  If a
       specific inode or inodes seems to be giving e2fsck trouble,
       try  running  the debugfs(8) command and send the output of
       the stat(1u) command run on the relevant inode(s).  If  the
       inode  is  a directory, the debugfs dump command will allow
       you to extract the contents of the directory  inode,  which
       can sent to me after being first run through uuencode(1).

       Always  include  the  full version string which e2fsck dis-
       plays when it is run, so I know which version you are  run-
       ning.

AUTHOR
       This  version  of  e2fsck  was  written  by  Theodore  Ts'o
       <tytso@mit.edu>.
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SEE ALSO
       mke2fs(8), tune2fs(8), dumpe2fs(8), debugfs(8)

E2fsprogs version 1.36     February 2005                 E2FSCK(8)
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Glossary
access permissions

The access permissions of a file determine whether a user or group can read, write,
or execute a file or directory. They are set by the system administrator or the owner
of a file.

account
The account is defined by the username or login name and the password. An account
corresponds to a user ID (UID).

ACL (Access Control List)
Extension of the conventional permission concept for files and directories. These
allow a more fine-grained control of the access permissions.

ADSL (Asymmetric Digital Subscriber Line)
Fast transmission protocol using the telephone network.

AGP (Accelerated Graphics Port)
A high-speed slot for graphics cards, offering a higher bandwidth than PCI. AGP
graphics cards can revert directly (without routing around the processor) to the
random access memory.

ATAPI (Advanced Technology Attachment Packet Interface)
ATAPI is one of the most frequently used mass storage device interfaces, next to
ATA or SCSI. The majority of CD-ROM drives are ATAPI devices.

backup
A backup is a copy of data used to restore data that has been damaged or lost.
Backups of all important data should be made regularly.

bandwidth
Maximum transfer rate of a channel for data transmission. Usually used with net-
work connections.

BIOS (Basic Input/Output System)
Small program started after power-on or reboot of a computer. It is responsible for
the initialization of hardware components. Most BIOSs allow modifications of low
level system parameters via an interactive setup program. The program code resides
in a read-only memory (ROM) chip.



bookmark (with browsers)
In bookmarks, save the URL of frequently visited or important Web sites. They
can be sorted in folders or renamed.

booting
The sequence of computer operations from power-on until the system is ready for
use.

browser
Program that displays the content of local files or Web pages.

client
A program or computer in a networking environment that connects to and requests
information from a server.

command line
Text-based mode of issuing commands to the computer.

console
Formerly synonymous with terminal. In Linux, the virtual consoles allow the screen
to be used for several independent, parallel work sessions without any graphical
display running.

CPU (Central Processing Unit)
See processor.

cursor
The cursor is a block or underline character that marks the place for text input.

daemon (Disk and Execution Monitor)
A daemon is a program that runs in the background and is activated automatically
when required. For example, the HTTP daemon (httpd) answers HTTP requests.

DDC (Direct Display Channel)
Communication standard between the monitor and the graphics card that allows
transmission of certain parameters, such as monitor name or resolution, to the
graphics card.

directory (in a file system)
A structure containing files or further directories (subdirectories). The directories
in a file system build a tree-like structure for organizing files.
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DNS (Domain Name System)
A protocol for converting name-based addresses to IP addresses and vice versa.

driver
Part of the operating system that is responsible for the communication to hardware
components.

e-mail (electronic mail)
The means of transporting mail electronically between users via a network. An e-
mail address has the form username@domain.org.

EIDE (Enhanced Integrated Drive Electronics)
Enhanced IDE standard that allows hard disks with a size over 512 MB.

environment
The set of environment variables and their values kept by the shell. The user can
alter (or unset) the values of existing environment variables and set new variables.
Permanent assignments are made by means of the configuration files of the shell.

environment variable
An element of the environment of the shell.

ethernet
A standard for data transmission in local computer networks.

EXT2 (Second Extended File System)
A file system supported by Linux.

FAQ (Frequently Asked Questions)
Acronym for documents providing answers to frequently asked questions.

firewall
A mechanism for filtering network traffic that protects a local network from unau-
thorized access from the outside.

FTP (File Transfer Protocol)
A protocol based on TCP/IP for transferring files over a network.

GNOME (GNU Network Object Model Environment)
A graphical desktop environment for Linux.
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GNU (GNU Is Not UNIX)
GNU is a project of the Free Software Foundation (FSF). The aim of the GNU
Project is to create a complete and free UNIX-style operating system. It is free not
so much in the sense of free of cost, but in the sense of freedom: having the right
to obtain, modify, and redistribute the software. The now classic GNU Manifesto
(http://www.gnu.org/gnu/manifesto.html) explains the details. In
legal terms, GNU software is protected by the GNU General Public License, or
GPL (http://www.gnu.org/copyleft/gpl.html), and by the GNU
Lesser General Public License, or LGPL (http://www.gnu.org/copyleft/
lgpl.html). The Linux kernel, which is subject to the GPL, benefits from this
project (especially from the tools), but should not be seen as the same thing.

GPL (GNU General Public License)
See GNU.

GRUB (Grand Unified Boot Loader)
Small program installed in the boot sector of the hard disk that starts Linux or an-
other operating system.

home directory
A private directory in the file system that belongs to a specific user (usually in
/home/<username>). Except for the superuser root, only the owner has full
access rights in the home directory.

hostname
Name of a machine. This often is the name by which it can be reached on the net-
work.

HTML (Hypertext Markup Language)
A markup language for text documents used in the World Wide Web. HTML
documents are usually viewed with a browser.

HTTP (Hypertext Transfer Protocol)
A network protocol defining how to request and transfer documents in the World
Wide Web. The documents are usually HTML pages offered by a server and re-
quested by a user via the browser.

IDE (Integrated Drive Electronics)
Mass storage device interface, mainly used to attach hard disks.
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Internet
Worldwide computer network based on TCP/IP.

IP address
A unique (32-bit) address of a computer in a TCP/IP network. Often written as four
decimal numbers separated by periods (for example, 192.168.10.1).

IRQ (Interrupt Request)
An asynchronous request for some action that can be triggered by hardware or
software. Most IRQs are handled by the operating system.

ISDN (Integrated Services Digital Network)
A standard for digital data transfer over a telephone network.

KDE (K Desktop Environment)
A graphical desktop environment for Linux.

kernel
The kernel is the core component of the operating system. It manages memory and
file systems, contains the drivers for the communication with the hardware devices,
and handles processes and networking.

LAN (Local Area Network)
A LAN is a local network that is usually rather small.

LILO (Linux Loader)
Small program installed in the boot sector of the hard disk that starts Linux or an-
other operating system.

link
A link (in a file system) is a pointer to a file. There are hard links and symbolic
links. While hard links refer to the exact position in the file system, the symbolic
link only points to the respective name.

Linux
High performance UNIX-like operating system core distributed freely under the
GPL (GNU). The name is an acronym (Linus' Unix) and refers to its creator, Linus
Torvalds. Although the name, in a strict sense, only refers to the kernel itself, the
popular understanding of the term Linux usually entails the entire system.
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login
Authentication of a user by username and password to gain access to a computer
system or network.

logout
The procedure of closing an interactive Linux session.

main memory
Volatile physical memory that allows random access with virtually no delay. This
is often referred to as RAM (Random Access Memory).

man pages
Traditional form of documentation for UNIX systems that can be read using the
command man. Man pages are usually written in the style of a reference.

MBR (Master Boot Record)
The first physical sector of the hard disk whose content is loaded to the main
memory and executed by the BIOS. This code then either loads the operating system
from a hard disk partition or a more sophisticated boot loader, such as LILO or
GRUB.

MD5
Algorithm for generating hash values (MD5 checksum of a file). These checksums
are generated in a way that makes it virtually impossible to create a file that has a
given MD5 checksum but a different content than the original file.

mounting
The process of attaching a file system into the directory tree of the system.

MP3
Compression algorithm for audio files that reduces the data size by about a factor
of ten in contrast to the uncompressed audio file. It is called a “lossy” compression
because information and quality are lost in the process.

multitasking
The capability of an operating system to run multiple processes (virtually) in parallel.

multiuser
The capability of an operating system to let multiple users work in parallel on a
computer.
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network
A connection of several computers that allows the transfer of data between them.
A computer sending a request over the network is often referred to as a client. The
computer answering the request, for example, by delivering a document, is referred
to as server.

NFS (Network File System)
A protocol for accessing a file system over a network.

NIS (Network Information Service)
A centralized user administration system in networks. Usernames and passwords
can be managed networkwide by NIS.

operating system
See kernel.

partition
A section of a hard disk, containing either a file system or swap space.

path
Unique description of a file's position in a file system.

plug and play
Automatic hardware detection and configuration protocol.

process
A running program. Sometimes referred to as a task.

processor
The processor (CPU, for Central Processing Unit) is a microchip that executes
machine code stored in the main memory. It is the brain of the computer.

prompt
A short (configurable) string that is printed at the start of each command line. It
usually contains the current working directory.

protocol
A standard defining interfaces and communication methods for hardware, software,
or networks. Examples are the HTTP and the FTP protocol.
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proxy
Typically refers to a computer that serves as intermediate storage for data transferred
from the Internet. If the same document is requested more than once, the second
request can be served much faster. Computers intended to take advantage of this
must be configured to issue their requests via the proxy.

RAM (Random Access Memory)
See main memory.

ReiserFS
A file system type that allows for fast repair of potential inconsistencies. Such in-
consistencies can occur when a file system is not unmounted before the operating
system is shut down, such as in the event of a power failure.

root
The superuser account. The superuser has all permissions. This account is used for
administrative tasks and should not be used for regular work.

root directory
The base directory in the file system hierarchy. In UNIX, the root directory is rep-
resented as a /.

SCSI (Small Computer Systems Interface)
A standard for attaching hard disks and other devices, such as scanners and tapes.

server
A computer or program dedicated to offering services, usually over the network.
Examples of services are file delivery, name resolution, and graphical rendering.

shell
A program that allows issuing commands. There are several shells, such as Bash,
Zsh, and tcsh. Each type of shell has its own specific programming language.

SMTP (Simple Mail Transfer Protocol)
Protocol for transferring electronic mail (e-mails) over a network.

SSH (Secure Shell)
A remote login program that uses encryption. It is a more secure alternative to telnet.

SSL (Secure Socket Layer)
Encryption protocol for transferring HTTP data.
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superuser
See root.

swap space
A hard disk partition (swap partition) that is used to store memory pages that are
currently unused.

system administrator
A person responsible for maintaining a system. This person uses the root account
to perform administrative tasks.

task
See process.

TCP/IP
Communication protocol used for the Internet and most local networks.

telnet
Telnet is a protocol for the communication with remote hosts. For remote login,
telnet is essentially superseded by SSH, which offers encrypted connections.

terminal
Formerly, the designation of a keyboard and monitor combination connected to a
central computer. Today this term is instead used for programs (like xterm) that
emulate a real terminal.

Tux
Name of the Linux penguin. See http://www.sjbaker.org/tux/.

UNIX
UNIX is a type of operating system. It is also a trademark.

URL (Uniform Resource Locator)
Specification of a resource in the network consisting of a protocol (for example,
http://), the name of the host and domain (such as www.suse.de) and a
document (for example, /us/company/index.html). The complete URL of
this example is http://www.suse.de/us/company/index.html.

user directory
See home directory.
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VESA (Video Electronics Standard Association)
Industrial consortium that defines, among other things, video standards.

wild card
Placeholder for one (symbol: ?) or more (symbol: *) characters. These are parts
of regular expressions.

window manager
A program running on top of the X Window System that allows for actions, such
as resizing windows or moving them around. The window manager is also respon-
sible for the window decoration like window titles and borders. The behavior and
look can be customized by the user.

WWW (World Wide Web)
Based on the HTTP protocol, this is a hyperlinked collection of documents, files,
and images that can be viewed with a Web browser.

X Window System
The X Window System is a network-based window system that runs on a wide
range of computers. It offers mechanisms for drawing lines and rectangles. It is the
middle layer between the hardware and the window manager.

X11
Version 11 of the X Window System.

YaST (Yet another Setup Tool)
The SUSE LINUX administration tool for installing and configuring a system.

YP (Yellow Pages)
See NIS.

276



Index
Symbols

A
accessibility

GNOME (see GNOME, accessibility)
KDE, 194–197

ACPI
disabling, 4

answering machine
configuring, 74

Apache, 76
applications, 137–158

development, 156
Anjuta, 157
CVS, 158
Eclipse, 157
Eric, 157
GCC, 158
GDB, 158
Glade, 158
GTK, 157
KDevelop, 156
MonoDevelop, 157
Qt, 157
Qt Designer, 158
Subversion, 158
Valgrind, 158

graphics, 149
Blender, 151
Dia, 151
Digikam, 152
Eye of Gnome, 153
f-spot, 152
GIMP, 150
gThumb, 152
Gwenview, 152

Inkscape, 151
Karbon14, 151
Kivio, 151
Kooka, 152
KPovmodeler, 152
POV-Ray, 151

multimedia, 145
amaroK, 147
Audacity, 148
Banshee, 147
Grip, 146
K3b, 147
Kaffeine, 147
kdetv, 149
KsCD, 146
LilyPond, 148
MainActor, 149
motv, 149
MusE, 148
Noteedit, 148
RealPlayer, 213
Rhythmbox, 148
Rosegarden, 148
Sound Juicer, 147
Totem, 147
tvtime, 149
xawtv4, 149
XMMS, 147
zapping, 149

network, 141–145
Epiphany, 143
Evolution, 143
Firefox, 142
Gaim, 144, 212
gftp, 145
GnomeMeeting, 144
kbear, 145
Konqueror, 142
Kontact, 143
Konversation, 144



Kopete, 144, 192
KPhone, 145
Linphone, 145
Mozilla Thunderbird, 143
Opera, 143
XChat, 144

office, 137–141
Evolution, 143
GnuCash, 140
Gnumeric, 139
Gnuplot, 139
Grace, 139
Kexi, 140
KOffice, 139
Kontact, 143
Mergeant, 140
moneyplex, 140
OpenOffice.org, 138
Planner, 141
PostgreSQL, 140
Rekall, 140
StarOffice, 139
Taskjuggler, 141
VYM, 141

PDF viewer
Adobe Reader, 154
Evince, 155
KPDF, 155
Xpdf, 155

starting, 126
Audacity, 148
authentication

Kerberos, 44

B
backups, 63

creating with YaST, 83
restoring, 84

BIOS

boot sequence, 227
booting, 257, 261

CD, from, 227
configuring, 19
floppy disks, from, 225
log, 93

C
cards

radio, 73
sound, 72
TV, 73

CDs
booting from, 227
checking, 64

chown, 35
commands

bzip2, 155
chown, 35
dump, 156
e2fsck, 261
gzip, 155
head, 35
Kdar, 155
nice, 35
sort, 35
tail, 35
taper, 155
tar, 155

configuration files
asound.conf, 73
fstab, 89
group, 30
gshadow, 36
hosts, 76
modprobe.conf, 32
modprobe.d/sound, 73
modules.conf, 32
passwd, 30



powersave.conf, 41
sysconfig, 91
XF86Config, 45
xorg.conf, 45

configuring
Bluetooth, 66
CD-ROM, 66
DNS, 76
e-mail, 75
firewalls, 83
graphics cards, 66, 101
groups, 81
hard disk controllers, 67
hard disks

DMA, 68
hardware, 65–74
languages, 92
monitor, 66, 101
networks, 74–79
NFS, 77
NTP, 77
PAM, 45
powertweak, 90
radio, 73
routing, 79
Samba

clients, 79
servers, 79

scanner, 70
security, 79–83
software, 51–63
sound cards, 72
system, 49–95
system services, 77
TFTP

servers, 79
time zone, 92
TV, 73
users, 79

crashes, 257, 261

D
desktops, 114

configuring, 117–121
GNOME, 117
KDE, 119

switching users, 122
terminology, 114

DHCP, 76
Digikam, 152
disks

boot, 85
required space, 9
rescue, 85

DNS
configuring, 76
multicast, 35

documentation (see help)
domains

.local, 35
download managers

KGet, 185

E
e-mail

configuring, 75
e2fsck, 261
editors

Emacs, 154
GEdit, 154
Kate, 154
vim, 154
XEmacs, 154

encoding
UTF-8, 35

error messages
bad interpreter, 89
permission denied, 89

Evolution, 143



F
fax

configuring, 74
file managers, 124

Konqueror, 176–181
Nautilus, 205

file servers, 77
file systems

checking, 257
e2fsck, 261
FAT, 14
NTFS, 14–15
reiserfsck, 257

files
archiving, 187, 215
associations, 178, 208
managing, 123
news feeds, 215
searching for, 125
telephony, 214
Usenet, 216

Firefox, 142
firewalls, 83
fonts

installing, 198

G
GIMP, 150
GNOME, 201

accessibility, 217–220
Dasher, 220
Gnopernicus, 219
GOK, 217

applets, 205
Blam, 215
configuring, 201
desktop components, 202–205
desktop menu, 203
dictionary, 211

File Roller, 215
GnomeMeeting, 214
icons, 202
Nautilus, 205–210
notes, 210
Pan Newsreader, 216
panels, 203
printing, 127
tomboy, 210
utilities, 210–217

graphics
galleries, 180, 182

groups
management, 81

H
hard disks

DMA, 68
hardware

Bluetooth, 66
CD-ROM, 66
graphics cards, 66, 101
hard disk controllers, 67
information, 67
infrared, 66
monitor, 66, 101

head, 35
help, 159–162

books, 165
FAQs, 164
guides, 165
HOWTOs, 164
info pages, 164
Linux documentation (TLDP), 164
man pages, 163
manuals, 165
package documentation, 166
specifications, 167
standards, 167



SUSE books, 165
SUSE Help Center, 159
Usenet, 167
Wikipedia, 165

hostnames, 76

I
inetd, 77
installing

manually, 44
Xen, 64
YaST, 3–28

Internet
chatting, 192, 212
connecting to, 132–134
wireless, 133

J
joystick

configuring, 69

K
K3b, 147
KDE, 173–181, 194–197

accessibility, 194–197
KMag, 194
KMouth, 196
KTTS, 195

Akregator (Newsticker), 190
Ark, 187
clipboard, 186
fonts, 198
KGet, 185
Klipper, 186
Kopete, 192
KPDF, 189
KSnapshot, 188
KWallet, 182
menus, 173, 175

printing, 128
utilities, 182–189

kernels
modules

modprobe.conf, 32
version 2.6, 32

keyboard
configuring, 69

KInternet, 132–134
Konqueror, 142

bookmarks, 179
file associations, 178
file manager, 176–181
image galleries, 180, 182
previewing files, 177
starting, 177

Kontact, 143
Kooka, 152

L
language, 63
languages, 92
LDAP, 77
License Agreement, 5
linuxrc

manual installation, 44
linuxthreads, 33
locale

UTF-8, 35
log files, 82

boot.msg, 93
messages, 93

logging
login attempts, 82

login, 111–113
GDM, 112
KDM, 112
sessions, 112–113



M
mouse

configuring, 69
Mozilla (see Firefox)

N
Nautilus, 205–210

configuring, 209
MIME types, 208
navigating, 206

networks, 131
configuring, 74–79, 131
DHCP, 76
Internet, 132
routing, 79
wireless, 133

news feed, 190
newsticker, 190
NFS

clients, 77
servers, 77

NGPT, 33
nice, 35
NIS, 77
NPTL, 33–34
NTP

client, 77

P
PAM

configuring, 45
partitions

creating, 8, 86–87
fstab, 89
GNU Parted, 155
LVM, 87
parameters, 87
RAID, 87
resizing Windows, 13

swap, 88
types, 8

PDF viewers, 189
PostgreSQL

updating, 30
power management, 135–136
printing, 127–130

GNOME, 127
KDE, 128

profile management, 136
proxies, 78

R
reiserfsck, 257
removable media

subfs, 38
repairing systems, 247
routing, 79
runlevels, 91

changing, 91

S
Samba

clients, 79
servers, 79

SaX2
3D, 104
display device, 102
display settings, 101
dual head, 103
graphics card, 102
graphics tablet, 106
keyboard settings, 106
mouse settings, 105
multihead, 104
remote access (VNC), 107
resolution and color depth, 103
touchscreen, 106

scanning



configuring, 70
GOCR, 154
troubleshooting, 71

SCPM, 90
screenshots

KSnapshot, 188
security, 130

configuring, 79–83
firewalls, 83
intrusion detection, 45

SGML
directories, 38

software
installing, 51–57
removing, 51–57

sort, 35
sound

configuring in YaST, 72
fonts, 73
mixers, 43

subfs
removable media, 38

SUSE books, 165
SuSEWatcher, 121
system

configuring, 49–95
languages, 92
security, 81, 130
services, 77
updating, 29–32, 62
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tail, 35
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new location, 47
TFTP

servers, 79
thread packages

NPTL, 34

time zones, 92
TLDP, 164
Tripwire
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TV

card configuration, 73
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updating, 29–32

online, 61–62
command line, 99

passwd and group, 30
patch CD, 62
problems, 30
sound mixers, 43
YaST, 30

users
concept, 113
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root, 114
superuser, 114
switching, 122

UTF-8
encoding, 35

V
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virtual memory, 88
VNC

administration, 78
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Web browsers

Firefox, 142
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X

display device, 102
display settings, 101
dual head, 103
graphics card, 102
graphics tablet, 106
keyboard settings, 106
mouse settings, 105
multihead, 104
remote access (VNC), 107
resolution and color depth, 103
touchscreen, 106

Xen
installation into directory, 64

xinetd, 77
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directories, 38

Y
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installation mode, 5
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security, 79–83
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software, 51–63
software updates, 23
sound cards, 72
starting, 3, 49
sysconfig editor, 91
system security, 81
system start-up, 3
text mode, 95–101
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time zone, 92
TV cards, 73
updating, 30, 62
user management, 79
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